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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Digital Photo Professional (hereinafter, “DPP”) is a high-performance
RAW image processing, viewing and editing software for EOS DIGITAL
cameras. It is often thought that RAW images are difficult to handle
compared with ordinary JPEG images, but using DPP, you can perform
advanced edits and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. As image processing is not performed inside the camera when a
photo is taken and the photo has been recorded in the special form of
“‘RAW image data + Image processing conditions information at the time
of shooting”, special software is needed to view or edit the image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“development”.

When is RAW Development done?

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP.

As a result, RAW images displayed in DPP are images whose
development processing has been completed.

With DPP, you can view, edit and print RAW images without being
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.
In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.

#'¢%, RAW image data

Image processing conditions information
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Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

View and organize RAW images
Real-time adjustment of a RAW image

Various image adjustments while maintaining the original image
Freely apply a Picture Style
View your image before and after adjustment in the same window

Trim and adjust the angle of an image
Change image size

Correction of lens aberration
Automatic/manual dust erasure processing

Convert from a RAW image to a JPEG or

TIFF image and save

Process large numbers of RAW images in batches
Transfer the image to image editing software

Print a RAW image
View and organize JPEG and TIFF images

Real-time adjustment of JPEG and TIFF
images
Various image adjustments while maintaining the original image

Print JPEG and TIFF images

Color management compatibility
CMYK simulation for commercial printing

System Requirements

oS Windows 8, Windows 7*1, Windows Vista*?
Windows XP Professional/Home Edition*3
PC with one of the above OS preinstalled

Computer | . Upgraded machines not supported

CPU 1.3GHz Pentium or higher*4

RAM Minimum 1GB*>

Displa Screen resolution: 1024 x 768 pixels or more

play Color quality : Medium (16 bit) or more

1
*2

*3
*4
*5

Compatible with 32-bit/64-bit systems for all versions except Starter Edition
Compatible with 32-bit/64-bit systems for Service Pack 2 except
Starter Edition

Compatible with Service Pack 3

Core2 Duo or higher is recommended

For Windows 8 or Windows 7 64-bit systems, minimum 2GB

Check the Canon Web site for the latest system requirements, including
supported OS versions.

Supported Images

This software supports the following image types.

Image type Extension
RAW images*' shot with EOS DIGITAL cameras, .CR2
RAW images | excluding EOS DCS1 and EOS DCS3 TIF
RAW images*2 shot with PowerShot cameras .CRW
. Exif 2.2, 2.21 or 2.3-compatible JPEG
JPEG images images JPG, JPEG
TIFF images | Exif-compatible TIFF images TIF, .TIFF

*1

*2

Compatible with RAW images shot with EOS D6000 or EOS D2000
that have been converted to RAW images using the CR2 Converter
and have the “.CR2” extension.

For information on CR2 Converter, refer to Canon Web site.

* Only models where Digital Photo Professional is listed in the “Data Type”

item in the “Specifications” section near the end of the Camera User Guide.

* Use the dedicated CameraWindow application to download images from a
PowerShot camera to a computer. See the Software Starter Guide for details.

* Lens aberration correction can only be used with some camera and lens models.

» Automatic dust erasure processing and other EOS DIGITAL specific
functions cannot be used.
* RAW images shot with the PowerShot Pro1 are also supported, but

they cannot be edited with the DPP RAW image adjustment function.
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Contents at a Glance [ i’ = 57 r
- | TR A Introduction
Downloading Images to Your Computer Adijust brightness of shadows/highlights - p.57
Download images by connecting your camera and Reduce image noise = p.62 Contents at
2*p.7 . a Glance
computer Correct lens aberration = p.63
Download images using a card reader 2p9 Use the Digital Lens Optimizer - p.69
Use a Picture Style file - p.59 o B:‘sifim
H H H rati
Viewing and Checking RAW Images Edit efficiently - p.34 P
Quickly enlarge parts of an image = p.11 Edit an image while comparing the image before and .
Sort images (check marks, rating) -»p.18, p.19 after adjustment P- Advanced
Display an image shot simultaneously as a RAW - p.22 Synchronize multiple images = p.54 e
image and JPEG image as a single image Display an area beyond the set range as awarning -
Display the images in the thumbnail list display at high _, 0.23 indicator (Highlight/Shadow warning) P- Advanced
resolution Restore an adjusted image to its condition at the time I?:ggﬁg;lt%g
Check shooting information such as the shooting date =» p.10, p.23 of shooting P-
B . . Composite images -»p.78 Processing
Editing RAW Images (Adjusting) Create HDR (High Dynamic Range) images - p.82 La;%‘irﬂgg‘g:rs
Adjust brightness/darkness - p.12, p.26 - . —
Use automatic adjustment = p.33 Printing Editing
Sharpen the modulation and contrast of colors (contrast)  =» p.29 nnt well on a L-anon printer p.89, p.90 Images
Make skin tone look healthier (color tone) = p.30 Faithfully reproduce the color of the subject = p.43, p.88,
Make the image colors more vivid (color saturation) — =» p.30 when printing p-89, p.90 Reference
Make an image sharp (sharpness) - p.31 Print with the shooting information =» p.86
Adjust an image to make color tone more natural - .28 Print a thumbnail list of images - p.87
(white balance) ' Approximate the color seen on screen with your - p.94 Index
Change an image to black-and-white or sepia tones . printing results '
(monochrome) P S
Trim an image and adjust the angle of an image -p.38 Conversion of Images
Specify an aspect ratio that matches the size of the 0.38 Convert a RAW image to a JPEG image = p.42, p.101 @ @
paper on which an image is to be printed ' Edit in Photoshop - .78, p.102
Erase dust shot with the image =>p.73,p.75 Perform batch processing - p.101 @
Erase unwanted parts of an image = p.77 Edit (adjust) a JPEG image - p.105

Auto correct RAW images with the Auto Lighting Optimizer =» p.61



1 Basic Operation

The basic operational flow — from how to download to your computer
images shot with a camera to checking, editing, saving and printing a
downloaded RAW image — is explained here.

)
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Starting up DPP

Double-click the desktop icon.

Double-click

EDS Utility

DPP starts up and the main window ([Folder] window) appears.

v

High quslty Becpe data: Puber of mages: 0 Humber of seleciod mages: B

Main Window Display

In the main window, you can use tabs to select either the [Folder]
window or the [Collection] window. The [Folder] window displays the
images in folders on your computer, while the [Collection] window (p.36)
displays images selected randomly by the user from one or more folders
and gathered together.

Unless noted otherwise, the [Folder] window will be described as the
main window from this point on.

[Folder] window

[Collection] window

R N N N )
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Downloading Images to Your Computer

Connect the camera and computer with the cable provided and

download the images saved on the memory card inserted in the camera.
For downloading images, start up the camera software “EOS Utility”

from DPP and use.

Select the save destination for the images.
Select the save destination in the folder area on the left of the
main window.

When creating a folder, see p.50.

ital Photo Professional - [EAUsers\CANON\Pictu

e Edit VNiew Bookmark Label Adjustment Tools

Window Help

|
I fo Selact all Clear all Rotate left Rotate right

Bl Desktop

Libraries
S

|
1 Music

N @Pictures

+1E Videos

Start up EOS Utility.
Select the [Tools] menu » [Start EOS Utility].

Tools

Start Quick check tool Alt+Q
Start Trimming/Angle Adjustment tool Alt+C
Start Stamp tool Alt+5
Start Rename tool Alt+R

[ startEOS Utility Alt+0
Sync folder with EQS Utility
Transfer to Photoshop Alt+P
Preferences... Ctrl+K

EOS Utility starts up.

EOS Utility (Displayed items differ depending on connected
camera)

Control Camera Accessories

Lets you select ar

Connect your camera and computer and turn the
camera on.
Connect the camera and your computer with the interface cable
provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and
computer, refer to the “EOS Ulility Instruction Manual” (PDF
electronic manual).

The capture window for EOS Ultility appears.
When an EOS M is connected, the capture window does not
appear. Proceed to step 5 on the next page.
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Click the [Main Window] button.
EEs 2=

o EREARS
- Style Standarc

Register User Def
WB SHIFT

Peripheral illumin.

HDR Mode Disable HDR

Live View shoot. ... .

Other Functions...

The main window for EOS Utility appears.

Download images.

I}, EOS Utility - EOS XXX

P——

Control Camera

-z
‘ Accessories

Starts to download images CIiCk

Lets you select and download images
Camera settings/Remote shooting

Monitor Folder

Downloading of images begins.

The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of DPP.

The downloaded images are sorted by date into folders and
saved.

-I\@/E Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

5

You cannot start up EOS Utility in the [Collection] window

(p-6, p.36).

When EOS Utility has been started up from DPP, you cannot use

the following functions.

* Quick check window view (p.16)

» Trimming and adjusting the angle of an image (p.38, p.113)

* Digital Lens Optimizer (p.69)

» Compositing images (p.78)

* Creating HDR (High Dynamic Range) images (p.82)

* Dust erasure processing (copy stamp function)
(p-73 to p.77, p.116 to p.120)

» Batch change file names (rename function) (p.103)

* Printing with shooting information (p.86)

* Printing a thumbnail list (contact sheet printing) (p.87)

* Printing using Easy-PhotoPrint EX or Easy-PhotoPrint
(Plug-in printing) (p.43, p.46)

* Transferring images to Photoshop (p.78)

* Batch saving images (batch processing) (p.101)
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Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card
reader.

Load the memory card into the card reader.

Open [My Computer] » [EOS_DIGITAL] and drag the
[DCIM] folder to the [Desktop].

File Edit View Bookmark Label Adjustment Iools Window Help

The [DCIM] folder is downloaded to your computer.
All images are saved in folder units inside the [DCIM] folder.

Display the images downloaded to your computer.
In the [DCIM] folder copied to your desktop, select the folder
where the shot images are saved.

G Floppy Disk Drive (A)
By Local Disk (C:)
5143 DVD RW Drive (D7)

i iy Windows7_0S (E)
gy EOS_DIGITAL (F3)
B ), DCIM
€l Network

:

fe . 102CANON

»Images in the folder are displayed in the main window of DPP.

>~ Checking before downloading images

By selecting the memory card folder directly in DPP, the images in the
folder are displayed in DPP and you can check the shot images.

|§| Copying to your computer may take time when there is a large
number of shot images saved in the memory card.
For details on the [DCIM] folder structure and the file names of
shot images, refer to “Folder Structure and File Names in the
Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).
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Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list Changing the Size of Thumbnail Images

Introduction

:L]i:éi\;/nz':dv‘ginsd?:" ::]Zui;aan gc::tl);er'(i'gi(zgn image to open the edit You can change the size of the thumbnail images displayed in the main
play 9 9 ’ window and display them with shooting information attached. Contents at
a Glance
Viewing Images as Thumbnails in the Main Window Select the [View] menu ) desired item.
View
L. Rotate selected image i:ﬁlmgww Ctmmghtz::
Main window
_ Tool palette Crl+T
e s v Tab
o Advanced
v | Rating Ctrl+0 operatlon
m‘l Large thumbnail Ctrl+1
il @ Medium thumbnail Ctrl+2
— Small thumbnail Cirl+3 Advanced
Thumbnail with infoermation Ctrl+4 Image Editing
s — - and Printing
“ The display changes to the selected item. :
Processing
s s s Large Numbers
_ of Images
h E N ——
= éfs{w‘:; Editing
o : 8 sis _ JPEGI/TIFF
e e e e it Images
Click to select the image
Display thumbnails of all the images inside the
folder selected in the folder area on the left Reference
® Images displayed with the ["® ] icon are movie files and cannot
be played back in DPP.
If the message [Insufficient memory.] appears, there are too Index
many images in one folder. Decrease the number of images in -

one folder such as by dividing them into smaller folders.

|§| When aspect ratio information is attached to the shot image with @ @

the EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark IlI,

EOS-1D Mark Ill, EOS 5D Mark IIl, EOS 6D, EOS 7D, EOS 60D, @
EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL

T4i/650D, EOS REBEL T3i/600D or EOS M, the image is

displayed as a trimmed image (p.38, p.113).

For a list of main window functions, see p.126. 10



Enlarging and Viewing an Image in the Edit Window

—

n 2% » % & &8 D

Double-click

Tool palette

A4 s | o | uee
[r—pe— =]

(MISE000 1 2, 44,28 S dckbe R CWYK righ qusity

It may take time for the image to redraw itself.
Click the [&]] in the upper right of the edit window to close the
edit window.

|§| By selecting the [View] menu » [AF Point] in the edit window, you can
display the AF points selected in the camera at the time of shooting.
However, AF points are not displayed for images whose image size
has been changed and then been converted and saved (p.42, p.136),
images for which you selected an effect other than [Shot settings] as
correction of fisheye lens distortion aberration, or images which have
had settings specified during RAW processing on the camera for
distortion correction and chromatic aberration correction.

For a list of edit window functions, see p.129.

Enlarging and Viewing a Specific Area
Double-click the area you want to enlarge.

BT T

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.

©® Double-click again to revert to the full view.

» To change the display position, drag on the image or drag the
enlargement display position of the tool palette.

Tool palette enlargement display position

Change the enlargement
display position by
dragging

=)= To display an image in an enlargement ratio other than 100%

Select the [View] menu » [200% view] or [50% view].

|§| You can change the enlargement ratio when you double-click (p.92).
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Adjusting an Image

You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image using the tool
palette of the edit window. You can easily restore an image to its original
settings with the [[$5]] button even if you have made the wrong
adjustment. Try out the various adjustments.

As an example, the procedure to adjust the brightness of an image is
explained here.

Tool palette
RAW |Re8 | nR/ALO [ LENS | ]
|Brightness adjustment U?| Rever_ts_ the Ima_ge to
oo the original settings
| : .
“'\"Jhite balance adjustment =] | prag the slider left or
ad 123 Register... rlght
|@ (Auto) - | Tune...
|Picture Style E3 ||

|@ (Standard) - | Browse...

-10.0 -8.0 6.0 -40 -20 0.0 20 4
Contrast:{0) ]
Highlight:(0) ]
Shadow:{0) ]

Linear
Color tone: (0) {
Color saturation: (0) {1
|Unsharp mask - |
Strength:(0) 1
Fineness:({0) 0
Threshold:(0) 1

The image brightness changes in real time according to the
amount of adjustments.

? The tool palette does not display

Select the [View] menu » [Tool palette].

About the Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your
editing requirements.

Because adjustment made with the tool palette (it undergoes automatic
development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Therefore, there are no problems with image deterioration that arise with
editing and you can readjust your images any number of times.

See Chapter 2 onwards for more detailed information on the various
functions of the tool palette.

About Recipes

In DPP, all the adjustment contents (image processing conditions
information) made with the tool palette are saved to an image as data
called a “Recipe” (p.98).

@ For a list of tool palette functions, see p.130.
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Saving an Image

If you perform the save operation described here, you can save all the
adjustment contents (recipe) made with the tool palette to the RAW
image.

Select the [File] menu » [Save].

File
[ Save Ctrl+5 ]
Save As... Ctrl+5Shift+5
Convert and save... Ctrl+D
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+5hift+P
Plug-in printing r
Info Ctrl+1
Close Ctrl+W

Your adjustment contents (recipe) are saved to the image.

Saving

With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method, see
Chapter 2 onwards.

Save (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save.

Save as (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save as a separate RAW image. The original RAW image
remains unaffected.

Add thumbnail to image and save* (p.23)

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images
redraw themselves more quickly.

Convert and save (p.42)

Convert adjusted RAW image to a JPEG or TIFF image and save.
The original RAW image remains unaffected.

Batch process (p.101)

Convert in batches adjusted multiple RAW images to JPEG or TIFF
images and save.

The original RAW images remain unaffected.

* Option available in the main window.
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the [File] menu » [Print].

File
Save Ctrl+5
Save As... Ctrl+5Shift+5
Convert and save... Ctrl+D

[ Print.. cuiep )
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 2
Info Ctrl+1
Close Chrl+W

The printer’s print settings dialog box appears.

Print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [OK] button.
Printing begins.

Printing
With DPP, you can perform the following types of printing according to
your requirements. For detailed information on each printing method,
see Chapter 2 onwards.

Print one image (p.49)

Print with a Canon inkjet printer (p.43, p.46)

Print with a high-end Canon printer (p.88)

Print with shooting information (p.86)

Printing a thumbnail list (contact sheet printing) (p.87)

Exiting DPP

In the main window, select the [File] menu P [Exit].

File
Open in Edit window Ctrl+ 0
Open in Edit window (enlarged)
Save Ctrl+S
Save As... Ctrl+Shift+5
Add thumbnail te image and save Ctrl+Shift+T
Convert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing
Add to collection Ctrl+G
Remowve from collection Ctrl+5Shift+G
Clear collection
Delete Del
Info Ctrl+1
Exit Alt+Fd

DPP exits.

|§| A confirmation dialog box for saving the images appears when you
try to exit DPP without saving the adjusted image. Click the [Yes to
all] button to save the adjustment contents (recipe) to all the images

adjusted.
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D Advanced Operation

A more advanced operation — from efficiently checking images, to
various ways of editing an image, printing a RAW image using a Canon
printer and sorting images — is explained here.

Efficiently Checking/Sorting Images.........cc.c............ 16
Sorting IMages........uuueeiieeieeeeeeeeeeeeeeeeeeeeeeeeeeeeee 18
Attaching Check Marks.........cccccccoeeeiiieeiiiiinieeenne... 18
Setting Ratings ......ccoovveiiiiiiiiieeeeeeeeeee, 18
Sorting Images in the Main Window ..............c........... 19
Attaching Check Marks in the Main Window ......... 19
Setting Ratings in the Main Window ...................... 19
Arranging Images in the Main Window...................... 20
Arranging by TYPE ....uuuuiiiiiiiieiie e 20
Arranging Freely .......ccoooovvoiiiiiiiiieeeeeee 21
Displaying a RAW Image and JPEG Image as a Single
IMAGE ... oo 22
Improving the Quality of an Image in the Main Window ... 23
Checking Image Information................cccccovvvveeennn. 23
Editingan Image ..., 25
About the RAW Tool Palette..........ccccceeeeeeeeeeeeeennnnin. 25
Editing with the Tool Palette in the Main Window.. 25
Adjusting Brightness...........ccoooiiiiiiiiiiiiiiiieeeeeeeeeeee, 26
Changing a Picture Style ..........cccccccooeeeeiiiiiiiieeeee. 26
Picture Style File..........ocooiiiiiiiiiiiieeeeeeee 27
Adjusting Color Tone by Changing White Balance.... 28
Adjusting Color Tone Using Click White Balance...... 28
Adjusting Contrast ..........ccccoiiiiiiiiiiieee e 29
Changing Color Tone and Color Saturation............... 30
Adjusting Monochrome ..........ccccccoiiiiiiiiiiiiieee . 30
Adjusting Image Sharpness...........cccccccviiieiieeeneeenn, 31

Detailed Setting of Image Sharpness..................... 32
Automatically Adjusting Brightness and Color (Tone
Curve AsSist) ... 33

Editing Efficiently ... 34
Editing in the Edit Image Window...........cccccccccevnnnee. 34
Changing the Thumbnail Display Position to Horizontal .............. 36
Gathering and Editing Images in the Collection Window ... 36

Trimming and Adjusting the Angle of an Image....... 38

Applying Adjustment Contents to Other Images...... 41

Saving Editing Results.............ccoii 41
Saving Editing Contents to a RAW Image................... 41
Saving as a JPEG or TIFF Image........ccccccvvveeeeeennnnnn. 42

Re-Editing an Image..........ccccooiiiiiiiii, 43

PrintinganImage ..........ccooii i 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint EX ........................ 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint..................cc........... 46
Printing Photographs with a Printer other than Canon
Inkjet Printers.........ooooie e 49

Organizing IMages ..........ueeiiiiiee e 49
Deleting an Unwanted Image ..............ccccccuvvvvveeeene.... 49
Creating a Folder for Saving Images..................c....... 50
MOVING IMAaQES ...ooeeieiiieieee e 50
Moving Images in Folders .........cccccooeiiiiiiiiiiiiieeee. 51
Registering Frequent-Use Folders (Bookmark
Registration) ........cccccoooiiiiiiiiie 51

Organizing Bookmarks ...........cccccccoeeeeeeciiiinineeenne... 51
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can attach check marks and sort
images into five groups.

Display the quick check window.
Click the [Quick check] button.

I

T Rotate right Quick Stamp Trimming
check 2

Rating « » & & =

pir—

The quick check window appears.

Click the [Next] or [Previous] button to switch
between images to be checked.
Quick check window

All the images displayed in the main window can be checked in
the quick check window.

Double-click the area you want to enlarge.

PoumEEEEl " | poyple-click

The area you double-clicked is enlarged to 50% view.
To change the display position, drag on the image.

@ Double-click again to revert to the full view.

© To exit, click the [OK] button.

|§| When [AF Point] is checkmarked, you can display the AF points
selected in the camera at the time of shooting. However, AF points
are not displayed for images which have had their image size changed
and then been converted and saved (p.42, p.136), which have had
settings specified during RAW processing on the camera for distortion
correction and chromatic aberration correction, which are composited, or
which are created as HDR (High Dynamic Range) images.
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Vs

> Convenient functions of the quick check window

~
-

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switch between images using the keyboard

You can also switch between images by pressing the <—> or <«>
key.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
when you right-click with the mouse on an image.

|§| The enlargement ratio when an image is enlarged is half (50%)
of the 100% (actual pixel size).

You can change the enlargement ratio to 100%, when an image
is enlarged (p.92).

For a list of quick check window functions, see p.134.
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Sorting Images

You can sort images by attaching check marks or setting ratings
(indicated with [ %] marks) for each subject or theme.

Attaching Check Marks

Display the image you want to attach a check mark
to, and then click any one of [[1]] to [[5].

Chedk mark:

Clear

Click

The selected check mark appears in the upper left of the window.

Check mark

Click the [Clear] button to remove the check mark.

|§| The values of check marks attached to images in DPP version 3.8
or earlier are maintained as they are.
You can also attach check marks from the menu that appears by
right-clicking with the mouse on an image in the main window.

Setting Ratings
Display the image you want to rate, and then click
any one of the [+ ].

Rating

(s = & 3 8)

— Click (changes to [ ] after
clicking [ = ])

The rating is set and an icon corresponding to the selected [ ]
appears in the upper left of the window.

(Window shown with a rating of three [ ])

To set [Reject], click the [Reject] button. Click the [Reject] button
again to cancel.

Rating icon
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Introduction

Setting Ratings in the Main Window

Select the images you want to rate, and then click
any of the [H] in the toolbar.

Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks
or setting ratings (indicated with [E1] marks) for each subject or theme.

—_—

Contents at

Attaching Check Marks in the Main Window

Select the images you want to attach a check mark
to, and then click any of [v] to [v¢] in the toolbar.

2R P @& @ @

Select all Clear all Rotate left Rotste right Quick Stamp Trimming Batch

check Angle proces|

Click

Y . Advanced
k Image Editing
T S L—!— Select e | s and Printing
J !’h ~& - The rating is set and an icon corresponding to the selected [E3] Processing
n appears in the image frame. Largflel Numbers
8 oo - L (Window shown with a rating of three [E3] as an example) w
The selected check mark appears in the upper left of the image - - - ; i
B = Editing
frame. ® 9 & 2 JPEGITIFF
o S T e Images
DO ® 9 & 2
Selact all Clear all Rotst= left  Rotste nght 5_;:;: Stamp Tr:‘r::::g p?::i; Reference
Check mark R
a |la O —_ Rating icon Index
IMG_0002.CR2 # TS _( 3 2+ IMG_0004.CR2
s P To cancel the rating, click the same [E3] as when the setting was
|@m MG o001.cR2  TMG_0002.CR2 * g MG 0003.CR2 made in the tOOIbar.

Click the check mark in the toolbar again to remove the check
marks.

Click (changes to [E1] after clicking [H])

i S 1 (7

Ai Select

[Reject] cannot be set with the toolbar. Set [Reject] with the
[Label] menu or the quick check window (p.18).
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Y

=@> To select multiple images in the main window

Click on desired images while holding down the <Ctrl> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <Shift> key.

-:\@/3 To display more thumbnails in the main window

You can display a large number of images by setting the size of thumbnail
images to small (p.10). Then, by selecting the [View] menu » [Rating] and
removing check marks so that ratings no longer appear in the image
frame, you can display still more thumbnail images in the main window.

|§| The [Label] menu can also be used to attach check marks and set
ratings.

By selecting the [Edit] menu » [Check mark] or [Rating] » image

selection criteria, you can refine criteria for selecting

checkmarked or rated images.

You can display and change the rating settings set in DPP with

other bundled software and on an EOS-1D X, EOS-1D C, EOS

5D Mark Ill, EOS 6D, EOS 7D (firmware version 2.0.0 or later),

EOS 60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS

REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T3/

1100D, or EOS M camera.

« EOS Utility version 2.9 or later:

Ratings set in DPP are displayed. However, [Reject] is not
displayed and you cannot change rating settings.

* On an EOS-1D X, EOS-1D C, EOS 5D Mark Ill, EOS 6D, EOS
7D (firmware version 2.0.0 or later), EOS 60D, EOS REBEL
TS5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/650D, EOS
REBEL T3i/600D, EOS REBEL T3/1100D, or EOS M camera:
Ratings set in DPP are displayed in the playback screen. You
can also change rating settings. However, you cannot display or
change settings for [Reject].

Reversely, you can also display and change with DPP the rating

settings set for still images on an EOS-1D X, EOS-1D C, EOS 5D

Mark Ill, EOS 6D, EOS 7D (firmware version 2.0.0 or later), EOS

60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS

REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T3/

1100D, or EOS M camera.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [View] menu » [Sort] » desired item.

Edit in Edit image window Ctrl+Right Arrow

View collections Alt+G
Tool palette Ctrl+T
v Tab

v Folder view

v Toolbar

v Rating Ctrl+0

Large thumbnail Ctrl+1
@  Medium thumbnail Ctrl+2
Small thumbnail Ctrl+3

Thumbnail with information Ctrl+4

Sort H Rating: Descending order

Rating: Ascending order

File name

Shooting Date/Time
RAW priority

Check markl

Check mark2

Check mark3

Check mark4

Check mark5

The images are arranged in the order according to the selected
item.
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Sort item

Rating: ascending
order

Rating: descending
order

File name

Shooting Date/Time

RAW priority

Check mark1 -
Check mark5

Description

Sorted in order of fewest [ ].

Sorted in order of most [ ].

Images are sorted by file name in alphanumeric
order (0to 9 » Ato 2).

Images are sorted by shooting date and time
from the earliest.

Images are sorted in the following order: RAW
images - JPEG images - TIFF images.

Images with check marks take priority and are
sorted in number order.

-Z\@/E Check mark sorting order

When check marks from 1 to 5 have been set, the images are sorted as

follows:

Check mark1 selected: 1»2->3-4-5
Check mark2 selected: 2>3->4->5->1
Check mark3 selected: 3-4->5->1->2
Check mark4 selected: 4»5->1-2->3
Check mark5 selected: 5»1-»2-3->4

Arranging Freely

Drag and drop the image to the desired location.

T i . e e p—

The image moves to the desired location.

You can also select multiple images (p.20) and move them.

The order of rearranged images is maintained until you exit DPP
or select another folder in the folder area.

Select the [View] menu » [Sort] P [File name] to revert to the
order before the images were rearranged.

:@E Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you exit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in the [Preferences] to
maintain the order of images without changing the image file names
(p.92).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.103).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Tools] menu » [Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

Preferences

| General settings | | View settings | Tool palette | color management |

Grid pitch

64 Pixels(8-256)

Image selection status

| Images opened in Edit window remain selected in main window

Magnification in Edit window

@) Fit to window 0% 100% 200%

Magnification when the Edit/Edit image window is double-clicked

0% @ 100% 200%

RAW and JPEG

[ Display only CR2 images for CRZ and JPEG flles of the same name! )

Sort order in main window

Retain sort order

Highlight/shadow Alert
Highlight 255 (192-255) -
Shadow 1} (0-64) -

Quick check tool display

@ 50% 100% (moiré reduction off)

el

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [(XED] mark (p.128).

? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

-Z\@/E When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

* Deleting an image (p.49)

* Moving or copying an image (p.50)

» Checkmarking (p.18, p.19)

* Rating (p.18, p.19)

» Rotating an image (p.126, p.134, p.135)

» Attaching a thumbnail to an image and saving (p.23)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[ 3] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2 (p.127).

@ In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.
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Improving the Quality of an Image in the Main Window
Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images redraw
themselves more quickly.

With all the images selected, select the [File] menu »
[Add thumbnail to image and save].

File

Open in Edit window Ctrl+0
Open in Edit window (enlarged)

Save Ctrl+5
Save As.., Ctrl+Shift+5
( Add thumbnail to image and save Ctrl+Shift+T
Convert and save... Ctrl+D)
Batch process... Ctrl+B

Create new folder...

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Remove from collection Ctrl+5hift+G

Clear collection

Delete Del

E\@/E The extent of the improvement in quality

The quality is improved for any JPEG or TIFF image. While the image
quality improves regardless of the thumbnail size (p.10), selecting [Large
thumbnail], with its larger display size, shows the improvement more
clearly than [Medium thumbnail] and [Small thumbnail].

@ A large number of images may take some time to add.

Checking Image Information

Select the image for which you want to check the
image information.

Click the [Info] button.

igital Photo Pfﬂsl - [EA\Users\CANON\Pictu

File Edit Miew Bookmark Label Adjustment

2 @ R
t Tool Info Select all Clear all
Folder . Collection() |

Bl Desktop
-J-d Libraries

\ - Documents

The image information window appears (p.24).
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Select a tab sheet and check information.
[Shooting Information] tab sheet

| Shooting Information | Metadata |

[Metadata] tab sheet

IMG_0001.CR2 =

Item

File Name

Camera Model
Firmware

Shooting Date/Time
Owner's Name
Shooting Mode

Tw( Shutter Speed )
Av( Aperture Value )
Metering Mode
Exposure Compensation
150 Speed

Auto IS0 Speed
Lens

Value

IMG_0001.CR2

Canon EQS XXX

Firmware Version Xxx
WAL A VR R R

Shutter-Priority AE
11600

8.0

Evaluative Metering

a

400

OFF

EF70-200mm ff4L USM

m,

Focal Length 183.0mm
Image Size o O
Image Quality RAW

Flash Off

FE lock OFF

White Balance Mode Auto

AF Mode Manual focusing
Picture Style Landscape
Sharpness 4

Contrast a

Saturation ]

Color tone ]

Color Space sRGB

Long exposure noise reduc...  0:0ff

High IS0 speed noise redu... 0:Standard
Highlight tone priority 0:Disable

Auto Lighting Optimizer F:Disable
Peripheral ilumination corr... Disable

Dust Delete Data No

File Size FOHKR 2

IDEscripﬁun

7

[Document Title]
KRN

[Authar]
O

[Authar Title]
OOOGE

[Description]
AN

[Description Writer]
AN

[Keywords]
HHXKHHHK

[Copyright Status]
OO

[Copyright Notice]
OOOGE

[Copyrightinfo URL]
N

-

Shooting information is displayed in the [Shooting Information]
tab sheet, while IPTC* information appended to the image after
shooting is displayed in the [Metadata] tab sheet.

IPTC* information provides additional comments on images,
such as captions, credits and the shooting location. The
information is sorted into 5 different categories and can be
viewed by selecting [Description], [IPTC Contact], [IPTC Image],
[IPTC Content] or [IPTC Status] from the list box in the [Metadata]
tab sheet.

IPTC* information can only be appended to JPEG/TIFF images
using Photoshop (CS3 or later).

* International Press Telecommunications Council (IPTC)

The contents of the [Shooting Information] tab sheet will vary
depending on the camera model.

A/

-~ Convenient uses in the main window

Switching displays

If a different image is selected in the main window when the image
information window is displayed, the image information for that image
will be displayed.

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in [View]
menu » [Thumbnail with information] (p.10).
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the []
button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and
how to adjust automatically with the [RGB] tool palette are explained in
this section.

Edit window Tool palette
foe ot |- Adpatment  Trom  findos  baip :w::u:o e = |

e s et &)

[ | tam

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> +
<Z> keys.

|§| You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the image before and
after adjustment (p.53).
You can synchronize multiple images and edit while comparing
them (p.54).
See p.129 for a list of edit window functions, and p.130 for a list of
tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your
editing requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/ALO] and [LENS] tool palette are explained in
Chapter 3.

Editing with the Tool Palette in the Main Window

By clicking the [Tool Palette] button (p.126) in the toolbar on the main
window, the same tool palette that appears in the edit window is
displayed and you can edit images.
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Adjusting Brightness

The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.

RAW [RGB | NR/ALO | LENS | Reverts the image to
| Brightness adjustment ((= Jjit— the original settings
! 0.00 Enter a numerical value
[| white balance adjustment 5
|Z/ 1 2 3 Reqgister
|ﬂ (Auto) - | Tune...

Drag the slider left or right

|§| The adjustment range is —2.0 to +2.0 (in 0.01-stop increments when
entering a value).

Changing a Picture Style

If the image you shot is different to what you visualized, you can change
the Picture Style to get closer to what you envisaged.

Even if you have saved the image (p.41) with [Monochrome] (p.30)
selected, you can still change to another Picture Style at any point by
simply selecting a Picture Style other than [Monochrome].

Picture Style = Reverts the image to
@ (standard) [ srowse... the original settings

Select

\

-10.0 80 -0 40 -20 0.0 2.0 40
Contrast:(0) 1

@ Even if the RAW image is from a camera that does not have
Picture Style settings, you can still set a Picture Style as long as
the RAW image is compatible with DPP (p.3).

You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style (p.93).

[Auto] is only applied to images shot with the EOS-1D X, EOS-1D
C, EOS 5D Mark Ill, EOS 6D, EOS REBEL T5i/700D, EOS
REBEL SL1/100D, EOS REBEL T4i/650D, EOS REBEL T3i/
600D or EOS M.

When changing a Picture Style with several images selected, you
can select [Auto] if images shot with the EOS-1D X, EOS-1D C,
EOS 5D Mark Ill, EOS 6D, EOS REBEL T5i/700D, EOS REBEL
SL1/100D, EOS REBEL T4i/650D, EOS REBEL T3i/600D or EOS
M are included. However, [Auto] is actually applied only to images
shot with the EOS-1D X, EOS-1D C, EOS 5D Mark Ill, EOS 6D,
EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/
650D, EOS REBEL T3i/600D or EOS M.

You cannot select [Auto] with multiple-exposure RAW images
created on the camera.
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Picture Style

@)

Standard

Auto

Portrait

Landscape

Neutral

Faithful

Monochrome

Description

The Picture Style set on the camera when the
image was shot.

When a mode in the Creative Zone is selected on
the camera, the Picture Style setin () is
displayed.

When a mode in the Basic Zone is selected on
the camera, [Shot settings] is displayed in (), and
image characteristics that are according to the
selected shooting mode are applied.

The image looks vivid.

Ordinarily, this setting is suitable for most images.

The color tone will be adjusted to suit the scene.
The colors will look vivid. Especially the colors of
blue skies, greenery, and sunsets will be vivid in a
shot of nature, outdoor, or sunset scenes.

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.30).

For vivid blues and greens.
Effective for making images of landscapes
impressive.

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.30).

Picture Style

(Picture Style file
registered in the
camera)

[Picture Style file
applied in DPP]

Description

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

The name of the Picture Style file applied in DPP
is displayed in [ ].

Picture Style File

A Picture Style file is an extended function file of Picture Style. See p.59
for how to use Picture Style files.
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Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an
image of, for example, pale-colored flowers.

RAW |RgB | mR/ALO | LENS |

|Brightness adjustment - |
i 0.00
|White balance adjustment (=N Reverts the image to
] B ERE = the original settings
[ﬁ (Auto) v][ Tune. ..
' Select

& () is the white balance set on the camera when the image

was shot.

* When a mode in the Creative Zone is selected on the camera,
the white balance set in () is displayed.

* When a mode in the Basic Zone is selected on the camera,
[Shot settings] is displayed in ( ), and image characteristics that
are according to the selected shooting mode are applied.

* If you have corrected white balance, the correction value is
displayed in ().

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (this page).

-Z\@IE Tune with color tone
To make further fine adjustments to color tone after adjusting the white

balance, you can use [Color tone] (p.30) to get closer to your requirements.

® You cannot register the adjustment results as personal white
balance (p.100) when you have selected [ ( )] from the list box.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

|§| Refer to your camera’s Instruction Manual for details on each white
balance setting.

Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

RAW |RGB | nR/ALO | LENS |
| Brightness adjustment [?”
I 0.00
White balance adjustment a”
VIERIE Register... Click
@ (auto) -] Tune...

Click on a point that is to be the standard for white.

T

[ ot Pocne Proesaee S 5 D0LGCRD ]

[rrm—r— =

I
il

[ r— = e

] o] mee|

{11632 8000 220200205 ok f dooe G OOV o g

——
Click

The coordinates of the cursor position and Reverts the
the RGB values (8-bit conversion) image to the

original settings
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The color of the image is adjusted with the point you selected as
the standard for white.
If you click on another point in the image, the white balance is

Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to

Introduction

Contents at

adjusted again. the right to make contrast stronger and to the left to make contrast a Glance
To finish click white balance, right-click with the mouse or click weaker.
the [[# ]] button again.
|Picture Style (B Reverts the image to Basic
(@ standerd) =] Browse... the original settings Operation
i Advahced
; Opetion
B L Advanced
100 8.0 60 -40 -20 0.0 20 40 Image Editing
Contrast:(0}——— @ Drag the slider left or and P"ntlng
Highlight: (0) 0 right (9 steps)
shadow:(0) 1 Processing
[CLinear Large Numbers
Color tone: (0) 1 of Images
Color saturation:{0) [
[Unsharp mask VI Editing
I Strength:(0) N} JPEG/TIFF
Fineness:{0) [ Images
Threshold: (0) I}
Displays the value of the setting Reference
"2 When there are no white areas in your image etz

When there are no white areas in your image, you can adjust the white S . ) .
balance by clicking on a grey point of the image in step 2. This has the @< [Linear] - A function for advanced adjustment

same adjustment result as selecting a white point. Use [Linear] when you will be adjusting separately using image editing

software that has advanced editing functions. Note that when [Linear] is : :
|§| The image is adjusted based on the average value of 5 x 5 pixel checkmarked, the image will become dim. @
range from the clicked point. A o : . . .
You cannot change or adjust white balance with multiple- ﬁl Iﬁ:cﬁrl;tgr:zlegdhtmg OppflatizAelr (1) Sl vehleten i (el 2

exposure RAW images created on the camera. 29



Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.26) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (this page).

[Picture Style ([=J—— Reverts the image to
the original settings

[ﬁ (Standard) v] Browse. ..

-10.0 8.0 -6.0 =40 -20 00 20 4
Contrast:(0) I
Highlight: (0} {t
Shadow: () I

I

|:| Linear

Color tone:(0)

Color saturation: (0)——

lUnsharp mask v]
Strength:(0) 1
Fineness: (0] [}
Threshold:(0) 0

| Drag the sliders left or
[ right

Displays the values of the settings

Color tone: Mainly used for adjusting skin tones. Move the
slider to the right to make skin tones more
yellow, and to the left to make skin tones
redder.

Color saturation: The overall color depth of the image is
adjusted with color saturation. Move the slider
to the right to make the color deeper, and to
the left to make the color weaker.

@ The adjustment range is —4 to +4 (in 1-stop increments).

Adjusting Monochrome

When the Picture Style (p.26) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering and with the
look of a single-color photograph.

Select [Monochrome] in the [Picture Style] list box.

|Picture Style (= Reverts the image to
| Monochrome - | Browse.. | the original settings

it

Bl | w ll'al
e | W ! Lo |
-10.0 80 S0 40 -20 00 20 40
Contrast:(0) D
Highlight:(0) [
Shadow: (0) D I
F”Ereﬁectﬂ:::;r | Drag the sliders left or
Toning effect: (Mone) [t rlght
[Unsharp mask v]
Strength:(0) I
Fineness:{0) D
Threshold: (0) I}

Displays the values of the settings
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Filter effect: Creates an image where the white of clouds and the
green of trees are emphasized in the same
monochrome photograph.

Filter Example of effect
None Ordinary monochrome image without filter effect.

Blue sky is reproduced more naturally and white

Yellow
clouds emerge clearly.
Orange Blue sky becomes somewhat darker. The
9 brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

Toning effect: You can create a monochrome photograph to which a
single color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

Y
~

=@> Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider closer to the right.

Adjusting Image Sharpness

You can make the overall atmosphere of an image sharper or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and
[Unsharp mask].
[Sharpness]: Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting), the more the edges are
emphasized for a sharper image.

[Unsharp mask]: Adjusts the image’s sharpness more finely.

[Strength]: Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting), the more the image’s edges are
emphasized for a sharper image.

Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the more fine detail can be emphasized.
Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges’.

[Fineness]:

[Threshold]:
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Introduction
Select [Sharpness] from the list box and make the Detailed Setting of Image Sharpness
setting. Select [Unsharp mask] from the list box and make
|Picmre Style (=) Reverts the image to the setting. C:rgfanr::‘s:eat
[ﬁ (Standard) "] Browse... ] the original Settings |Pich..|re Style |
I I : ; i lﬂ (Standard) v] Browse. ..
; . R Basic
: RO Operation
| | Ad%ed
-10.0 €0 60 <40 -20 00 20 40 E Op et
Clonhl'astl:[l.']}l g -10.0 80 60 40 -20 00 20 4.0
HLghlzlllght:[{E;} ; I Contrast:(0) 1 Advanced
Shadow: (01 14l | Editi
[T Linear Highlight:(Q) [ ;nnag% A tli ::;g
Color tone:({0) 1 Shadow:(0) ) {l
Color saturation:{0) 1 [ )
\ Color tone:(0) (I Processing
([ sharpness -} Select [Sharpness] Color saturation:(0) T Large Numbers
Sharpness((1) [[Unsharp mask v} Select [Unsharp mask] of Images
w Strenghﬂ:5>— m
- @ i Editing
e d 3 JPEG/TIFF
Drag the slider left or right Images
Displays the value of the setting
Drag the slider left or right Reference
Displays the values of the settings —
Index

? The effects of sharpness adjustment appear unnatural

Adjust image sharpness with the window view set to [200% view],

00
©

[100% view] or [50% view]. If the view is set to [Fit to window] (full view),

|§| The adjustment range is 0 to 10 (in 1-stop increments). the effects of adjustment may seem unnatural. 30



Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.145). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired
automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

rawl | ReB  JnrjaLo [ LEns

|Tone curve assist

([ [ (=) Reverts the tone curve
[Tone curve adjustment = to the original settings

e J[R][c][e]

255 High
Standard

a

a 255

Brightness: i 0

Contrast: 1 0

Hue: D 0

Saturation: D 100

Sharpness: [ 0

The tone curve changes as adjusted.

A/

- Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

* Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

* Images which have extreme backlighting

® If you click the [[Z%]] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.109).
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Editing Efficiently
Editing in the Edit Image Window

The thumbnail display and the edit window are combined and images can
be edited efficiently while quickly switching between images to be edited.
Images to be edited are selected beforehand in the main window.

In the main window, select the images you want to edit.

Switch to the edit image window.

Select all Clear all

Bl Desktop
5 = Libraries
33 Documents

Click

The main window switches to the edit image window.

Edit the image.

Change the size
Edit image window
e S

Select the image to be edited
The selected image is displayed as an enlargement
in the middle of the window

It may take time for the image to redraw itself.
The same tool palette as in the edit window is displayed and you
can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> +
<Z> keys.

@ By selecting the [View] menu » [AF Point] in the edit window or edit
image window, you can display the AF points selected in the camera
at the time of shooting. However, AF points are not displayed for
images whose image size has been changed and then been
converted and saved (p.42, p.136), images for which you selected
an effect other than [Shot settings] as correction of fisheye lens
distortion aberration, or images which have had settings specified
during RAW processing on the camera for distortion correction and
chromatic aberration correction.
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Double-click the area you want to enlarge.
[0 2w Froms Pt - L Do AN Prtares P, AL AR £ TEer——

Double-
click

The area you double-clicked is enlarged to 100% (actual pixel
size).

To change the display position, drag on the image or drag the
enlargement display position (p.130) of the tool palette.
Double-click again to revert to the full view ([Fit to window]).

To return to the main window, click the [Main window] button on
the toolbar.

To display an image in an enlargement ratio other than 100%

Click the [50% view] or [200% view] on the toolbar.

5

You can change the way the tool palette is displayed (p.93).

You can change the enlargement ratio when you double-click
(p.92).

With the edit image window, you can only select images from one
folder. To gather images from several folders for editing, see
“Gathering and Editing Images in the Collection Window” (p.36).
For a list of edit image window functions, see p.135.
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Changing the Thumbnail Display Position to Horizontal

Select the [View] menu » [Change thumbnail

position].

:
| @ @™ ® ( {

If you select [Change thumbnail position] again, the thumbnail
display reverts to the vertical position.

Gathering and Editing Images in the Collection Window

You can gather any randomly selected images together in the
[Collection] window for viewing, comparison and editing. You can gather
images from several folders as well as from only one folder, allowing you
to work with them efficiently.

Select images from the [Folder] window in the main

window, and select the [File] menu » [Add to collection].

File

Open in Edit window Ctrl+O
Open in Edit window (enlarged)
Save Ctrl+5S
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+T
Convert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+ Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
' Add to collection Ctrl+G
EMOVE 1T0M CONECLion CLrl+3nit+
Clear collection
Delete Del
Info Ctrl+I
Exit Alt+F4

The selected images are added to the [Collection] window and the
number of selected images is shown on the [Collection] tab sheet.
When you add RAW and JPEG images displayed as a single
image (p.22), the number of images shown on the [Collection]
tab sheet increases by 2.

You can select several images and add them to the [Collection]
window.

You can also add images to the [Collection] window by selecting
images, right-clicking with your mouse, and selecting [Add to
collection] from the menu that appears.

You can add up to 1,000 images to the [Collection] window.
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B ®

Selectall  Clearall

Pl Desktop
{4 Libraries
133 Documents

SRGE | Adobe RGE High quaity Recos date: e Phamber of images: 7

Harber of seleted mages: 1 o

Edit the images.
You can now edit the images displayed in the [Collection]
window.
Images displayed in the [Collection] window are retained in the
[Collection] window even after exiting DPP.

|
\\/

:@5 To remove images from the [Collection] window

Removing randomly selected images
Select the images to be removed in the [Collection] window and then
select [Remove from collection] in the [File] menu. (You can also remove
images from the [Collection] window by selecting the images, right-
clicking with the mouse, and selecting [Remove from collection] from the
menu that appears.)
Note that even if you remove an image from the [Collection] window, the
original image remains unaffected.

Removing all images
Select [Clear collection] in the [File] menu. (You can also remove all
images from the [Collection] window by selecting one image, right-
clicking with the mouse, and selecting [Clear collection] from the menu
that appears.)
Note that even if you remove all images from the [Collection] window,
the original images remain unaffected.

® Modifications to the image are applied to the original image
Modifications made to images added to the [Collection] window are
all applied to the original image.

ﬁl You can arrange images displayed in the [Collection] window the
same way as in the [Folder] window (p.20, p.21). You can
maintain the order of rearranged images even after exiting DPP
by checkmarking [Retain sort order] on the [View settings] tab
sheet in the [Preferences] (p.92).

You cannot use the following functions in the [Collection] window.

« Starting of EOS Utility (p.7), or synchronizing of folders with
EOS Utility
» Batch change the file name of images (p.103)
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Trimming and Adjusting the Angle of an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before trimming. If
you select [Circle] for [Aspect ratio], the area outside the specified range
is only masked in black and the image will not be cropped.

Adjust the angle of the image as needed.
Trimming/angle adjustment window

Select the image to be trimmed.

Open the trimming/angle adjustment window.
Click the [Trimming Angle] button.

I

3 &

Stamp

Batch

process

]

Rotate right GQuick

check

Trimming
Angle

Ratng » » = » »

—1— Largest

possible
trimming
range

+— Click (rotate
image left
or right in
90-degree
increments)

The trimming/angle adjustment window appears.
Editing can be done once the image is displayed clearly in the
trimming/angle adjustment window.

Drag* (0.01-degree increments;
adjustment range: -45 to +45 degrees)

Use the mouse (click A/V) to adjust the angle or
directly enter the adjustment angle*
increments; adjustable range: -45 to +45 degrees)

(0.01-degree

* You cannot adjust the angle of images that exceed 9999 x 6666

pixels in size.

If you click [Center on Screen], you can display the trimming

range in the center of the window.

When correcting lens aberrations, it is recommended to perform
lens aberration correction before adjusting the angle of the

image.
If you click the [OK] button after adjusting only the

angle of the

image, the image will be trimmed at the largest possible trimming

range.

|§| When aspect ratio information is attached to an image shot with the
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-
1D Mark Ill, EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 60D, EOS
REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/650D,
EOS REBEL T3i/600D or EOS M, the trimming range based on the

aspect ratio information is displayed.
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Select a ratio and drag the trimming range.

« (=)—Cancel

- Select a
trimming
S ratio

. e | —Dragthe
trimming
S range

{704, 362) > (228, 1413) = (1577 £ 1051) [ 1.50)

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range. (Not available
when [Circle] is selected.)

List of aspect ratios (width : height)

4:5

A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

Circle

[Free]: You can trim an image to any size, regardless of the
selectable ratio.

[Custom]: You can trim an image at the specified ratio.

[Circle]: The area outside the specified range is masked in
black. The image is not trimmed.

Click the [OK] button to return to the main window.

The trimming range frame is displayed in the trimmed image
(p.128).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.43).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.128).

 Edit window: The image is displayed in its trimmed condition.

+ Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.42).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D
Mark 111, EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 60D, EOS REBEL
T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/650D, EOS
REBEL T3i/600D or EOS M, the set trimming range based on the
aspect ratio information is displayed. Since the image is not actually
trimmed, you can change the trimming range or revert to the condition
before trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 5D Mark Ill, EOS 6D, EOS 60D, EOS REBEL
T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/650D, EOS
REBEL T3i/600D or EOS M, its trimming range cannot be changed
nor reverted to the condition before trimming, since the image is
actually trimmed and saved in the set trimming ratio.”

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.137).

* When shooting with EOS 5D Mark Il and [Add cropping information]
is set in Custom Functions, aspect ratio information is only set and
the image is not actually trimmed, even for JPEG images.

ALy

> Convenient functions of the trimming/angle adjustment
window

Ay

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys or the <F11> key.

Operate using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the <Ctrl> key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <Shift> key.

® For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

@ For a list of the trimming/angle adjustment window functions, see
p.137.
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Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]
menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu » [Paste recipe].
The recipe is applied to the image.

|§| The recipe (p.98) can be saved as a separate file from the image
and loaded and applied to another image (p.99).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.38) range information can be saved to a RAW image or to a
separate RAW image.

The adjustments made with the tool palette (p.56 to p.68) and the dust
erase processing explained in Chapter 3 (p.73 to p.77) can also be
saved in a RAW image.

Select the [File] menu » desired item.
File
Open in Edit window Ctrl+0

Open in Edit window (enlarged)

Save Ctrl+5
Save As... Ctrl+Shift+5
Ctrl+Shift+T

Add thumbnail te image and save
Convert and save... Ctrl+D

Batch process... Ctrl+B

Create new folder...

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing *
Add to collection Ctrl+3
Remaove frem collection Ctrl+Shift+G
Clear collection

Delete Del
Info Ctrl+1
Exit Alt+F4

Your adjustments are saved to the image.
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Saving as a JPEG or TIFF Image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

The image is saved as a separate image, so the RAW image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

File

Open in Edit window Ctrl+0
Open in Edit window (enlarged]
Save Ctrl+5
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+T

( Cenvert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Remove from collection Ctrl+5hift+G
Clear collection
Delete Del
Info Ctrl+I
Exit Alt+Fd

The [Convert and save] window appears.

Specify the necessary settings, and then click the

[Save] button.
By default, the image is converted and saved to a JPEG image

with the highest image quality, without changing the image size.

Change the settings according to your requirements.

-— Select the save

s destination
A
Computer
“w —
B Crre——— =) Click and save
Save o5 type: Enl-JPEGI JPG.* JPEG) - Concel
Qualty setting
Image qualty /] 10
Bty Enter a file name and

Output resolution EE -] ¥ Embed 1CC profie in mage I t . t
e select an image type
Resine

The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

|
\\/

:@3 To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two differing versions of DPP, processing results may
differ very slightly even if with the same RAW image data, or the results of
significant editing of RAW image data with an attached recipe may be different.
When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

|§| By saving as explained on this page, a trimmed image (p.38) or
dust-erased image explained in Chapter 3 (p.73 to p.77) actually
becomes a trimmed image or dust-erased image.
You can reduce the noise characteristic of JPEG images which

occurs when you convert and save an image as a JPEG (p.91, p.92).

You can batch convert and save multiple images (p.101).
For a list of [Convert and save] window functions, see p.136.
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.25 to p.33), so the “original image data itself”
remains unaffected.

Also, the trimming range information of a trimmed image (p.38) is simply
saved to the image.

For this reason, you can undo any adjustments saved (p.41) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Adjustment |
Rotate Left Ctrl+L
Rotate Right Ctrl+R

Apply Dust Delete Data
Work color space 3

Tone Curve Assist - Standard

Tone Curve Assist - High

Ctrl+ Alt+Z
Ctrl+Shift+Z

Revert to last saved settings
Revert to shot settings

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with Canon inkjet printers compatible with the Canon printing software,
Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how to print
photographs using other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (this page)
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint (p.46)
Printing Photographs with a Printer other than Canon Inkjet Printers
(p.49)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with Canon
inkjet printers compatible with Easy-PhotoPrint EX (hereinafter, “EPP
EX"):

Simple printing of RAW images

Printing with faithful colors

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.
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Introduction

Select the image to be printed. In the EPP EX window, select the [File] menu »

[Preferences].

Start up EPP EX. [File] Contents at
Select the [File] menu » [Plug-in printing] » [Print with Easy- Open- cuk-C gloles
PhotoPrint EX]. Previous Step —

Mext Ste
[File] d Basic
Open in Edit window Ctrl+0 save ‘ Cirls Operation
Open in Edit window (enlarged) Savefse
Save Ctrl+5S [ erf:rencesm —
Save As... Ctrl+Shift+5 e w Ad%ed
Add thumbnail to image and save Ctrl+Shift+ T My Recent Files op ion
Convert and save... Ctrl+D Exit
Batch Ctrl+B :
atch process " The [Preferences] window appears. Advanced
Create new folder... |mage Edit|ng
. e In [Print Quality], select [Quality Priority], click the and Printing
Print with detailed setfing... Ctrl- Alt+ P [Option] button. In the dialog box that appears,
Contact Sheet Prints... Ctrl+Shift+P checkmark [Prlnt with the best quallty]_ Processing
Plug-in printing Print with Easy-PhotoPrint EX J _ Large Numbers
(e . == of Images
Add to collection Cirl+G m— —
Remove from collection Ctrl+Shift+G .
Clear collection [E spool print job page by page Edltlng
| Number of copies : 1 ] Copies JPEG/TIFF
Delete Del printing Order [pyoae -] Images
Info Ctrlsl Amount of extension of borderless printing : pefatt -]
Print Quality : Quality Priority ) Sel eCt
Exit Alt+Fd : :
Ql.JaI!ty Reference
EPP EX starts up. Priority
—
Index
I
[ oK ] [ Cancel ] [ Help ] @ @
Click and checkmark [Print with the best quality] g;:
S
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Introduction
Select the [Advanced] tab, checkmark [Enable ICC Select the paper type, and then click the [Layout/
profile], and then click the [OK] button. Print] button.

The [Preferences] window closes. S - Contents at
Specify the number of sheets to be printed, and then e — i a Glance
click [Select Paper]. e -

EPP EX R pa e : Basic
e — f—n U U AL [ Operation
= ot - | | B Select the S

_ | = T = g | paper size AdvRced
S [ = g s | andtype [N
coo | cwe ) couo| cws ] cas | cus “"(:)—Click to , -

increase the Advanced
&m“ ‘ ﬁg = number of | Image Editing
T e T T, sheets o be I and Printing
. IC—=_0
h printed == - _ -
_ g Processing
, R Click Large Numbers
_‘ of Images
*.
4 B— Spemfy the layout, and then click the [Prlnt] button.
.|:- f-"_ il s, 0_D0S_ WG D00 MAD_DXOT_ UG 000K MAO_DO0A_ MIC. x_; o = JPEGITIFF
Click a == Images
M:” g Bardered
T Select the
L[] layout Reference
—_
= 0, Index
D —————————
| i || 0 o»
_ B 00

Click to print @

Printing begins.



? Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

The printed image’s color is not what you expected

In the EPP EX window, select [Preferences] in the [File] menu and
then click the [Advanced] tab in the [Preferences] window to display
the [Advanced] tab sheet.

In the [Advanced] tab sheet, select [Enable ICC profile] in [Color
correction for printing] and try printing using the [Perceptual] setting
(p.146).

A/

-@> Advantages of printing with EPP EX

Printing with faithful colors

When the color space (p.146) is set to SRGB or Adobe RGB (p.78,
p.95), this color space is automatically transmitted from DPP to EPP
EX, allowing you to print with faithful colors.

When the color space is set to Apple RGB or ColorMatch RGB, the
image is printed with an sRGB color space, and when set to Wide
Gamut RGB, with an Adobe RGB color space.

Printing with a wide color reproduction

When the color space setting (p.78, p.95) is set to Adobe RGB and
the image is printed with a Canon inkjet printer, the color reproduction
range is wider, and green and blue in particular are reproduced
vividly.

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.88).

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint

You can perform the following types of photograph printing with Canon
inkjet printers compatible with Easy-PhotoPrint (hereinafter, “EPP”):
Simple printing of RAW images
High quality printing using the color reproduction range of Adobe RGB
and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP version 3.5 or
later on your computer. When using an Easy-PhotoPrint EX-compatible
inkjet printer, it is recommended that you print using Easy-PhotoPrint EX

(p.43).

Select the image to be printed.

Start up EPP.
Select the [File] menu » [Plug-in printing] » [Print with Easy-
PhotoPrint].

Cpen in Edit window ChrlHC

Open in Edit window (enlarged)

Save Chrl+5
Save As... Ctrl+5hift+5
Add thumbnail ko image and save  Cbrl+Shift+T
Convert and save.. Ctrl+D
Batch process... Ctrl+B

Creake new folder.. .

Print. .. Ctrl+P
Print with detailed setting. .. CEH+AlE+P
Contact Sheet Prints., .. Ctrl+3hift+F
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In the EPP window, select the [File] menu »

[Preferences].

Preferences. ..
Exit

The [Preferences] window appears.

In [Print Quality], select [Quality Priority].

Preferences b_?|
Frint | Advanced
[15paal print job page by page
Mumber of copies ; Copies
Printing Order : | By Date v |
Amount of extension of borderless printing : | Default h |
Frint Quality :
Defaults

[ 0k ] [ Cancel

J [

Help

]

Select
Quality
Priority

Select the [Advanced] tab sheet and check that the
EPP image compensation function is disabled.
If not disabled, the operation of the EPP image compensation
function may prevent images being printed with faithful color

reproduction.
Preferences [‘5?|
Fririt | Advanced |
Image @]ptimiza images automatically
Apply Ratate/Trimming ta the same images in the same manner
‘When landscape images are rotated depending on the selected layout :
(%) Rotate Left
() Rotate Right
Layout [ &hways tim when you select the layout with the margins
Set margins ta the minimurn when you select the layout with the marging
Print filename when you select the index in layout
Preview all layouts of &4 and Letter
Image Select images from multipls folders
Selection
Defaults
\
[[ Ok ] I Cancel ] [ Help ]
v 4

If checked,
click to
remove the
check mark

Click to
close the
window

Specify the number of sheets to be printed, and then

click [Next].

D Lasy PhetoPrint

Fapes 508 - 4t 1015 Medka Trpe : Fhotn Pages Pro

increase the
number of
sheets to be
printed

J
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Check that the image compensation function is
disabled, select the paper type and then click [Next].
If checked, click to remove the check marks

Click

Select the
paper type

Pages S 41t 1Paget)

Click to print

} S P U
] Il : LT

L3 L] L3 L] L]

.
bt et 8 o i i o o P Trea

Select the layout

=» Printing begins.

? Additional information

© Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

© The printed image’s color is not what you expected
Change the [Rendering intents when using Easy-PhotoPrint] (p.94) to
[Perceptual] (p.146) and print.

|
\\/

== Printing with a wide color reproduction

When the color space (p.78, p.94) is set to Adobe RGB and the image is
printed with Canon inkjet printer, the color reproduction area widens,
and green and blue in particular are reproduced vividly.

When the color space is set to Apple RGB or ColorMatch RGB, the
image is printed with an sRGB color space, and when set to Wide
Gamut RGB, with an Adobe RGB color space.

@ DPP is also compatible for printing with Easy-PhotoPrint Pro (p.88).
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Organizing Images
This section explains how to delete unwanted images, create folders for
saving images, move or copy images, etc., and organize your images.

Introduction

Printing Photographs with a Printer other than Canon Inkjet Printers

You can print one image on one sheet of paper.

Contents at

. a Glance
Select the image to be printed. Deleting an Unwanted Image
Be aware that you cannot recover deleted images. ]

Select the [File] menu » [Print]. ObE o
e Select an unwanted image in the main window.

Open in Edit window Ctrl+ 0

i — Select the [File] menu » [Delete]. Advaficed

Save Ctrl+5 = Op ion

save As.. Ctrl+Shift+5 Open in Edit window Ctrl+ 0

Add thumbnail to image and save Ctrl+Shift+T

Open in Edit window (enlarged) Advanced
Convert and save... Ctrl+D v
Batch process. Ctrl+B save Ctrl+5 Image E-dl-tlng
; _ and Printing
Save As... Ctrl+Shift+5
Create new folder... Add thumbnail te image and save Ctrl+Shift+T
( Print... Ctrl+P Convert and save.. Ctrl+D Processing
Print with detailed setting... Ctrl+Alt+P Batch process... Ctrl+B Large Numbers
Centact Sheet Prints... Ctrl+Shift+P of lmages
Create new folder...
Plug-in printing 3
Print... Ctrl+P HH
Add to collection Ctrl+G T _ _ Editing
Print with detailed setting... Ctrl+Alt+P JPEG/TIFF
Ri f llecti Ctrl+Shift+G
Emove from cofection e Contact Sheet Prints.. Ctrl Shift+P Images
Clear collection L
Plug-in printing 3
Delete Del .
Add to collection Ctrl+G
Info Ctri+l Remowve from collection Ctrl+5Shift+G Reference
Exit Alt+F4 Clear collection
. . ( Delete Del
The [Print] dialog box appears. — T g
naex
Set to photograph printing and print. Exit Alt+F4

Specify the optimum settings for photograph printing in the _ _ )
printer’s print settings dialog box and click the [OK] button. The [Confirm File Delete] dialog box appears.

Printing begins. Click the [Yes] button. @ @

The image is moved to the [Recycle Bin] and is deleted from DPP.
The images are deleted completely from your computer when the
[Empty Recycle Bin] operation is performed on the [Recycle Bin]

on the desktop.
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Creating a Folder for Saving Images Moving Images U
You can create a folder for sorting images. You can move or copy images to a separate folder and sort by shooting c
ontents at
date or themes. a Glance
In the folder area, select the location where the new —
folder is to be created. Drag the image to be moved or copied.
) . ; i i Basic
(ET e e | To move: Drag thg image and release when the image is in the Operation
| File Edit View Bookmark Label Adjustment Took Window Help destination folder.
To copy: Drag the image while holding down the <Ctrl> key and
: release when the image is in the destination folder. Advihced
Folder Collection(@) | mgs-nﬂ O Op ion

B Desktop

E\\e Edit  View mark Label Adjustmel s Window Help

-1 Libraries
- [ Documents &a\ D
ol Select all Clear all Rotste left Rota| Adva n ced
o e Image Editing
[ Rt [ colecton) and Printing
. B Desktop
Select the [File] menu » [Create new folder]. Fg i
= ; $ o Processing
Open in Edit window Ctrl+ 0 B L Photo Large Numbel's
Open in Edit window (enlarged) j‘“Sa.Es of lmages
Save Ctrl+5 o@@ E::;Do:p
Save As... Ctrl+Shift+S i E'::Su"'m 4 _ = Editing
Add thumbnail to image and save Ctrl+Shift+T &?y Metwork 7 JPEG/TIFF
Convert and save... Ctrl+D o T ‘ a Images
Batch process... Ctrl+B | il
(__ Creste newfolder.. The images are moved or copied to the destination folder.
Print... Curl+P Reference
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P —
Plug-in printing 4
Add to collection Ctrl+G Ind X
Remove from collection Ctrl+Shift+G &
Clear collection - )
Delete Del
Info Ctrl+I
00
The [Create new folder] dialog box appears. @
Enter a folder name and click the [OK] button. o

The new folder is created in the folder selected in step 1.



Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <Ctrl> key and
release when the folder is in the destination folder.

@ Digital Photo Professional - [E\Us=rs\CANON Ficture o
E Edit View Bookmark Label Adjustment T Help

) (B @

Tool Info Seleciall  Clearall  Rotsie bt Rots
Palatte

J-3 Documents
gl Music
D .

& Homegroup
- B CANON
+-78 Computer
- Network
- 4y Travel

The folders are moved or copied to the destination folder.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders appear by clicking the [Bookmark] menu.

Select the folder for which a bookmark is to be
registered.

=) <4 Libraries
% Documents
g Music

e Select

| 3ample Plctares
- H videos

4, Homegroup

& CANON

=
HE

®
IMG_0001.CR2 ™

o
Select the [Bookmark] menu » [Add].

The folder selected in step 1 is registered in the [Bookmark]
menu.

Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.

Organizing Bookmarks

You can change a folder name or delete a folder registered in
[Bookmark].

Select the [Bookmark] menu » [Organize].
The [Sort bookmarks] window appears and you can change
folder names or delete folders.
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3 Advanced Image Editing and Printing

Various preferences including advanced image adjustment, automatic
dust erasure processing, various printing functions for printing out work,
and color management are explained here, geared to the user who is
competent in the handling of third-party image editing software.

Adjusting While Comparing with the Original Image... 53
Changing How the Window is Split.............ccccoeeee 53

Adjusting by Comparing Multiple Images................. 54

Displaying an Area Beyond the Set Range as a

Warning Indicator (Highlight/Shadow Warning) ....... 95

Performing Advanced Editing............ccccoooovieiiinnnn, 56
Adjusting White Balance with Color Temperature ..... 56
Tuning White Balance with Color Wheel ................... 56
Adjusting Dynamic Range .............cccccveeeeeieeeenninnns o7
Adjusting Brightness of Shadows/Highlights ............. o7
Tone Curve Adjustment.............oooiiiiiee 58

Example of a Tone Curve Operation ..................... 29
Using a Picture Style File..........cccoooveiiiiiiiieeee. 59
About the RGB Tool Palette .............ccccceeeeiiiiinnen. 60

Using the Auto Lighting Optimizer...............c............ 61

Reducing NOISE........coooiiiiiiiiiiiii e 62

Correcting Lens Aberration ...........ccoooovvviiiiieeeennnnnnn. 63
Compatible Cameras..........ccccoeeeeiiiii 63
Compatible Lenses.......ccccoeeeeeiiiiiie 63
Making Corrections.............ceevveeeeeiiiiiiiieeeeee e 65

Effects of Distortion Aberration Correction for Fisheye

LENSES...ciiiieiieeeeeeeeeeee 66
About Shooting Distance Information Slider.............. 68
Correcting Multiple Images ata Time............cccccc...... 68

Using the Digital Lens Optimizer ............ccccccooeoee. 69
Compatible Cameras.............cccceeoeiiiiiiiieeeee, 69
Compatible Lenses...........ccccoeeeieiiiiiiiiii 69
Using the Digital Lens Optimizer..........ccccccoeeeieiiennnnn. 70

Performing Automatic Dust Erasure Processing ..... 73
Compatible Cameras............ccccccvviiieeeieeeeeeee e, 73
Automatic Dust Erasure Processing in the Main Window... 75

Manually Erasing Dust (Repair Function)................ 75
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCLION). .. 77

Transferring a RAW Image to Photoshop................ 78

Setting Work Color Space ...........ccoovvvvvvveiiiinciennnnn. 78

Compositing Images.........cccceevvieiiiiiieeeeecee e 78
Compositing Methods..............coooiiiiiiiiiieee e, 82

Creating HDR (High Dynamic Range) Images........ 82

Starting Up Map ULility ........cccooeveeiiiiiie 85

Printing with Shooting Information........................... 86

Printing a Thumbnail List (Contact Sheet Printing).. 87

Printing RAW Images on a High-End Canon Printer.. 88
Printing with a High-End Canon Inkjet Printer ............ 88

Printing with DPP and Easy-PhotoPrint Pro........... 88
Printing with DPP and Print Studio Pro .................. 89
Printing with a Large-Format Canon Printer............... 90

Specifying Preferences..........ccccoceevieieiiiiciiceeeeenn. 90
General SettingS.........ooooooiiiiiiiiiiii e, 91
View SettingS.......oooooiiiiiiiiieeee e 92
Tool Palette .....c.cvveeeeeeeeee e 93

Color Management.............coooeecviiiieieiee e, 94
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Adjusting While Comparing with the Original Image

Introduction
You can display before and after versions of an adjusted image in the

same window and adjust while checking the adjustment results. Changmg How the Window is Sp“t
You can change the display of the image to a single image split in two. .
In the edit window, select the [View] menu » [Before/ ontents at
after comparison]. In the edit window, select the [View] menu » [Display L
g e e mode] » [Split single image].
i | Basic
Operation

—

Advanced
Operation

Imag\aﬂtmg
and Pfinting

=»One image is divided and displayed on the left and right or top
and bottom. Processing
© To switch between top and bottom, and left and right, perform the Large Numbers

Change the image display. same operation as step 2 on the left page. | of Images

The image divides into a left and right window.
The window on the right shows the image after editing.

Select the [View] menu » [Change up/down/left/right] » [Up/ Editing

down]. JPEGITIFF
: e - Images

—_—

Reference

The layout of the two images changes to top and bottom. @ @
The bottom window shows the image after editing. @

|§| Images can also be displayed in the edit image window by the same
operation.
53



Adjusting by Comparing Multiple Images e
You can synchronize the display position of multiple edit windows and Move the display position.
adjust images while comparing them with each other. If you move the enlargement display position in one of the edit

T ] . : windows, the enlargement display position will also change in the Contents at

In the edit window, display the multiple images to be other edit windows. a Glance

compared. To cancel synchronization, select the [Window] menu » —
. . hroni in.

Align the images. [Synchronize] again Basic
Select the [Window] menu » [Arrange vertically] or [Arrange Operation
horizontally]. N —
The edit windows are aligned.

Advanced

Select the [Window] menu » [Synchronize]. °P°’at'°“

Enlarge the image.

Imag |t|ng
Enlarge and dlsplay any of the edit windows. and Pfinting

Processing
Large Numbers

of Images
—_—

Editing
JPEG/TIFF

Images
R

Reference

The other edit windows will also be displayed in the same

position/enlargement ratio. @ @

@ Synchronization only applies to the enlargement display position @
and the enlargement ratio. Adjustments to the images are not

synchronized.
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Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning)

You can set up a warning indicator in both the highlighted part and the
shaded part, which is effective for checking the light and dark areas and
preventing excessive adjustment of an image. Where the area on the
image has exceeded that set range, you can display the highlighted part
in red and the shaded part in blue.

Select the [Tools] menu » [Preferences].

Select the [View settings] tab sheet.

Enter the warning value for [Highlight] and [Shadow].

Preferences

General settings View settings | Tool palette I Color management |
Grid pitch
64 Pixels(8-256)
Image selection status
Images opened in Edit window remain selected in main window
Magnification in Edit window
@) Fit to window 7) 50% ) 100% T 200%
Magnification when the Edit/Edit image window is doubledicked
2 50% @ 100% 21 200%

RAW and JPEG

["Display only CR.2 images for CR2 and JPEG files of the same name:

Sort order in main window

[] Retain sort order

Highlight/shadow Alert
Highlight 255 192-255) .

Shadow 0 0-64) .

Quick check tool display

@ 50% *) 100% (moiré reduction off)

Cancel

Click the [OK] button to close the window.

Display the edit window.

Select the [View] menu » [Highlight]. Similarly, select
[Shadow].
On the opened image, if there is an area that exceeds the value
entered in step 3, the highlighted part of that area is displayed in
red and the shaded part is displayed in blue.

|§| You can also display the warning with the same operation in the edit
image window.
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Performing Advanced Editing

This section explains how to use the advanced adjustment function on
the tool palette in the edit window.

Adjustments made using the high-level functions of the [RAW] and
[RGB] tool palettes, as well as the functions of the [NR/ALO] and [LENS]
tool palette are explained in this section.

Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

RAW [RGB |NR/ALO | LENS |

| Brightness adjustment |1||
I 0.00

”Whibe balance adjustment E”

] 213)

I Colnrtemperature_ F“ Tune... |
(ssnu K}

Drag the slider left or right

— Displays the value of the
setting

|§| The adjustment range is 2500 to 10000K (in 100K increments).

Tuning White Balance with Color Wheel

White balance can be tuned by moving a cursor in the color direction
shown in the color wheel.

In the [RAW] tool palette, click the [Tune] button.

Tune by dragging a point.
You can also fine-tune your adjustment by directly entering the
adjustment values.

QK

Cancel

Calor tone:
— Enter the values to set
Color saturation:

® To register adjustment results as personal white balance (p.100),
select a setting other than [ @@ ( )] from the [White balance
adjustment] list box, and then tune with the color wheel. You
cannot register the adjustment results as personal white balance
when you have selected [ @ ( )] from the list box and have done
any tuning.

You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

ﬁl The adjustment range of color tone is 0 to 359 (1 increment in
numerical value input), and the adjustment range of color saturation
is 0 to 255 (1 increment in numerical value input).
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Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

[Picture Style (=]
'@ (standard)

vl[ Browse... ]

= Move downwards
Output highlight points

I

Move to the left or rignt
Input highlight points

-10.0 "
Contrast:(0)
Highlight: (0
Sll-.gadlzw-(z)) Move upwards
" Fluinear Output shadow points

Color tone:(0)
Color saturation:{0)
[Unsharp mask v]

Strength:(0)
Fineness:{0)

Threshald:{0)

Move to the left or right
Input shadow points

The horizontal axis shows the input level and the vertical axis
shows the output level.

Adjusting Brightness of Shadows/Highlights

You can adjust the brightness of shadows and highlights in an image.
By adjusting shadows and highlights in an image with a restricted
brightness, you can reduce the effects of clipping in shadows and
highlights.

Picture Style (=]
@ (Standard)

vl Browse...

-10.0 8.0 60 -40 -20 0.0 20 40
Contrast:(0) 1 '
Highlight: (0) @ | E_)rag the sliders left or
Shadow:{0) @ r'ght
|:|Linear

Color tone:(0)
| Color saturation:{0)

[Unsharp mask vl
Strength: (D) 1
Fineness: () [
Threshold: (0) I
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Introduction

Tone Curve Adjustment Make adjustments. ]
You can adjust the brightness, contrast and color of a specific area by RAW | RGB [NR/ALO | LENS |
changing the tone curve (p.145). i“’“e curve assist )] C:’gfa"r:‘s:eat
Tone curve adjustment |
In the tool palette, select the [RGB] tab sheet. [Ir@[‘?j)
255 Adjusts each channel Basic
. . Batch adiusts RGB Operation
Select the tone curve mode and interpolation atch aqjusts
method.
RAW | RGE  |NR/ALO [ LENS | _ _ ég‘é?:ﬁgg
|Tone curve assist | Clle toadd a [D] (p0|nt)
|Tc:ne urve adjustment | AdJUSt by dragglng [0l
R g C.i!’
25 and mflhting.
o Processing
Large Numbers
of Images
@ Curve Brightness: D u] S —
Straight i
- Right-click with the ot 0 0 Editing
© RGERGB i .
mouse inside the graph .
Luminance R G B to display the menu e ! i Images
Saturation: D 100
- . Sharpness: 1 [u} Reference
: - The horizontal axis shows the input level and the vertical axis
Brightness: L o shows the output level.
Contrast: 0 0 The maximum number of [[]] is 8. Index

To delete a [[1], either press the <Del> key or double-click on the [[]]. “—iir’

Hue: D @ a

Saturation: [ @ 100

Sharpness: 1} 0 @ @
@ The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any @‘

adjustments (p.93). o

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.93).




Example of a Tone Curve Operation
Makes medium tones brighter

Makes medium tones darker

Makes tones sharper Makes tones softer

Using a Picture Style File

A Picture Style file is an extended function file of a Picture Style.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon Web site effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Display the image to which the Picture Style file is to
be applied in the edit window (p.11).

Select the [RAW] tab sheet in the tool palette, and
click the [Browse] button.

|Piu:ture Style
'@ (standard) -

Browse...

-10.0 8.0 %0 40 -20 00 20 40

The [Open] dialog box appears.

Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.

To apply a different Picture Style file, follow the procedure from
step 2 again.

ﬁl The Picture Style files that you can apply to the camera are files with
the “.PF2” or “.PF3” extension only. Furthermore, you cannot apply
Picture Style files with the extension “.PSE” to an image; however if
such a file is registered in the camera and the image is shot, the
image will display correctly.
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About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your
editing requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the functions in the [RGB]
tool palette is wider than the [RAW] tool palette, the image color may be
saturated, or the image quality may deteriorate if you adjust too much.
Therefore we recommend for functions other than tone curve
adjustment (p.58) and automatic adjustment (p.33), that you adjust
images using the same functions available in the [RAW] tool palette.
See Chapter 5 for explanations on functions of the [RGB] tool palette
other than tone curve adjustment.

-:\@/3 Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/ALO] and [LENS] tool palette
(p.131) when applying the Auto Lighting Optimizer (p.61), reducing
noise (p.62) or correcting aberration (p.63) after you have made any
required adjustments with the [RAW] and [RGB] tool palettes.
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Using the Auto Lighting Optimizer
If the shooting result is dark or the contrast is low, you can use the Auto
Lighting Optimizer function to auto-correct the brightness and contrast,
and obtain a more pleasant image.

You can also change the settings of the image shot with the camera’s
Auto Lighting Optimizer function.

This function is compatible only with RAW images shot with EOS-1D X,
EOS-1D C, EOS-1D Mark IV, EOS 5D Mark Ill, EOS 5D Mark Il, EOS
6D, EOS 7D, EOS 60D, EOS 50D, EOS REBEL T5i/700D, EOS REBEL
SL1/100D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL
T2i/550D, EOS REBEL T1i/500D, EOS REBEL T3/1100D and EOS M.
* ALO stands for Auto Lighting Optimizer.

Select the [NR/ALO] tab sheet from the tool palette in
the edit window or edit image window.

RAW | RGE ( MRIALD }ENS
| Auto Lighting Optimizer |
7 U
| Low Standard Strong
| Noise reduction Apply |
MR Preview...
RAW
Luminance noise reduction:{1)
o 20
Chrominance noise reduction:{3)
0 0 20

TIFF/IPEG

Checkmark the checkbox.

Raw | RGE | MRIALO | LENS

| Auto Lighting Optimizer

ﬂ

| Low Standard Strong

Checkmark

For images shot with the camera’s Auto Lighting Optimizer
function, the checkbox is already checked.

Change the settings according to your preferences.

Rawy |RGE | MRIALD | LENS

| Auto Lighting Optimizer |

| U;
| Low Standard Strong

Select from three levels:
Low/Standard/Strong

Auto correction is applied to the image to match the settings.
For images shot with the camera’s Auto Lighting Optimizer
function, the settings at the time of shooting are applied as the
default values.

To cancel the Auto Lighting Optimizer, remove the check mark
from the checkbox.

When [Highlight tone priority] is set to [Enable] in EOS-1D X,
EOS-1D C, EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 60D, EOS
REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/
650D, EOS REBEL T3i/600D, EOS REBEL T2i/550D, EOS
REBEL T3/1100D and EOS M, the Auto Lighting Optimizer
function cannot be set.

You cannot use the Auto Lighting Optimizer with multiple-
exposure RAW images created on the camera.
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Reducing Noise

You can reduce noise that arises in RAW images shot at night or with a
high ISO speed.
NR is an abbreviation for “noise reduction”.

Select the [NR/ALO] tab sheet from the tool palette in
the edit window or edit image window.

Click the [NR Preview] button.

| Moise reduction Apply |

[ [ MR. Preview... ]

RANY

The [NR Preview] window appears.

Adjust an image.

Cancel

Navigator
window

—Enlargement

display
Ra position
Luminance noise rj n:(7)
z i = Drag the
Chrominance noise, tion: (8) .
" 1 = sliders

NR check window

You can set a noise reduction level from within a range of 0 to 20.

The larger the setting, the larger the noise reduction effect.

The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.

You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Click the [Apply] button.

Noise reduction is applied to the image and the image is
redisplayed.

"2 The noise reduction function does not work

Noise reduction cannot be applied when [Viewing and saving RAW
images] (p.91) is set to [High speed] in the [Preferences] window.
Select [High quality] to reduce noise.

Vi
2= To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/ALO]
tool palette (p.131) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

i

You can set the default noise reduction beforehand, using
[Default noise reduction settings] in the [Tool palette] tab sheet in
the [Preferences] (p.93).

* When [Apply camera settings] is selected, you can pre-set a
noise reduction level that suits the camera settings beforehand
as the default.

* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand. This is
particularly useful for applying noise reduction to all the images
in a folder at once, such as batch noise reduction for images
with high ISO speeds.

However, for images with recipes attached, the noise level

recorded in the recipe will be applied.

If [Luminance noise reduction] has been set, resolution may be

reduced along with reduction of noise.

If [Chrominance noise reduction] has been set, color bleeding

may occur along with reduction of noise.

For a list of [NR Preview] window functions, see p.133.
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Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that you can only correct RAW images which have been
taken with the compatible cameras and lenses listed below. JPEG or
TIFF images cannot be corrected.

Compatible Cameras

EOS-1D X EOS-1DC EOS-1D Mark IV
EOS-1Ds Mark Il EOS-1D Mark Il EOS-1D Mark II N
EOS-1Ds Mark I EOS-1D Mark Il EOS-1Ds

EOCS-1D EOS 5D Mark Il EOS 5D Mark Il

EOS 5D*1 EOS 6D EOS 7D

EOS 60D EOS 50D EOS 40D

EOS 30D*? EOS REBEL T5i/700D EOS REBEL SL1/100D

EOS REBEL T4i/650D EOS REBEL T3i/600D EOS REBEL T2i/550D

EOS REBEL EOS DIGITAL REBEL EOS DIGITAL REBEL
T1i/500D XSi/450D XTi/400D DIGITAL
EOS REBEL EOS DIGITAL REBEL EOS M

T3/1100D XS/1000D

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

Compatible Lenses

Fisheye, ultra wide, and wide angle lenses
EF 14mm f/2.8L USM EF 14mm f/2.8L Il USM*3
EF 8-15mm f/4L USM Fisheye*3 EF 15mm f/2.8 Fisheye*3
EF 20mm /2.8 USM EF 24mm f/1.4L USM
EF 24mm f/1.4L Il USM*3 EF 24mm /2.8
EF 24mm /2.8 IS USM*3 EF 28mm /1.8 USM
EF 28mm /2.8 EF 28mm /2.8 IS USM*3
EF 35mm f/1.4L USM EF 35mm /2
EF 35mm /2 IS USM*3 —

Standard and medium telephoto lenses

EF 40mm f/2.8 STM*3
EF 50mm f/1.4 USM

EF 50mm /1.8 1l

EF 85mm f/1.2L Il USM*>
EF 100mm f/2 USM

EF 50mm f/1.2L USM*4
EF 50mm /1.8

EF 85mm f/1.2L USM
EF 86mm /1.8 USM

Telephoto lenses

EF 135mm f/2L USM

EF 200mm f/2L IS USM*3
EF 200mm /2.8L 1l USM
EF 300mm f/2.8L IS USM
EF 400mm f/2.8L IS USM
EF 400mm /5.6L USM

EF 500mm /4L IS USM

EF 600mm /4L IS USM

EF 800mm f/5.6L IS USM*3

EF 135mm /2.8
(with Softfocus mechanism)

EF 200mm /2.8L USM

EF 300mm f/2.8L IS Il USM*3
EF 300mm f/4L IS USM

EF 400mm f/2.8L IS Il USM*3
EF 400mm f/4 DO IS USM
EF 500mm f/4L IS 1l USM*3
EF 600mm f/4L IS Il USM*3
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Zoom lenses

EF 16-35mm f/2.8L Il USM*3
EF 17-40mm f/4L USM

EF 24-70mm f/2.8L USM

EF 24-70mm f/4L IS USM*3
EF 24-105mm f/4L IS USM
EF 28-90mm f/4-5.6 USM

EF 28-90mm f/4-5.6

EF 28-90mm f/4-5.6 Il

EF 28-105mm f/3.5-4.5 1| USM
EF 28-105mm f/4-5.6

EF 28-200mm /3.5-5.6

EF 28-300mm /3.5-5.6L IS USM

EF 16-35mm f/2.8L USM

EF 17-35mm f/2.8L USM

EF 20-35mm /3.5-4.5 USM
EF 24-70mm f/2.8L Il USM*3
EF 24-85mm /3.5-4.5 USM
EF 28-70mm f/2.8L USM

EF 28-90mm f/4-5.6 1l USM
EF 28-90mm /4-5.6 I

EF 28-105mm /3.5-4.5 USM
EF 28-105mm /4-5.6 USM

EF 28-135mm f/3.5-5.6 IS USM
EF 28-200mm f/3.5-5.6 USM
EF 55-200mm /4.5-5.6 Il USM  EF 55-200mm f/4-5.6 USM

EF 70-200mm f/2.8L USM EF 70-200mm f/2.8L IS USM

EF 70-200mm /2.8L IS Il USM*3 EF 70-200mm f/4L USM

EF 70-200mm f/4L IS USM*4 EF 70-300mm f/4-5.6L IS USM*3
EF 70-300mm f/4-5.6 IS USM EF 70-300mm /4.5-5.6 DO IS USM
EF 75-300mm f/4-5.6 11*3 EF 75-300mm f/4-5.6 111*3

EF 75-300mm f/4-5.6 USM EF 75-300mm f/4-5.6 Il USM

EF 75-300mm f/4-5.6 Il USM EF 90-300mm f/4.5-5.6

EF 90-300mm f/4.5-5.6 USM EF 100-300mm f/4.5-5.6 USM
EF 100-400mm f/4.5-5.6L IS USM —

Macro lenses
EF 50mm f/2.5 Compact Macro*3 EF 100mm f/2.8 Macro USM
EF 100mm /2.8L Macro IS USM*3 EF 180mm f/3.5L Macro USM

MP-E 65mm f/2.8 1-5x Macro
Photo*3

EF-S lenses
EF-S 60mm f/2.8 Macro USM EF-S 10-22mm f/3.5-4.5 USM
EF-S 15-85mm /3.5-5.6 IS USM*3 EF-S 17-55mm /2.8 IS USM
EF-S 17-85mm f/4-5.6 ISUSM  EF-S 18-55mm /3.5-5.6 IS STM*3
EF-S 18-55mm f/3.5-5.6 EF-S 18-55mm f/3.5-5.6 Il
EF-S 18-55mm /3.5-5.6 I1I*3 EF-S 18-55mm f/3.5-5.6 USM
EF-S 18-55mm f/3.5-5.6 Il USM  EF-S 18-55mm f/3.5-5.6 IS*3
EF-S 18-55mm f/3.5-5.6 IS I3 EF-S 18-135mm f/3.5-5.6 1S*3
EF-S 18-135mm f/3.5-5.6 IS STM*3 EF-S 18-200mm f/3.5-5.6 1S*3
EF-S 55-250mm f/4-5.6 1S*3 EF-S 55-250mm f/4-5.6 IS II*3

EF-M lenses
EF-M 22mm f/2 STM EF-M 18-55mm f/3.5-5.6 IS STM

Aberration correction will not apply to images shot with a combination of
lenses *3 *4 *5 and EOS 5D or EOS 30D with the firmware versions below.
* You cannot attach an EF-S lens to EOS 5D.

*3 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.5 or earlier

*4 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

*5 EOS 5D with firmware version 1.0.5 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

You can also correct RAW images taken with the compatible lens
even when the extender is attached.

You can also correct RAW images shot with EF 50mm /2.5
Compact Macro fitted with Life Size Converter EF.

The aberration correction function is not available for images shot
with combinations of camera/lens other than those given under
“Compatible Cameras” and “Compatible Lenses”. They are
therefore not displayed and cannot be used.

The lens aberration correction function is not available for
multiple-exposure RAW images created on the camera.

EF cinema lenses (CN-E lenses) are not compatible.
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Making Corrections

You can make corrections to any of the four aberrations as below, either
one at a time or simultaneously.
Peripheral illumination
Chromatic aberration (color fringing which occurs in the periphery of
an image)
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)
Distortions

In the tool palette, select the [LENS] tab sheet.

Click the [Tune] button.

RAYW | RGE NRJALD | LENS

| Digital Lens Optimizer Tune. .. |

Setting OFF

Lens data @ Mo

Update...

| Lens aberration correction I | Tune. . |

Peripheral illumination OFF
Chramatic aberration QFF
Color blur OFF

LCiskartion CFF

The [Lens aberration correction] window appears.

Checkmark the items to be corrected.

(I Lens aberration comection -

The image is corrected and redisplayed.
Check the results of corrections to peripheral illumination or
distortions in the full view.

Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check. In the
top right of the window, the area is displayed at 200% in the
enlargement display section (p.138).

You can lessen the degree of correction by moving the slider to
the left for the item you want to correct.

You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

To correct distortion aberration of images shot with a fisheye lens
(EF 8-15mm f/4L USM Fisheye or EF 15mm /2.8 Fisheye), four
effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

The level of an effect can be adjusted with the adjustment slider
located below [Distortion].

For detailed information on each effect, see “Effects of Distortion
Aberration Correction for Fisheye Lenses” (p.66).
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For images shot with EF 8-15mm /4L USM Fisheye, a fine-tune
slider is also displayed when you select [Emphasize Linearity]
from the [Effect] list box.

Adjust the amount of correction for distortion aberration with the
adjustment slider, and then adjust with the fine-tune slider if more
adjustment is required.

When the list box for selecting an extender is displayed, select
the extender attached at the time of shooting from the list box.

Click the [OK] button.

The [Lens aberration correction] window closes and the result of
the corrections is applied to the image in the edit window and the
image is redisplayed.

The result of the settings of the [Lens aberration correction]
window is also displayed in the tool palette.

In the main window, the [ g}¥ ] mark is displayed on the image to
indicate the lens aberration corrections (p.128).

Effects of Distortion Aberration Correction for
Fisheye Lenses

Shot settings
By selecting this option, only distortion aberration correction for
correcting optical distortion is performed.

Emphasize Linearity
This converts the image to a “central projection” style image. This
projection method is used with general lenses.

Differing from fisheye lenses, central projection displays straight lines

as straight lines. By selecting this option, a wide-view panoramic

image can be obtained. However, the periphery is stretched, resulting

in decreased resolution.
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Emphasize Distance

This converts the image to an “equidistant projection" style image.
This projection method preserves distance relationships.

Equidistant projection displays the same distances from the center to
the periphery as the same distances. In particular, when shooting a
celestial body such as the celestial sphere, any height above the
horizon (declination) is captured at an equal interval. This method is
therefore used in such photography as celestial photography (star
maps, solar path diagrams, etc.).

Emphasize Periphery

This converts the image to a “stereographic projection” style image.
This projection method emphasizes the periphery.

Stereographic projection allows position relationships on a spherical
surface, such as N, S, E, W on a map, to be displayed correctly. It is
therefore used for world maps and monitoring cameras.

By selecting this option, the periphery is stretched and may result in
decreased resolution.

Emphasize Center

This converts the image to an “orthogonal projection” style image.
With this projection method, the center is more emphasized.

Since an orthogonal projection allows a subject of the same
brightness to be displayed as occupying the same area in the image,
this method has typical uses in photography for celestial luminance
distributions and center-emphasized animal photography. By
selecting this option, the center is stretched and may result in
decreased resolution.

© While selecting any of the options [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center] will yield results similar to each of the projection methods,
the conversion does not exactly apply each projection method in
their precise sense.
Accordingly, care should be taken since they are not suited to
scientific or other such purposes.
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About Shooting Distance Information Slider

When correcting RAW images shot with the cameras in the table below,
if shooting distance information has been saved to the image, the slider
is set automatically according to this shooting distance information.
However, if no shooting distance information is saved to the image, the
slider is set automatically to the right end at infinity position and a [<!>]
appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

The distance cannot be minutely adjusted by using the slider forimages
shot with an EF-M lens. (The slider is not displayed.)

EOS-1D X EOS-1DC EOS-1D Mark IV
EOS-1Ds Mark Il EOS-1D Mark Il EOS 5D Mark Il
EOS 5D Mark I EOS 6D EOS 7D

EOS 60D EOS 50D EOS 40D

EOS REBEL T5i/700D EOS REBEL SL1/100D EOS REBEL T4i/650D
EOS REBEL T3i/600D EOS REBEL T2i/550D EOS REBEL T1i/500D

EOS DIGITAL REBEL EOS REBEL EOS DIGITAL REBEL
XSi/450D T3/1100D XS/1000D

EOS M — —

When correcting RAW images shot with the cameras in the table
below, it is set automatically to the right end at infinity position. You
can then minutely adjust the distance by operating the slider while
looking at the screen if the shooting distance is not infinite.

EOS-1D Mark II N EOS-1Ds Mark Il EOS-1D Mark Il
EOS-1Ds EOS-1D EOS 5D
EOS 30D EOS DIGITAL REBEL

XTi/400D DIGITAL

For RAW images shot with MP-E 65mm f/2.8 1-5x Macro Photo or EF
50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

[Shooting distance information] slider is applied to all the correction
items with check marks.

Correcting Multiple Images at a Time

Select multiple images to correct in the main window. Display tool
palette by clicking the [Tool Palette] button (p.126) in the toolbar. If you
perform correction procedures (p.65) when tool palette is displayed, you
can apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.41).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.62). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p-31).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.30) and/or the color saturation (p.109) to
make the color deeper.

The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

® The periphery of the image may be truncated when [Distortion]
correction is made.

|§| For a list of the [Lens aberration correction] window functions, see
p.138.
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Using the Digital Lens Optimizer

This function enables the resolution of images to be increased by
removing any remaining aberration related to image-forming capability
or any deterioration of resolution resulting from diffraction phenomena
that are unavoidable as long as light must pass through the lens. These
optical phenomena cannot be corrected under [Lens aberration
correction] (p.63). Correction is achieved using the designed value of
each lens. The images that can be corrected are RAW images shot
using any of the following “compatible cameras” and “compatible
lenses”. JPEG, TIFF, S-RAW, and M-RAW images cannot be corrected.
To use this function, [Lens data] for the lens used to shoot images first
needs to be downloaded to your computer.

Before using the Digital Lens Optimizer, it is recommended that you set
[Sharpness] or [Strength] for [Unsharp mask] for images to 0.

Compatible Cameras

EOS-1D X EOS-1DC EOS-1D Mark IV

EOS-1Ds Mark I EOS-1D Mark Il EOS-1D Mark II N

EOS-1Ds Mark I EOS-1D Mark Il EOS-1Ds

EOS-1D EOS 5D Mark Il EOS 5D Mark I

EOS 5D*1 EOS 6D EOS 7D

EOS 60D EOS 50D EOS 40D

EOS 30D*2 EOS REBEL EOS REBEL
T5i/700D SL1/100D

EOS REBEL EOS REBEL EOS REBEL

T4i/650D T3i/600D T2i/550D

EOS REBEL EOS DIGITAL REBEL EOS DIGITAL REBEL

T1i/500D XSi/450D XTi/400D DIGITAL

EOS REBEL EOS DIGITAL REBEL EOS M

T3/1100D XS/1000D

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

Compatible Lenses

EF 14mm f/2.8L USM
EF 20mm /2.8 USM
EF 24mm f/1.4L USM
EF 28mm /1.8 USM
EF 35mm f/1.4L USM

Wide angle lenses

EF 14mm f/2.8L Il USM
EF 24mm f/1.4L 1l USM
EF 24mm /2.8 IS USM
EF 28mm /2.8 IS USM
EF 35mm f/2 IS USM

Standard and medium telephoto lenses
EF 40mm f/2.8 STM EF 50mm f/1.4 USM
EF 50mm f/1.2L USM EF 85mm f/1.2L USM
EF 85mm f/1.2L 1l USM EF 85mm /1.8 USM

Telephoto lenses
EF 300mm f/2.8L IS Il USM EF 400mm f/2.8L IS Il USM
EF 500mm f/4L IS 1l USM EF 600mm f/4L IS Il USM

Zoom lenses
EF 16-35mm f/2.8L Il USM
EF 24-70mm f/2.8L USM
EF 24-70mm f/4L IS USM

EF 16-35mm f/2.8L USM
EF 17-40mm f/4L USM

EF 24-70mm f/2.8L Il USM
EF 24-105mm f/4L IS USM EF 28-70mm f/2.8L USM

EF 28-200mm /3.5-5.6 USM EF 28-200mm f/3.5-5.6

EF 28-300mm /3.5-5.6L IS USM EF 70-200mm f/2.8L IS USM
EF 70-200mm f/2.8L IS I USM  EF 70-200mm f/4L USM

EF 70-200mm f/4L IS USM EF 70-300mm f/4-5.6L IS USM
EF 100-400mm f/4.5-5.6L IS USM —
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Macro lenses
EF 100mm f/2.8L Macro IS USM —_

EF-S lenses
EF-S 55-250mm f/4-5.6 IS I EF-S 55-250mm f/4-5.6 IS
EF-S 10-22mm f/3.5-4.5 USM EF-S 15-85mm f/3.5-5.6 IS USM
EF-S 18-55mm /3.5-5.6 Il USM  EF-S 18-55mm /3.5-5.6 USM
EF-S 18-55mm f/3.5-5.6 llI EF-S 18-55mm f/3.5-5.6 Il
EF-S 18-55mm f/3.5-5.6 EF-S 18-55mm f/3.5-5.6 IS Il
EF-S 18-55mm /3.5-5.6 IS EF-S 17-55mm /2.8 IS USM
EF-S 17-85mm f/4-5.6 IS USM  EF-S 18-55mm f/3.5-5.6 IS STM
EF-S 18-135mm /3.5-5.6 IS EF-S 18-135mm f/3.5-5.6 IS STM
EF-S 18-200mm /3.5-5.6 IS —

EF-M lenses

EF-M 22mm f/2 STM EF-M 18-55mm f/3.5-5.6 IS STM

The Digital Lens Optimizer is also available for images shot with
an extender mounted on a compatible lens.

You cannot use the Digital Lens Optimizer with multiple-exposure
RAW images created on the camera.

EF cinema lenses (CN-E lenses) are not compatible.

Using the Digital Lens Optimizer

In the tool palette, select the [LENS] tab sheet, and
check the status of [Lens data] for [Digital Lens
Optimizer].

RAW | RGE | MR/ALD [ LENS

| Digital Lens Optimizer Tune... |

Setking OFF
Lens data : Mo '
Update. ..

| Lens aberration carrection | Tune. .. ||
4 [l

[Not Available] is displayed for an image shot with a non-
compatible camera or lens, or for a non-compatible image such
as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot
be used for these images.

If [No] is displayed, proceed to step 2. To use the function, you
need to download [Lens data] for the lens used when shooting
the image. It is recommended that you check the lens used when
shooting the image beforehand. The lens used can be checked
using the [Info] button in the toolbar on the main window (p.23).
You can also check it with the menu that appears when you right-
click with the mouse on an image.

If [Yes] is displayed, proceed to step 4.

|§| Before you click the [Update] button in step 2, Lens data [No] may

be displayed instead of [Not Available] for non-compatible images.
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Click the [Update] button.

Checkmark the checkbox for the lens used to shoot

Introduction

—_—

e the image, and click the [Start] button.
| Digital Lens Optimizer Ture... | r. Add or Remove lens Corgfnts at
a Glance
Setting OFF ; EF14mm F2.8L IT USM
| |EF24mm F1.4L II USM
) | |eF3smm F1.4L usM
Lens data: Mo [ |EFsomm F1.2L UsM Basic
|_|EFSomm F1.4usM .
|_|EF85mm F1.2 11 UsM Operatlon
; EF300mm F2.8L IS II USM
|Lens aberration correction Tunz... | |_|EF400mm F2.8L IS IT USM
f L EF500mm F4L IS II USM
The [Add or Remove lens data] window appears. o Advanced
[ |EF16-35mm F2.5L USM Operatlon
| |eF 17-40mm FaL usm
: EF24-70mm F2,8L IT USM
| |eF24-70mm F2.8L UsM
: EF24-105mm F4L IS USM
:EFZB-300mm F3.5-5.6L IS USM Imag |t|ng
; EF70-200mm F2.8L IS II USM d t
L | EF70-200mm F2.8L IS USM an Ing
~300mm P, Processing
’_|EFlo04DDmm F4.5-5.6L IS USM N S Large Numbers
Add: 1/Delete: 0 [[ Start ]! Cancel ] Of lmages
—_—
=» The lens data is downloaded to your computer. Editing
When the downloading of the lens data ends, the indication for J'TES;':F
[Lens data] changes to [Yes]. -
You can download the data for up to 30 lenses at the same time.
If you remove the check mark from the checkbox for already- Reference
downloaded lens names and click the [Start] button, the lens data
will be deleted from your computer.
Index
—_—

® To use this function, an environment with Internet access

(subscription to a provider, browser software installed and an in- ® Depending on the type, current state, etc. of software running on
your computer, the download of the lens data may fail. If it occurs,
wait for a while then try downloading the data again.

place line connection) is required.

An administrator-level privilege is required for this operation. 71



Click the [Tune] button.

RAW |RGE | mRjaLo | LEMS |

| Digital Lens Optimizer I[ Tune... ]

Setting OFF

Lens data : Yes

The [Digital Lens Optimizer] window appears.

Checkmark the [Setting] checkbox and adjust the
image.

Digital Lens Optimize:

L

" Shooting distance information

Setting : {100)

o 100

;

&

Introduction

—_—

Contents at
a Glance
D ————————

Basic
Operation

—

Advanced

Operation

—

Advapced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

e ¥
|:| Do not sharpen previews
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@ © The [Setting] checkbox will be checkmarked if the image has the

Digital Lens Optimizer already applied. Remove the checkmark
and click the [Save] button to cancel the Digital Lens Optimizer.
Images displayed in the [Digital Lens Optimizer] window are with
[Sharpness] and [Unsharp mask] effects applied by default. If you
checkmark the [Do not sharpen previews] checkbox, images are
displayed without [Sharpness] or [Unsharp mask] effects applied,
allowing you to check only the Digital Lens Optimizer effect.
When applying the Digital Lens Optimizer, the effect of
[Sharpness] or [Unsharp mask] may become excessive. It is
recommended that you set [Sharpness] or [Strength] for [Unsharp
mask] for images to 0 before using the Digital Lens Optimizer.
Adjust [Sharpness] or [Unsharp mask] again after applying the
Digital Lens Optimizer to images.
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results are applied to the image in the edit window.

Performing Automatic Dust Erasure Processing= |
When the list box for selecting an extender is displayed, select The Dust Delete Data that is appended to images shot with the camera
the extender attached at the time of shooting from the list box. that can attach this data, can be used to automatically erase dust spots.
\L/JVshe th[eMs:ijit]ar t(zj .adjlust ’?fe Dtigitalljl_c.atn? LOptimOiZ(:.r effec’;. - Contents at
en is displayed for the Digital Lens Optimizer level, the - a Glance
effect will remain the same even if you move the slider further to Compatlble Cameras
the right.
You can change the display_position o_f_the_check win_dow by EOS-1D X EOS-1D C EOS-1D Mark IV o‘iaé;?on
dragging the enlargement display position in the navigator
window. EOS-1Ds Mark 11l EOS-1D Mark I EOS 5D Mark IlI
Even if you set shooting distance for a lens in this window, the EOS 5D Mark Il EOS 6D EOS 7D Advanced
value indicated for shooting distance in the [Lens aberration Operation
correction] window will not change. EOS 60D EOS 50D EOS 40D
If no shooting distance information is saved to the image, the EOS REBEL EOS REBEL EOS REBEL
shooting distance slider is set automatically to the right end at T5i/700D SL1/100D T4i/650D Img‘;‘%‘jﬁ?ng
infinity position and a [<!>] appears above the shooting distance EOS REBEL EOS REBEL EOS REBEL and Pfinting
slider. The distance cannot be minutely adjusted by using the T3i/600D T2i/550D T1i/500D
slider for images shot with an EF-M lens. (The slider is not Processin
displayed.) EOS DIGITAL REBEL EOS DIGITAL REBEL EOS REBEL Large Numbg's
. o XSi/450D XTi/400D DIGITAL T3/1100D of Images
Images cannot be corrected for [Chromatic aberration] in [Lens g
aberration correction] if the Digital Lens Optimizer has been EOS DIGITAL REBEL EOS M L
applied. XS/1000D Editing
JPEG/TIFF
i . . . . |
Click the [Save] button. In the main window, select an image appended with mages
Dust Delete Data.
Sl o | e | Click the [Stamp] button. Reference
= |
iqi imi i i 3 = - Index
The [Digital Lens Optimizer] window closes and correction i».‘ @ @ @

Corrections made in the [Digital Lens Optimizer] window are also
displayed in the tool palette.

In the main window, the [%] mark is displayed on the image to
indicate that the Digital Lens Optimizer is applied (p.128).

After clicking the [Save] button, the application of the corrections
to the image may take some time.

The size of the image file will be larger after applying the Digital
Lens Optimizer.

Rotate right Quick Stamy
check

Rating & & » » »

o

The copy stamp window appears.
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When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

f\Pctused Phot THS6 « 2304

St b L0 wiew 1o perfinm stamg cperaton

Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.
The [@,] mark (p.128) is displayed on an image from which dust
spots have been erased.

? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.75) or the copy stamp function (p.77).
The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).
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-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then

displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, see p.142.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in

multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.

Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image you want to
erase dust spots.

Click the [Stamp] button.

I
) ® @ @ @

Rotate right Quick Stamp Trimming Batch
check Angle process

Rating & & & & »

The copy stamp window appears.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

\ HCANON Pt CRa [345% + 2704 e

Double-
click

St b L0 wiew 1o perfinm stamg cperaton

The display changes to 100% view.
The display position can be changed by dragging.
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Click the button that matches the dust spot to be
erased.
If the dust spot is dark in color, click the [[@»C)]] button, and if
the dust spot is light in color, click the [[C»C]] button.
When you move the cursor over the image, the dust erasure
range appears as [Q].
Place the dust spot to be erased within the [O] and
click.

() = Click

[T —

The dust spot within the [Q] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, either right-click with
the mouse, or click the button clicked in step 4 again to cancel dust
erasure processing and perform the operation again from step 3.
When the dust spot cannot be erased, [§)] is displayed.

Click the [OK] button to return to the main window.
The [@,] mark (p.128) is displayed on an image from which dust
spots have been erased.

? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.77).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).
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AL/

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you
can efficiently erase dust spots by clicking the images while holding
down the <Ctrl> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <Shift> key, and then displaying the copy
stamp window.

® For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

|§| For a list of the copy stamp window functions, see p.142.

Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1 to 3 in “Manually Erasing Dust (Repair
Function)” (p.75).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <Alt> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [@,] mark (p.128) is displayed on a corrected image.
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Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop.

Select the [Tools] menu » [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, see p.102.

|§| Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.145) is added. The ICC profile
contains information about [Preferences] (p.94) or work color
space set for each image as described below and the appropriate
color information is relayed to Photoshop.
When you exit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred

image as a separate image in Photoshop is highly recommended.

For CS4 or later versions of Photoshop, this function is not
available if a 32-bit version is not installed.

Setting Work Color Space

A different work color space (p.146) from the default settings (p.94) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and then
subsequently change the default color space setting (p.94), this default
setting will not be applied and the individually set color space will remain.

-:\@/3 The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.

Compositing Images
You can combine two images into a single image. You can further
combine images by adding another image to the composited image.

Since the composited image is saved as a separate image, the original
images remain as they are.

|§| This function can be used with all image types (p.3) supported by
DPP. However, images with more than 6666 x 4444 pixels are not
supported.

The color space of a composited image will be the color space of
the background image.

Image information is not appended to a composited image.

Select a background image in the main window.

LT

|.. e - —— [ — [ ——

: You can also select a background image from the edit window,
edit image window, or [Collection] window.
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Select the [Tools] menu P [Start Compositing tool].

Tools
Start Quick check tool Alt+Q
Start Trimming/Angle Adjustment tool Alt+C
Start Stamp tool Alt+5
[Start Compaositing tool Alt+X ]

Start HDR tool Alt+Y
Start Rename tool Alt+R
Start EOS Utility Alt+0
Sync folder with EQS Utility

Transfer to Photoshop Alt+P
Preferences... Ctrl+ K

The compositing tool window appears.

Foregound Tinage

Select an mage

|| Fer image comprsiting, select an image ta combine.

Select the image to combine.
Select the image to combine from the [Foreground Image] list
box.

100% view ]

Fareground Image

|1MG_poot.CRZ -

Select an image
IMG 0001.CR2

IMiG 0002, CRE
IMG_D004,CRE
IMG_D006,CR2

The selected image is displayed in the [Foreground Image]

thumbnail display.

A preview of the combined background image and foreground

image is displayed in the composite preview.

The following images can be combined.

* When a background image is selected in the main window
([Folder] window) or edit window: image in same folder as
background image

* When a background image is selected in the [Collection]
window: image in the [Collection] window

* When a background image is selected in the edit image
window: image displayed in the thumbnail display area

You can combine images of differing sizes.
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Select a compositing method.

Select a compositing method from the [Composite Method] list
box.

[ 100% view |

Foreground Image

MG _nooz.cr2 -|

Composite Method
|add - |
I Add
L .ﬁ.veraEE
Lighten
Darken

Position
The compositing method selected in the composite preview is
applied.
The compositing method can be selected from five types: Add,
Average, Weighted, Lighten, and Darken. For details on each
compositing method, see “Compositing Methods” (p.82).
If you select [Weighted], you can set the proportion of brightness
of the image to be combined. Use the [Weight] slider at the
bottom of the [Composite Method] list box or directly enter a
value to set the brightness proportionally.
By clicking the [100% view] button, the image is displayed at
100% magnification (actual pixel size).
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Introduction
Position the images.
‘=' EAUsers\CANON Pictures\Photolan o oAIMG_0001.CR2 | |
| Contents at
Foreground Image a Glance
—
Basic
Operation
Advanced
Composite Method ope ration
[¥] Compose in RAW Format
Weight n i ]| Ad Ced
Positon = Shift large amount (50 pixels) Imag iting
‘é and Pfinting
[ Shift small amount (1 pixel)
E%@@ o Processing
= Align image centers Large Numbers
2 ) . of Images
x o &vo = p———— Youcanalsodirectly enterthe position —
coordinates of the [Foreground Image] "
to align it Editing
g = gn it JPEGI/TIFF
[ o= | Images
Reference
By default, the background image and the [Foreground Image] are
displayed with their centers aligned. —
[Compose in RAW Format]
Checkmark the [Compose in RAW Format] checkbox as necessary. Index
@ You can set [Compose in RAW Format] under the following @ The following functions are not available for images composited —
conditions. with [Compose in RAW Format].
Both the background image and [Foreground Image] are RAW * Auto Lighting Optimizer (p.61) @ @
images, and, all the following conditions are met. « Picture Style Auto (automatically set to Standard) (p.59)
* The cameras used to shoot were of the same model « Selecting [Circle] for the aspect ratio when trimming (p.39) @
* The ISO speed setting at time of shooting was the same Q

* The highlight tone priority setting at time of shooting was the same
» The image sizes (original size) are the same
81



Click the [Save As] button.

2]
=
RN ENICY
=]
£2
[ Congnue ]
[ Save As... D

By clicking the [Save As] button, the [Convert and save] window
(p.42) appears. Specify the required settings, and then click the
[Save] button.

By clicking the [Continue] button, images are combined to create
a new background image, and you can continue by combining
another image.

To finish, click the [Close] button.

Compositing Methods

Add

The brightnesses of the background image and [Foreground Image]
are added and images are overlaid.

Average

Images are overlaid with negative exposure compensation being
applied automatically. If you want to change the amount of exposure
for individual images, select [Weighted].

Weighted

Compositing method where brightness is set proportionally for the
[Foreground Image].

Lighten

The background image and the [Foreground Image] are compared,
with only brighter portions being combined.

Darken

The background image and the [Foreground Image] are compared,
with only darker portions being combined.

Creating HDR (High Dynamic Range) Images
You can create images with a wide dynamic range where clipping in
highlights and shadows has been reduced, and images that appear like
paintings. This is suited for scenes such as still-lifes and landscapes.
This function is most effective when using three images with different
exposures of the same scene (negative exposure, standard exposure,
positive exposure) to create an HDR image. However, you can also
create an HDR image from two images, or even only one.

Since an HDR image is saved as a separate image, the original images
remain as they are.

* HDR stands for High Dynamic Range.

|§| This function can be used with all image types (p.3) supported by
DPP. However, images with more than 6666 x 4444 pixels are not
supported.
Image information is not appended to an HDR image.

Select an image in the main window.
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Introduction
Select the [Tools] menu » [Start HDR tool]. Specify the required settings, then click the [Start
Toolsl HDR] button-
Start Quick check tool Alt+Q -
Start Trimming/Angle Adjustment tool Alt+C Contents at
Start Stamp tool Alt+S a Glance
Start Compositing tool Alt+X —
(stert HOR tool Aty )
Start Rename tool Alt+R Basi'c
Start EOS Utility Alt+0 Operatlon
Sync folder with EOS Utility
Transfer to Photoshop Alt+P
Preferences... Ctrl+K IMG_0001.CR2 | IMG_0002.CR2 | IMG_0003.CR2 édvantc'ed
. Cooeen o [ome.. ] peration
The [Select Images] window appears. ——
L ign
You can also display the [Select Images] window from the edit o .
window and edit image window. - S — s |mag‘5‘;ﬁing
and Pfinting

@ To change the selected image, or add another image, click the

[Browse] button and in the [Open] dialog box that appears, select Processing
the image file and click the [Open] button. Large Numbers

® If you select two images of the same size, you can checkmark of Images
the [Auto Align] checkbox for auto image alignment. However, —
auto image alignment may not work properly with repetitive Editing
patterns (lattice, stripes, etc.) or flat, single-tone images. JPEG/TIFF
By clicking the [Start HDR] button, the [Adjust Image] window Images
appears.

® After using auto image alignment, the periphery of the images is RO
partially deleted. —
Index
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Introduction
Make required selections to adjust the image. [Detail Enhancement]
‘ [Strength]: Adjusts the overall contrast and contrast of
details together. Move the slider to the right for a Contents at
stronger effect. a Glance
eranes:(59) [Smoothness]: Adjusts the overall smoothness of the image. —
m”ﬂ Move the slider to the right for a smooth and
— natural impression. OpBearzi?on
0 [Fineness]:  Adjusts the clearness of details. Move the slider
et to the right for a sharper outline.
o Advanced
P [Presets] and finishing effects Operation
il With [Presets], you can select from the five preset finishing
effects below from a pulldown menu ([Natural] is selected by AdvEnced
default), instead of operating the sliders individually. By selecting Imag\ajiting
a finishing effect, each slider moves according to the setting. You and Pfinting
can also operate and adjust the sliders after selecting an effect.
R , [Natural]: In high-contrast scenes, rendering in areas Processing
C o . Large Numbers
Sliders in [Adjust Image] yvhere highlights or s.hado.ws are usually cI!pped of Images
[Tone/Color] is corrected, fqr a.fmlsh with reduced highlight —
[Brightness]: Adjusts the overall brightness of the image. Move ar'md Shad_O\_N C|Ip.plng.. o ) Editing
the slider to the right to brighten the image, and to [Art standard]: lees a_f|n|§h with painting-like tonality for an JTrEET:F
the left to darken the image. o Impressive @gge. _ J
[Saturation]: Adjusts the overall color saturation of the image. [Art vivid] For a more V!V!d look than W!th [Art standard].
Move the slider to the right to make the color [Art bold]: For a more vivid Iogk than with [Art standard], Reference
deeper, and to the left to make the color weaker. that makes the subject pop out.
[Contrast]:  Adjusts the overall contrast of the image. Move [Art embossed]: Tones down sharpness more than [Art standard],
the slider to the right to make contrast stronger for an old-fashioned feel.
and to the left to make contrast weaker. Ldex




Starting Up Map Utility o
Click the [Save As] button. Map Utility is a software that allows you to view images shot on a GPS
function-compatible Canon camera, including the shooting location and
Fineness:(0) route travelled. After installing Map Utility to your computer, you can
0 start it up from DPP. cg’(‘;tfa"r:zeat
Select the [Tools] menu P [Start Map Utility].
Map Utility starts up. Basic
For information about Map Utility, refer to the Map Utility Operation
instructions, or to the Help for Map Utility.
Advanced
Operation
® Do not edit images with DPP and use Map Utility at the same time.
Editing results may not be saved properly.
Advapced
Imag iting
and Pfinting

— Version 1.1.0 or later versions of Map Ultility are compatible.
By clicking the [Save As] button, the [Convert and save] (p.42) Map Utility is not included on the EOS DIGITAL Solution Disk.

window appears. Specify the required settings and click the [Start Map Utility] will not appear in the [Tools] menu if Map Utility ._;;?ﬁﬁﬁ,'ﬂg,s

[Save] button. is not installed to your computer. of Images

Editing
JPEGI/TIFF
Images
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Printing with Shooting Information

You can freely layout one image on one sheet of paper and print N
together with titles and shooting information, etc. @ To maintain'the settings

Introduction

—_—

Select one image to be printed.

. : . L a Glance
settings can be applied to another image when printing.
Select the [File] menu » [Print with detailed setting]. P
|§| You can set printer profiles (p.94). Ope?;?on
click the [Print] button. colors (p.94). Y
Switches the settings tab sheet op‘;?;‘t?ﬁn

@ £\Users\CANONPictures\Photaiooo:
| i image [ .| eimas

Printer:
[Oanun PLALS xxxx v]

Media: 297.0mm x 210.0mm
A4 v]

Media orientation:

() Portrait @ Landscape

Media type:

Plain Paper

Print Quality:
Standard

Borderless:
off

Print profile:

CMYK profile:

CMS settings...

! Print . Cancel Apply
-———p—,N,N,N—NN———NYSN— e e

Print preview

The image can be moved by dragging.

Drag the four corners of the image to change the size.

For the shooting information, click [[I]] on the [Text] tab sheet
and select the necessary items in the window that is displayed.

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.

Select images to be printed in a thumbnail list.
Select the [File] menu » [Contact Sheet Prints].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

P””‘P" Image | Text | Settings

Printer:
[ Ganon PRAUS oo -

Media: 210.0mm x 297.0mm
Ad 'l

Media orientation:

(@ Portrait () Landscape

Media type:
Plain Paper

Print Quality:
Standard

Borderless:
off

Print profile:

CMYK profile:

CMS settings...

N
Print J

[

Cancel ][ Apply ]

Print preview

A/

ZQ= To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

@ You can set printer profiles (p.94).

If CMYK simulation has been set, the image is printed in the set
colors (p.94).
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Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro and Print Studio Pro, you can print with
DPP by a simple operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and

the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP and Easy-PhotoPrint Pro, first install Easy-PhotoPrint
Pro version 1.3 or later on your computer.

Printing with DPP and Easy-PhotoPrint Pro
Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].

Easy-PhotoPrint Pro starts up.

Match on-screen image colors and printing result

colors.
Select [Custom] in [Print Quality], click the [Set] button, and in the
window that appears, drag the slider to [1] at the right end, and
then click the [OK] button to close the window.
Next, click the [Color Adjustment] button to display the [Color
Adjustment] window and display the [Color Management] tab
sheet. Set [Color Mode] to [Enable ICC Profile] and [Printer
Profile] to [Auto], and then click the [OK] button to close the
[Color Adjustment] window.

Specify any other required settings for printing, and

then print.

AN/

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.94) is not applied.

The printed image’s color is not what you expected

In the Easy-PhotoPrint Pro window, click the [Color Adjustment]
button to display the [Color Management] tab sheet, set [Rendering
Intent] to [Perceptual] (p.146), and try printing.

/

> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When a color space is set (p.78, p.94), it is automatically transmitted
from DPP to Easy-PhotoPrint Pro, allowing you to print with faithful
colors.

Printing with a wide color reproduction

When the color space setting (p.78, p.94) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider
color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Printing with DPP and Print Studio Pro
Select the [File] menu » [Plug-in printing] » [Print
with Print Studio Pro].

Print Studio Pro starts up.

Specify required settings for printing photographs,
and then print.

Refer to Print Studio Pro's Instruction Manual for details on
settings.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.96) is not applied.

Y

~@< Advantages of printing with Print Studio Pro

Printing with faithful colors

When a color space is set (p.78, p.94), it is automatically transmitted
from DPP to Print Studio Pro, allowing you to print with faithful colors.
Printing with a wide color reproduction

When the color space setting (p.78, p.94) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider
color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Specifying Preferences

You can change the various functions of DPP in the [Preferences]
window. Check the contents of each window and set.

Also, depending on the item, a detailed explanation may be available,
so refer to each window.

Introduction

Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format

Contents at

imagePROGRAF printer. To print with DPP, first install imagePROGRAF a Glance
Print Plug-In for Digital Photo Professional on your computer.
Select the [Tools] menu P [Preferences].
Select the [File] menu » [Plug-in printing] » Plug-In The [Preferences] window appears. oiarzi?on
for the printer you use. Select the tab sheet, specify the settings, and then
The Plug-In starts up. click the [OK] button.
Specify the required printing photographs and then o ég‘;?;‘t‘;gg

print.

? Additional information

A single image can be printed at a time

General settings | View settings I Tool palette I Color management |

Startup folder
@ Last displayed folder
Specified folder

Browse...

Save redpe

Advapced
Imag iting
and Pfinting

You can print a single image selected in DPP at a time. When printing @ Dispay message when adding fle Processing
multiple images, perform printing for each image individually. € add to e automatically Largﬁ Numbers
Functions set in DPP that are not applied to printing . A of images
Specified output resolution (p.91) and CMYK simulation (p.94) are not @ Hgh qualty (rszommended) e e ”
I' d View images at high speed (moire reduction Edltlng
applied. ! of JPEG/TIFF
High speed |mageS
203 Advantages of printing with imagePROGRAF Print Plug-In PEG mage quaky
Remove blodk noise and mosquito noise
Printing with faithful colors Reference
When a color space is set (p.78, p.94), it is automatically transmitted Default valve of autputresolation
from DPP to the Plug-In, allowing you to print with faithful colors. 35 dpi(1-50000)
Printing with a wide color reproduction R Index
When the color space setting (p.78, p.94) is set to a color space wider T
than sRGB (such as Adobe RGB), the color reproduction range of the A —
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly. (o« ) com |
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General Settings

You can specify the folder that opens when DPP is started up, image
quality of displayed and saved RAW images, etc.

Preferences

General settings | View settings I Tool palette I Color management |

Startup folder
@ Last displayed folder
Specdified folder

Save recpe
@) Display message when adding fille

Add to file automatically

Viewing and saving RAW images

View/save RAW images at high quality

@ High quality {recommended)
Moire is reduced and the NR tool palette can be used

View images at high speed {maire reduction
o

High speed

JPEG image quality

Remove block noize and mosquito noise

Default value of output resolution

350 dpi(1-60000)

At EOS Utility startup

Edit image window enabled at EOS Utility startup

Ok ] | Cancel

Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.62) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.62)
to reduce the luminance noise and chrominance noise.
Because the effects of the false color reduction processing and noise
reduction function are difficult to see in the [50% view] or [Fit to
window] display of the edit window and edit image window, use
[100% view] or [200% view] to check.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]
If you checkmark [View images at high speed (moiré reduction off)],
when the image is displayed in the edit window or the edit image
window, false color reduction processing is not applied. However, you
can use the noise reduction function.

As the setting is the same as [High quality] other than for image
display, the image undergoes false color reduction processing when it
is saved.

[High speed]
Since false color reduction processing is not applied, the display speed
of a RAW image in the edit window or the edit image window, and the
time it takes to save a RAW image is shorter than with [High quality].
You cannot use the noise reduction function (p.62).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

® For images shot with ISO speed range expansion set, the difference
in image quality between [High quality] and [High speed] becomes
remarkable. To check the image quality of images shot with ISO
speed range expansion, make sure to set [High quality] and check
the images in the edit window or edit image window.
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. . Introduction
JPEG image quality View Settings
[Remove block noise and mosquito noise] . . . .
Y, . h litv of a JPEG i by reducing th . You can specify settings relating to the display.
ou can improve t e qua ity of a image by reducing the noise Contents at
particular to JPEG images. a Glance
This setting is also effective when RAW images are converted to —
JPEG images and saved (p.42, p.101) and for JPEG images that General settngs View settngs Tool palette [ coor management
have been saved with a different name. il Basic
64 Pixels(3-256) Operation
? The extent of the improvement in noise reduction Image selection status
[¥]1mages opened in Edit window remain selected in main window
The higher the JPEG image’s compression rate, the more noise is Sd‘é?:t‘i’gg
reduced. When the compression rate is low, the effect of noise reduction Magnification in Edit window P
iS negllglble @) Fit to window (1 50% ) 100% () 200%
Magnification when the Edit/Edit image window is double-dlicked I Ad c'et'd
. _ _ i ma Itin
Default value of output resolution S an(? ntingg
You can set the resolution for RAW images converted and saved as | RAW ard PPEG
JPEG or TIFF |mages (p42, p1 01 ) ["|Displzy enly CR2 images for CR2 and JPEG files of the same name: Processing
‘ Large Numbers
Sort order in main window of lmages
| [ Retain sort order —
Highlight/shadow Alert J PEEdgli!FIgF F
Highlight 255 {192-255) . Images
Shadow 0 (0-64) .
Quick check tool display
@ 50% () 100% (moiré reduction off) Reference
—
[ QK ] [ Cancel
Index




Sort order in main window

You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.21).

If you checkmark the checkbox, the order of the rearranged images is
maintained even if you exit DPP or select another folder in the folder
area.

If you remove the check mark, the order of the rearranged images is not
maintained and reverts to the previous order when you exit DPP or
select another folder in the folder area.

Highlight/shadow warning

Highlighted/shaded areas that exceed the set range can be displayed
on the image as warning indicators (p.55).

Tool Palette

You can specify settings for the tool palette.

Preferences

General settings I View settings

Default settings of RGE tool palette
Tone curve mode
@ RGERGB
() Luminance R G B
Histogram display
() Before adjustment
(@) After adjustment

Tool palette display in Edit Image Window
(@ Docking display

() Floating display

Modified Picture Style settings
Retain settings of each Picture Style

Tool palette display mode
[ 5ame for Main window and Edit window

Default noise reduction settings
@ Apply camera settings
() Set as defaults

R Jurira

TIFF/IPEG luminance noise reduction:(0)

TIFF/IPEG chrominance noise reduction:(0)

Tool palette

Tone curve interpolation method

@ Curve

(©) straight

Color management

1 __Cance\

Default settings of RGB tool palette

You cannot apply changes to the settings until you re-open the folder.

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.
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Modified Picture Style settings

You can select whether the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings will be changed accordingly or
retained, when you change the Picture Style.
If you checkmark the checkbox, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be changed to match the
camera’s preset settings, when you change the Picture Style.
If you remove the check mark, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style.

Default noise reduction settings

You can set a default beforehand for the noise reduction level.
RAW Images
» When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.
JPEG/TIFF Images
* You can set a desired default noise reduction level beforehand.
For images not having a recipe attached, the default set here for noise
reduction level is applied. However, if you want to apply settings to
images in the opened folder, you need to re-open the folder after making
settings here. For images with a recipe attached, the noise level
recorded in the recipe remains as it is and the default for noise reduction
level set here is not applied.

-:\@/3 Advantages of setting a noise reduction default

In instances where the same level of noise occurs in several images,
such as images shot with high ISO speed, setting an appropriate default
noise reduction setting enables you to apply a batch noise reduction
default to all the images displayed in DPP (excluding images with a
recipe attached). This eliminates the need to apply noise reduction to
each individual image. And, since you always shoot with the same
conditions, it is also useful when you want to set the same noise
reduction level for all shot images.

Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

General settings | View settings

| Tool palette ‘

Default settings of Wark color space
9 sREE
Adobe RGB

Wide Gamut RGB

Color matching settings
For display

) sRGE
Use the OS settings
Monitor profile

Browse...

Printing profile

() Apple RGB

ColorMatch RGB

= None —

Perceptusl

CMYK simulation profile

Relative Colorimetric

—— None —

perceptual

Rendering intents when using Easy-PhotoPrint
Perceptual

@) Relative Colorimetric

Relative Colorimetric

Preferences
" mar el

L
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Default settings of Work color space

You can select from five types of color space (p.146) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.42,
p.101) or printed (p.43, p.46, p.49, p.86 to p.90).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the main
window (p.126, p.127), the edit window (p.129), and the edit image
window (p.135).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

|§| You can set a color space that is different from the default settings
for each image (p.78).

Display setting (color setting of the monitor)

Where a profile (p.145) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.
If you select [Use the OS settings], the color profile set in Windows
will also be applied in DPP.
If you are using multiple monitors, only the profile of the primary
monitor is applied to DPP.
Select the [Monitor profile], click the [Browse] button and in the dialog
box that appears, select a profile for your monitor.

-:\@/3 Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.

Setting of printing profile (color setting of the printer)

Where a profile (p.145) is attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile. The profile that has been set is applied to
all printing (p.49, p.86, p.87) except for printing using a Canon inkjet
printer (p.43, p.46) or linked printing (p.88, p.90).

? The adjustment function of the printer driver should not be
used

Even if you set a printer profile, if you use the color adjustment function
of the printer driver, the image may print in colors different from those
displayed on screen.

== Automatic settings for printing using EPP EX, EPP, and
linked printing

If you are printing using a Canon inkjet printer (p.43, p.46) or using
linked printing (p.88, p.90), a profile is set automatically even when the
[Printing profile] setting is not performed. This allows you to print faithful
colors easily.

Introduction

Contents at
a Glance

Basic
Operation

Advanced

Operation

Advapced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00

95



Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.146) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.126, p.127,
p.129, p.135) at the bottom of the main window, edit window and edit
image window, and colors can be checked.

To temporarily cancel CMYK simulation, press the <Ctrl> + <Y> keys.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.146) for printing
using Easy-PhotoPrint (p.46).

The rendering intent is ordinarily set to [Relative Colorimetric].

When colors with [Relative Colorimetric] are not satisfactory, set to
[Perceptual].
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4 Useful Functions for Processing Large Numbers of RAW Images

For users shooting a large amount of RAW images, the convenient
function of batch processing large amounts of RAW images is explained
here.
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Utilizing Adjustment Contents (Recipe)

Introduction

All the adjust.me.n’F contentg (re.C|pe) madg using t”he tool palette can be 2 Additional information
saved as an individual recipe file (extension “.vrd”) and loaded and =
applied to another image. Recipe data includes tool palette contents
o - . — . . . . . Contents at
You can edit images efficiently by selecting and adjusting one image Recipe data includes adjustments made with the tool palette ([RAW], a Glance
from images shot with the same shooting environment and batch [RGB], [NR/ALO] and [LENS]). For this reason, other editing content )
applying the adjustment results to a large number of images. such as trimming or dust-erasure (copy stamp) is not included in the
weoorcrz = recipe data. Basic
[ raw [rea [nejao [ | ' Recipes adjusted with the [RAW] tool palette can only be applied Operation
|Brighmess adjustment to RAW images
! e Adjustments in the [RAW] tool palette, which can only be made for
I\balance R — .@ 3 A RAW images, are not applied to a JPEG or TIFF image even if they ég‘é?:ggg
(@ o) = e—— Ty are pasted.
||IPict|.|re Style | T m Advanced
@ (standard) ~ | rowse... ! - ' : Image Editing
e e e mage data and Printing
i Processing
* | e T Larg bers
T e ecpal ) of Iméges
-10.0 8.0 £.0 -40 -20
Contrast: {0) {1 —
Highlight: (0 I iti
shah;o:;(fn) 0 Contents adjusted using the tool Jfgg}?ﬁ:,:
et ; palette can be handled Images
Color saturation:(3) 0 individually as a recipe file
|unsharp mask ™ (extension “.vrd").
Strength: (D) [}
Fineness: (1) [ Reference
Threshold: (0) 0 — —
Index
|§| The adjustment contents of JPEG or TIFF images (p.105) can be @

saved as a recipe file (extension “.vrd”) and loaded and applied to

another image in the same way as with RAW images. 98
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Saving Recipes as a File

Select an edited image, and then select the [Edit]

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image. Contents at

menu » [Save recipe in file].
The [Save recipe in file] dialog box appears.

Select the destination folder, enter a file name, and

and then select the [Edit] menu » [Copy recipe to Basic
then click the [Save] button. clipboard]. Oparation
The recipe is copied.
? Check the contents of a recipe file by pasting to an image Select the image to Whi_Ch the recipe is to be' applied Sg‘;?;‘ﬁﬁﬂ
o . _ and then select the [Edit] menu P [Paste recipe to
When you do not know the contents of a recipe file, paste it to an image g
T : selected image].

and check the settings in the tool palette. When only a few settings are W , , Advanced
adjusted, we recommend you use a file name that describes the The recipe is applied to the image. Image Editing
contents or that you separately record the adjustments as text and Printing

information.

Select the image from which a recipe is to be copied

a Glance

ProcegS§sing
Larg bers
of mes
Loading and Pasting Recipes -~
iting
Select the image to which a recipe is to be applied, J'T'E‘:"';':F
and then select the [Edit] menu » [Read and paste J
recipe from file].
The [Open] dialog box appears. Reference
Select a recipe and click the [Open] button.
The recipe is applied to the image.
Index
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.

Registering Personal White Balance

Adjust the white balance (p.28, p.56).
To adjust white balance, select a setting other than [ & ( )] from
the [White balance adjustment] list box (p.28). You will be unable
to register the adjustments if you select [ @& ( )].

In the [RAW] tool palette, click the [Register] button.
The [Register personal white balance] dialog box appears.

Select the button number to be registered from the
list and click the [OK] button.

Register personal white balance

Register current setting in personal white balance

Current setting: Click white balance

? To use the registered personal white balance on another
computer

In step 3, click the [Export] button to write as a file.

Copy the file to another computer.

In DPP on the other computer, display the window of step 3.

Click the [Import] button and in the window that appears, select the
copied file.

© You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.

Applying Personal White Balance

In the main window, select the image to which white
balance is to be applied.

Click the [Tool Palette] button on the toolbar.
The tool palette appears.

Click the personal white balance number button that
is to be applied.

RAW |RGB |MR/ALO | LENS |
| Brightness adjustment Eﬂ
[ 0.00
| White balance adjustment (=]
2 ([@EGE) e
| Daviight [ Ture...
| Picture Style =]

@ (Standard)

v‘ Browse...

-10.0 8.0 60 40 -20 0.0 20 4
Contrast: () {1
Highlight:{0) 1
Shadow:(0) {

|:|Linear
]
I

Caolor tone: (0}

Color saturation: (0)

IUnsharp mask v‘
Strength: () [
Fineness: (0) [
Threshold: (0) I

Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain
unaffected.

In the main window, select multiple images to be
converted.

Click the [Batch process] button on the toolbar (p.126).

The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

IMG_0001.CR2 Save folder
MG_0002.CR2
MG_0003.CR2 E:\Users\CANON Pictures
MG_0004.CR2
IMG_0005.CR2 File format
MG_0006.CR2
IMG_0007.CR2 find of file
MG_0008.CR2
IMG_0008.CR2
MG_0D10.CR2
IMG_0011.CR2
MG_0D12.CR2 Output setting
IMG_0013.CR2
MG_0D14.CR2 Output resolution 350 dpi  [¥]Embed ICC profie
MG_0015.CR2

Browse...

Exif-JPEG M

Image quality 1 10

Resize setting
Resize

Lock aspect ratio

File name
Current file name

@) New file name
String Sequence number
DPP_ 0001
Save sequence number

Ex.: DPP_0001.JPG, DPP_0002.JPG...

Image transfer settings

Open image using software

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Exit] button appears in the
batch processing dialog box.

In the processing dialog box, click the [Exit] button.

? Saving images with recipe is not possible

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p-41, p.121) to edited RAW images.

E\@/:— To save the developing/editing results for the version you are currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two differing versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

@)% Skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the edit window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.

® If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected images.

|§| If you have selected [New file name] in [File name], [Sequence
number] has to be set.
By saving as explained on this page, a trimmed image (p.38,
p.113) or dust-erased image (p.73 to p.77, p.116 to p.120)
actually becomes a trimmed image or dust-erased image.
For a list of [Batch settings] window functions, see p.143.
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Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike
[Transferring a RAW Image to Photoshop] (p.78), you transfer images
that have first been converted and saved as a seperate image, so the
transferred image will not disappear after exiting the destination
software. The software used here as an example is Adobe Photoshop
CS.

In the main window, select multiple images to be
transferred.

Click the [Batch process] button on the toolbar (p.126).

The [Batch settings] window appears.

Perform settings required for transferring (e.g. file
format).

Click the [Browse] button.

Batch settings
MG_0001.CR2 Save folder
IMG_0002.CR2
IMG_0003.CR2 E:\Users\CANON Pictures \&I
MG_0004.CR2
IMG_0005.CR2 File format
IMG_0008.CR2
IMG_00D7.CR2 Kind of file Exif-IPEG -
MG_0008.CR2
IMG_0002.CR2 ]

X 10
IMG_0010.CR2 Tar=am s 0
MG_0011.CR2
IMG_0012.CR2 Output setting
IMG_0013.CR2
MG_0014.CR2 Output resolution 350  dpi  []Embed ICC profie
IMG_0015.CR2

Resize setting
Resize
pivel
Lock aspect rat
File nam¢
Curren it file name
@) New file name
String Sequence number
DPP_ 0001
Save sequence number
Ex.: DFP_0001.JPG, DPP_000Z.JFG...
Image transfer settings
Open image using software
Browse...
Execute Cancel

The [Open] dialog box appears.

Select Photoshop CS.
In the [Open] dialog box, select a Photoshop CS file or a shortcut
and click the [Open] button.
The [Open] dialog box closes and [Image transfer settings] in the
[Batch settings] window is set to Photoshop CS.

Checkmark [Open image using software].

Image transfer settings

Dpen image using software

E:Program Files\Adobe\Adobe Photoshop CS\Photoshop Browse. ..

[ Execute ] | Cancel |

Click the [Execute] button.
The processing dialog box appears and batch transfer begins.
When the first image has been transferred, Photoshop CS starts
up and transferred images are displayed in transferred order.

® If the message [Insufficient memory.] appears, too many images are

selected at the same time. Decrease the number of selected
images.
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].
The rename window appears.

Specify the required settings (p.144) and click the
[Execute] button.

-
e, =)
File name Extension
DPP w Shooting Date/Time « Sequence number ~  |Do not change -
Basic Settings Format settings
Sort Sequence number
@) Fit to main window 0001 Save sequence number
File name
Shooting Date/Time
Shooting Date,Time ‘Year Month Day - ‘
Same file name for RAW+IPEG images ‘W-MM-DD ‘
Copy and Rename
| Insert underbar
E:\Users\CANONPictures
Criginal File Name Modified File Name
IMG_0001.CR2 DPP_05-09-13_0001.CR2
IMG_0001.JPG DPP_06-09-13_0001.JPG
MG_0002.CR2 DPP_06-09-13_0002.CR2
IMG_0002.JPG DPP_06-09-13_0002.JPG
IMG_0003.CR2 DPP_06-09-13_0003.CR2
MG_0003. PG * DPP_06-09-13_0003.IPG
IMG_0004.CR2 DPP_05-09-12_0004.CR2
IMG_0004.JPG DPP_06-09-12_0004.JPG
[ [ Execute ] Cancel

Processing begins and the file names are changed.

? Changes cannot be made when the file name is duplicated

If a file name in red text has appeared in [Modified File Name], the file name
has been duplicated. Changes cannot be made if even one file name has
been duplicated. Change the settings so that duplication does not occur.

® The name of the movie files cannot be changed in DPP.

|§| You cannot start up the rename tool from the [Collection] window
(p.36, p.127).
For a list of the rename window functions, see p.144.

Changing the File Name of Images in the Order in the Main Window

When you change the order of the images in the main window, you can
change in one operation the names of the files for the images, in the
order they were rearranged.

Change the order of the images in the main window
(p.21).

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu P [Start Rename tool].

Select [Fit to main window].

EM\Users\CAMON\Pictures\Photo’\xoco_xx

File name
DFP » Shooting Date,Time
Basic Settings
Sort
( @) Fit to main window J

File name
Shooting Date,Time

Specify the required settings (p.144).
To copy an image, checkmark [Copy Rename].

Click the [Execute] button.
The file names are changed and the order in the main window is
maintained.

© If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected
images.
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5 Editing JPEG and TIFF Images

DPP is software mainly aimed for advanced RAW image editing, but it

also has JPEG and TIFF image editing functions. Here, the editing and
saving of JPEG and TIFF images are explained.
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/ALQO] tool palettes.

Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any number of
times.

e |

RAW | RGB  [NR/ALO | LENS |

Tone curve assist @
Tone curve adjustment

fre. J[r][e][8]

255

!I I I I ')
/| ¥ L m
..\.. . 1 ’. T g Ty
: e Tson AT N
= i
Lurd
Brightness: i 1] ——

Contents adjusted using the tool
palette can be handled

o individually as a recipe file
(extension “.vrd”) (p.98, p.121).

Contrast: i} 0 I

Hue: { @ o

e

Saturation:

Sharpness: [ 1]

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.121), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.98, p.121).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore, take care not to adjust your images to an
excessive degree.

You can adjust RAW images with the functions in the [RGB] tool palette.

However, for functions other than tone curve adjustment (p.110) and
automatic adjustment (p.106), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.145). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

RAW | RGB  |NR/ALO | LENS |

‘Tone curve assist il 3 ==Y Reverts the tone curve
[Tane curve adjustment to the original settings
[R)[s]
295 High
Standard

u}

Brightness: [} 0
Contrast: D a
Hue: D a
Saturation: D 100
Sharpness: [ i

The tone curve changes as adjusted.

|
\\/

== Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

* Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

» Images which have extreme backlighting

@ If you click the [[[Z%]] button, the tone curve as well as the [Hue]
and [Saturation] revert to the default settings. Take care when
adjusting the [Hue] and [Saturation] individually (p.109).
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Adjusting Brightness and Contrast

Brightness: Move the slider to the right to make an image
brighter and to the left to make an image darker.

The brightness and contrast of an image can be adjusted. Contrast: Used to adjust modulation and degree of contrast

RAW | RGB  |NR/ALO | LENS |

| Tone curve assist |

‘Tone curve adjustment |

Lokee.  J[r][c][e]

Brightness: ; ' Di A

Contrast: ; ‘ : ' a

Hue: ; D @ a
Saturation: : D 100
Sharpness: [} @ i

of color. Move the slider to the right to make
contrast of an image stronger and to the left to
make contrast weaker.

Drag the sliders left or
right
Enter numerical values

@ The adjustment range is =100 to +100 (in 1-stop increments when
entering a value).
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J

Introduction
Adjusting Color Tone Using Click White Balance N
You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white Contents at
. . S . . a Glance
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.
. Basic
Click the [[#]] button. Operation
N —
RAW | RGB  |NR/ALO | LENS |
|Tone curve assist | Advanced
‘Tone curve adjustment =3 Operation
EL‘ E] S —
s ' Advanced
Image Editing
and Printing
S ——
; o Processing
The coordinates of the cursor posmon and Large Numbers
the RGB values (8-bit conversion) of Images
e e

=» The color of the image is adjusted with the point you selected as
the standard for white EEEQ
' JPEGIIFF
|

If you click on another point in the image, the white balance is es
adjusted again.
0 To finish click white balance, right-click with the mouse or click
the [[#]] button again. Reference
Brightness: E I 0 )
Contrast: ; D a
'? When there are no white areas in your image Ind
e —1 B | - . | e
When there are no white areas in your image, you can adjust the white - )
saturation: ' L 100 balance by clicking on a grey point of the image in step 2. This has the
Sharpness: I} B8]0 same adjustment result as selecting a white point. @ @
ﬁl The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point. @
The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any

adjustments (p.93). 108



Introduction

Adjusting Hue, Saturation and Sharpness Hue: Move the slider to the right to make color tones
more yellow, and to the left to make color tones

You can adjust hue (tone) and saturation and make the overall redder.

atmosphere of an image sharper or softer. Saturation: Move the slider to the right to make the color C:rgfanrfzeat
deeper, and to the left to make the color weaker. -
RAW | RGB  |NR/ALO | LENS | Sharpness: Move the slider to the right to make an image ]
[Tane curve assist M) sharper, and to the left to make an image softer. OpBear;?on
‘Tone curve adjustment |

Lokee.  J[r][c][e]
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Brightness:

Contrast:
Reference

Saturation:

{l
il
Hue: m @ o
O

100 Enter numerical values

Sharpness: m @D T Index
| '? Sharpness is unnatural S

Drag the sliders left or right

Adjust sharpness with the window view set to [100% view], [50% view]
or [200% view]. If the view is set to [Fit to window] (full view), the @

sharpness will seem unnatural. @
O
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|§| The adjustment range is —30 to 30 for hue, 0 to 200 for saturation,
and 0 to 500 for sharpness (in 1-stop increments when entering a
value).



Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.145).

Make adjustments.

Select the tone curve mode and interpolation

method.
RAW | RGB  |NR/ALO | LENS |
‘ Tane curve assist |
|Tone curve adjustment |

s JRI[s][E]

255

Curve

Right-click with the
mouse inside the graph

Straight

RGBRGB to display the menu
Lurminance R G B
T
al : i .{1 k
o Ry,
. s,

0 255
Brightness: I 0
Contrast: D 0
Hue: D 0
Saturation: D 100
Sharpness: [ 0

RAW | RGB  |NR/ALO | LENS |

| Tone curve assist |
‘Tone curve adjustment E”
RGE (R

255

Brightness:

Contrast:

Hue:
Saturation:

Sharpness: [}

(B] o
[B] 100
(B] o

Adjusts each channel
Batch adjusts RGB

Click to add a [[] (point)
Adjust by dragging [[]

The horizontal axis shows the input level and the vertical axis

shows the output level.

The maximum number of [[]] is 8.

To delete a [[1], either press the <Del> key or double-click on the [[]].

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any

adjustments (p.93).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.93).
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Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Move downwards
Output highlight points

RAW | RGB  |NR/ALO | LENS |

|Tone curve assist |

‘Tone curve adjustment ‘— Reverts the

—r e llclla] # 1]l image to the

Output 253 original
highlight point settings
numerical
value
Move to the Move to the
right left
Input shadow Input highlight
points points

Output shadow
pointnumerical 2551 Input highlight
value Brighfness: 1 0 pointnumerical
value

Input shadow

point numerical ®o
value
Saturation: [ 100
Sharpness: [} @ i

Move upwards
Output shadow points

The horizontal axis shows the input level and the vertical axis shows
the output level.

The setting range of shadow points is 0 to 247 (in 1-stop
increments when entering a value).

The setting range of highlight points is 8 to 255 (in 1-stop
increments when entering a value).

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.93).
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Reducing Noise

You can reduce noise that arises in JPEG and TIFF images that have

been

shot at night or with a high ISO speed.

Select the [NR/ALO] tab sheet from the tool palette in
the edit window or edit image window.

Click the [NR Preview] button.

| Moise reduction Apply |

[ [ MR. Preview... I

RAWY

The [NR Preview] window appears.

Adjust an image.

i

NR Preview

Navigator
window

— Enlargement

display
TIFF/IPEG position
Luminance noise on:(7)
° i i Drag the
Chreminance noise iction: (8) .
0 ( u) 1 2 sliders

NR check window

You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.

The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.

You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Y
N

-
- ~

Click the [Apply] button.

Noise reduction is applied to the image and the image is
redisplayed.

To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/ALO]
tool palette (p.131) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

5

If [Luminance noise reduction] has been set, resolution may be
reduced along with reduction of noise.

If [Chrominance noise reduction] has been set, color bleeding
may occur along with reduction of noise.

You can set the batch processing settings for noise reduction
beforehand, using [Default noise reduction settings] in the [Tool
palette] tab sheet in the [Preferences] (p.93). This is particularly
useful for applying noise reduction to all the images in a folder at
once, such as batch noise reduction for images with high ISO
speeds. However, where images have a recipe attached, the
noise level recorded in the recipe is applied.

For a list of [NR Preview] window functions, see p.133.
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Trimming and Adjusting the Angle of an Image

You can trim only the part of an image you need, or change the Adjust the angle of the image as needed.
composition of an image where an image shot horizontally becomes Trimming/angle adjustment window
vertical. You can also adjust the angle of an image before trimming. If ST T

you select [Circle] for [Aspect ratio], the area outside the specified range r

will only be masked in black and the image will not be trimmed. —=——=——Largest
possible
Select the image to be trimmed. f .;w- :gr:grzlng

Open the trimming/angle adjustment window. == ==} Click(rotate

Click the [Trimming Angle] button. = image left
or right in
- 90-degree
] = increments)
y @

S & @

Rotate right Quick Stamp Trimming Batch
check Angle process

Rating & & » & &

The trimming/angle adjustment window appears.
Editing can be done once the image is displayed clearly in the
trimming/angle adjustment window.

|
Drag* (0.01-degree increments;
adjustment range: -45 to +45 degrees)

Use the mouse (click A/V) to adjust the angle or

directly enter the adjustment angle* (0.01-degree
increments; adjustable range: -45 to +45 degrees)

* You cannot adjust the angle of images that exceed 9999 x 6666
pixels in size.
If you click [Center on Screen], you can display the trimming
range in the center of the window.
If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming
range.

@ When aspect ratio information is attached to an image shot with the
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-
1D Mark Ill, EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 60D, EOS
REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/650D,
EOS REBEL T3i/600D or EOS M, the trimming range based on the
aspect ratio information is displayed.
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Select a ratio and drag the trimming range.

-~ }— Cancel
y— Select a
trimming
o ratio

—— Drag the
trimming
range

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range. (Not available
when [Circle] is selected.)

List of aspect ratios (width : height)

1:1

32
213
43
34

54

4.5

A Size Landscape
A Size Porfrait
Letter Landscape
Letter Portrait
Custom

Circle

[Free]: You can trim an image to any size, regardless of the
selectable ratio.

[Custom]: You can trim an image at the specified ratio.

[Circle]: The area outside the specified range is masked in
black. The image is not trimmed.

Click the [OK] button to return to the main window.

The trimming range frame is displayed in the trimmed image
(p.128).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.122).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.128).

+ Edit window:

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when saved as a separate image

The trimmed JPEG or TIFF image actually becomes a trimmed image
when saved as a separate image (p.121).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark 1ll, EOS-1D
Mark Ill, EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 60D, EOS REBEL
TS5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/650D, EOS
REBEL T3i/600D or EOS M, the set trimming range based on the
aspect ratio information is displayed. Since the image is not actually
trimmed, you can change the trimming range or revert to the condition
before trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 5D Mark Ill, EOS 6D, EOS 60D, EOS REBEL
T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/650D, EOS
REBEL T3i/600D or EOS M, its trimming range cannot be changed
nor reverted to the condition before trimming, since the image is
actually trimmed and saved in the set trimming ratio.”

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.137).

Ay

The image is displayed in its trimmed condition.

* For JPEG images shot with EOS 5D Mark Il and [Add cropping
information] set in Custom Functions, aspect ratio information is
only set and the image is not actually trimmed.

ALy

> Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard
You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys or the <F11> key.

Operate using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

® For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

@ For a list of the trimming/angle adjustment window functions, see

p.137.
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The copy stamp window appears.

® Dust Delete Data is not attached to images having settings specified

during RAW processing on the camera for distortion correction,
chromatic aberration correction, etc. As a result, you cannot perform
automatic dust erasure processing on such images.

Performing Automatic Dust Erasure Processing e
The Dust Delete Data that is appended to images shot with the camera When the image has redrawn itself, click the [Apply
that can attach this data, can be used to automatically erase dust spots. Dust Delete Data] button.
s = Corcl;tfnts at
- a ance
Compatible Cameras T
Basic
EOS-1D X EOCS-1DC EOS-1D Mark IV Operation
EOS-1Ds Mark 1l EOS-1D Mark llI EOS 5D Mark I m
EOS 5D Mark I EOS 6D EOS 7D iy ey - Advanced
EOS 60D EOS 50D EOS 40D == R
EOS REBEL EOS REBEL EOS REBEL o [ s
T5i/700D SL1/100D T4i/650D Advanced
Image Editing
EOS REBEL EOS REBEL EOS REBEL and Printing
T3i/600D T2i/550D T1i/500D S5 4 St gy
EOS DIGITAL REBEL EOS DIGITAL REBEL EOS REBEL » Dust spots are erased in a single operation. I_;g;"ﬁjﬁjggrs
XSi/450D XTi/400D DIGITAL T3/1100D . . . of Images
Click the [OK] button to return to the main window.
)E((S)/S1(I):Z)|(();I;TAL REBEL EOS M — S =»The [@,] mark (p.128) is displayed on an image from which dust E
spots have been erased. Jpﬁﬁ:l:
. . . . I
In the main window, select an image appended with ==
Dust Delete Data.
Click the [Stamp] button. Reference
Index
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O
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? Additional Information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.122).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.118) or the copy stamp function (p.120).

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.121).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, see p.142.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one. Click the button that matches the dust spots to be

In the main window, select the image you want to
erase dust spots.

Click the [Stamp] button.

.
y ® & @ 2

Rotate right Quick Stamp Trimming Batch
check Angle process

Ratng & = & & =

The copy stamp window appears.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

) e e

e e Double-
N click

St 1 LO0% view 1 perfioem tarms eperatien

The display changes to 100% view.
The display position can be changed by dragging.

erased.
If the dust spot is dark in color, click the [[@»C |] button, and if the
dust spot is light in color, click the [+ ] button.
When you move the cursor over the image, the dust erasure
range appears as [O].

Place the dust spot to be erased within the [O] and

click.

W1 P

N Pichsed Photal oot oG 005G (3164 458

() —i—on Click

[T ——

The dust spot within the [Q] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, either right-click with
the mouse, or click the button clicked in step 4 again to cancel dust
erasure processing and perform the operation again from step 3.
When the dust spot cannot be erased, [(§)] is displayed.

Click the [OK] button to return to the main window.
The [@,] mark (p.128) is displayed on an image from which dust
spots have been erased.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.120).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.122).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.121).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you
can efficiently erase dust spots by clicking the images while holding
down the <Ctrl> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <Shift> key, and then displaying the copy
stamp window.

® For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

|§| For a list of the copy stamp window functions, see p.142.
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Compositing and High Dynamic Range .
Introduction
: : You can composite images also using JPEG and TIFF images in the
Erasing Unwanted Parts of an Image (Copy Stamp Function) same way as RAW images as described below,
You can correct an image by pasting a section copied from another part Compositing Images (p.78)
of the image to an unwanted part of the image. Creating HDR (High Dynamic Range) Images (p.82) C:rgfanl:(s:eat
Follow steps 1 to 3 in “Manually Erasing Dust (Repair
- ,, | } - u B -
Function)” (p.118). Starting Up Map Utility Operation
Specify the section to be copied. You can start up Map Utility using the procedure below.
Click on the section that is to be the copy source while holding Starting Up Map Utility (p.85)
down the <Alt> key. Advanced
) ] Operation
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy Advanced
Source position]. '?:(?%Eg;f%g
Correct the image.
Click or drag on the section you want to correct on the image. [+] Processing
. . - - Large Numbers
in the window indicates the copy source and [Q] indicates the of Images

copy destination.
The copied image is pasted in the position to which it was

Editihg
dragged. JP'%IFF
For [Pen type], you can select from [Brush] (the pasted image’s Im#Ges
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Reference
Click the [OK] button to return to the main window.
The [@,] mark (p.128) is displayed on a corrected image.
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Saving Editing Results

Saving Editing Content to an Image

All the contents (recipe) adjusted with the tool palette (p.105 to p.112)
as well as the trimmed range (p.113) and dust-erasure (p.116 to p.120)
information can be saved to a JPEG or TIFF image, or to a separate
JPEG or TIFF image.

Select the [File] menu » desired item.

File

Open in Edit window Ctrl+0
Open in Edit window (enlarged)

Save Ctrl+S
Save As... Ctrl+Shift+5
Ctrl+Shift+T

Add thumbnail to image and save
Convert and save.., Ctrl+D

Batch process... Ctrl+B
Create new folder...

Print... Ctrl+P
Ctrl+Alt+P
Ctrl+Shift+P

Print with detailed setting...
Contact Sheet Prints...
Plug-in printing 4

Add to collection Ctrl+G
Remaove from collection Ctrl+5Shift+G

Clear collection

Delete Del
Info Ctrl+I

Exit Alt+F4

Your adjustments are saved to the image.

Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.105 to p.112)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a trimmed image (p.113) or dust-erased image (p.116 to
p.120) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.42)

Batch save as JPEG or TIFF images (batch processing) (p.101)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.41)

Utilizing adjustment contents (recipe) (p.98)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.43)

Printing with shooting information (p.86)

Printing a thumbnail list (contact sheet printing) (p.87)

Printing RAW images on a high-end Canon printer (p.88)
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.105 to p.112), so the “original image data itself”
remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.113) or dust-erased image (p.116 to
p.120) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.121) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Adjustment |
Rotate Left Ctrl+L
Rotate Right Ctrl+R

Apply Dust Delete Data
Work color space 3

Tone Curve Assist - Standard
Tone Curve Assist - High

Revert to last saved settings Ctrl+Alt+Z
Revert to shot settings Ctrl+Shift+Z

The image reverts to the conditions of the selected item.
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Reference

This reference section has been provided to enhance your experience
using DPP.

It contains various troubleshooting solutions, how to delete DPP from
your computer, explanations of the various windows and a glossary.
An Index is provided at the end of the chapter for you to easily find
information you are looking for.
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Troubleshooting

If DPP is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

Select an administrator-level privilege ([Computer administrator],
[Administrator], etc.) as a user setting. You cannot install the software
if a user setting other than an administrator-level privilege is selected.
For detailed information on selecting an administrator-level privilege,
refer to your computer User’s Manual.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements are not met. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Exit
any applications other than DPP.

The card reader does not detect the SD card

Depending on the card reader and computer OS used, SDXC cards
might not be correctly detected. In such a case, connect your camera
and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility (provided software).

Images are not displayed properly

Images that are not supported by DPP are not displayed. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than
Exif compatible images may not display properly (p.3).

When a dust-erased image (p.73 to p.77, p.116 to p.120) is displayed
in a window other than the copy stamp window, it is displayed as it
was before dust erasure was performed. Check dust-erased images
in the copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.130).

PowerShot Pro1 RAW images cannot be adjusted with the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.130).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.10, p.25, p.126, p.134, p.135),
trimming (p.38, p.113), dust erasure (copy stamp) (p.73 to p.77, p.116
to p.120) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.130).

The Auto Lighting Optimizer (p.61) is a function that is only available
for RAW images shot with EOS-1D X, EOS-1D C, EOS-1D Mark 1V,
EOS 5D Mark lll, EOS 5D Mark Il, EOS 6D, EOS 7D, EOS 60D, EOS
50D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL
T4i/650D, EOS REBEL T3i/600D, EOS REBEL T2i/550D, EOS
REBEL T1i/500D, EOS REBEL T3/1100D and EOS M. You cannot
apply the Auto Lighting Optimizer’s adjustment contents to RAW
images shot with other cameras.

Color appears weak in the image when viewed with
other software

A RAW image which has a color space other than sRGB set (p.78,
p.94) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with sSRGB color space. In this case, set the RAW image color space
to sRGB, convert again to a JPEG or TIFF image and save, and then
view this image.
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The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.94) and a profile for a printer is
set up correctly (p.94), the color of a printed photograph and the color
of an image on screen can be more closely matched. Using a Canon
printer (p.43, p.46) or linked printing (p.88, p.90) automatically sets up
printer profiles, so you only need to set the color of the monitor to
bring the colors closer together.

When printing using Easy-PhotoPrint and the Easy-PhotoPrint
automatic compensation function and the various types of image
adjustment functions are operating, colors are not printed correctly.
Cancel all Easy-PhotoPrint image adjustment functions (p.47).

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.49).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with EOS 10D, EOS
DIGITAL REBEL/300D DIGITAL and PowerShot Pro1 may not display
image information (p.10, p.23).

Deleting the Software (Uninstalling)

Exit any applications before uninstalling the software.

Log in under an administrator-level privilege when uninstalling the
software.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.

Windows 7, Windows Vista, Windows XP

Select the [ @ ] button ([Start] button in Windows XP)
» [All Programs] » [Canon Utilities] » [Digital Photo
Professional] » [Digital Photo Professional
Uninstall].

Proceed with the uninstallation as directed by the

on-screen messages.
The software is uninstalled.

Windows 8

Uninstall the software according to the OS software uninstalling
method.
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List of Main Window (Folder Window) Functions .10

Shows/hides the tool palette (p.130) Image information (p.23)

Shows/hides the folder area Selects all images ‘
Switches to the editimage

window (p.135)
bieal Photd p@ - [E\U

Folder path i s
Fi Edit View Bookmjark Labell Adjustmenf
Toolbar*’ "N

[Collection] tab sheet*> ? - -

Cancels selection of all images
Displays the quick check window (p.134)
Displays the copy stamp window (p.142)

Displays the trimming/
angle adjustment window
(p.137)

|

Window Help

Batch conversion/
saving

Info Select all Clear all Rotate left Rotste right

win : ::r Palette
[Folder] tab sheet*> [ e | ckino | (p.101, p.102, p.143)
Bl Desktop 3 3 i
=3 jD ) Image rotation
- ) Musi (90 degree
E!H Pictures H
Check mark (p.19) R T increments)
Sample_Pic_tures
@E Videos
- Homegrou .
- —— g hhx — S S Rating (p.19)
2 {8 Computer IMG_DD0L.CRZ  * IMG_0002.CR2 IMG_0004.CR2 IMG_0005.CR2
Folder area -6 Network
s |8 e ING_0010.CRZ
MG_OOILCRZ MG_0012.CR2 MG_0013.CR2 ' IMG_0014.CR2 MG_0015.CR2 I
Im:ge CElOF ISpace sRGB [ Adobe RGB High quality Redpe data: Yes Number of images: 15 NLImeEr of selected images: 1 CMYK T CMYK SImUIatlon
ana work color =

—— Number of selected images display (p.94)

|
Display mode*4
Recipe attachment status (p.98)

space*3 (p.78, p.95) _
Number of displayed images

*4 The item selected in [Viewing and saving RAW images] (p.91) of the
[Preferences] window is displayed.
*5 You can switch between the [Folder] and [Collection] windows.

*1 To switch between show/hide, select the [View] menu » [Toolbar].

*2 The images inside the folders selected here are displayed in a
thumbnail list on the right.

*3 Displays the coordinates of the cursor position and the RGB values (8-bit
conversion) when click white balance was performed with the tool palette.
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List of Main Window (Collection Window) Functions 39

Image information Cancels selection of all images
Shows/hides the tool palette Selects all images ‘
Switches to the edit image

Displays the quick check window

Displays the copy
stamp window

window
File MH Label| Adjustmeni| Tools [Window Help
Toolbar @ @ B ® D ® @™ & B Batch conversion/
[CO"eCtion] tab Sheet*1 = e Selactall  Clearzll  Rotstelsft Rotste fght Fe! Stamp '{r'm'm':in; Eth SaVing
[Folder] tab sheet e | Oolectonso) m__ _

: Displays the
trimming/angle
adjustment window

. Rating
@3  MG0002.cR2 ' MG_0004CRZ L+ MG_0008|.CR2 MG 0003.CRZ IMG_ODI2.CRZ MG_0013.CR2 .
Image rotation
(90 degree
increments)
—— Check mark
B ewnce
:Ar;:)argecgﬁ)lsgzzaczfzand sRGE [ Adobe RGB High quality Redpe data: Yes Number of images: 7 Number of selected images: 1 CMYK CMYK S|mu|at|0n
R | | display
(p.78, p.95) Display mode

Number of selected images
Number of displayed images

Recipe attachment status

*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion) when click white balance was performed with the tool
palette.

*1 The total number of images added to the [Collection] window is
displayed in the () in the [Collection] tab sheet. Accordingly, when an
image is added that is displayed as a single image (p.22), twice the
total number of displayed images is displayed.
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Image Frame Information in the Main Window and Edit Image Window (e.10, p.34)

Information displayed when [Large thumbnail] (p.10) is selected

@ Digital Photo Professional - [EUsers\CANONY

File Edit View Bookmark Label Adjustment Tools Window Help

2P @® @B D ® O @

Edit image Folder Tool Infa Select all Clearall  Rotste left Rotste right Guick Stamp Trimming
window wiew Paletta chack Angle

Digital Lens
Optimizer mark
(p.69 to p.73)

| Folder | Collection(d) | Chedk mark Rating Yy = o
Bl Desktop r %
Check mark -9 Libraries A Copy stamp mark
(p181 p19) |T_|3 Documents (p73 to p77, p1 16
asi Pictures
. Photo —— Lens aberration
- . :ooloc_;:_c_n | correction mark
., Sample Pictures
EIE Videos (p65)
-+ Homegroup R T e e ———— Trimming range**
Rating mark m. 8 CANON (p.38, p.113)
(p18, p19) m -8 Computer
Kl N k
Brightness oSy et J Aperture*3
adjustment ﬁ '
*1 | . .8 . 1/400
value*' (p.26) ( IMG_0002.CR2 GPS
. e *5
White balance icon*" File name Unsaved editing content mark GPS mark

(p.28)

Image type*? Shutter speed*3

*1 Does not display with [Small thumbnail].

*2 Displays in RAW+JPEG images displayed as a single image (p.22).
[RAW] is displayed in RAW images.
(In [Small thumbnail] (p.10), [R] is displayed.)
In PowerShot Pro1 RAW images, [RAW] is not displayed.

*3 Does not display with [Medium thumbnail] or [Small thumbnail].

*4 When aspect ratio information is attached to an image shot with
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D
Mark Ill, EOS 5D Mark Ill, EOS 6D, EOS 7D, EOS 60D, EOS REBEL
T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/650D, EOS
REBEL T3i/600D or EOS M, the image is displayed as a trimmed
image.

*5 Displayed on images shot on a GPS function-compatible Canon
camera.
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J

List of Edit Window Functions .11, .25)

Path and file name of image Tool palette*! (p.130, p.131, p.132)

Introduction

|

[ Mc_ooo1.cr2 Contents at
Window Help Raw [RGB [ nm/aLo [ LEns | a Glance
| Brightness adjustment J —
; ) 0.00
|White balance adjustment ] BaSiC
1](2])(z Register... Operation
@ (uto) | Twe.. | S
|[petre st || Advanced
@ (standard) - Bromse.. Operation
H i H H H > H
Advanced
Image Editing
A and Printing
—
-10.0 80 -60 40 -20 00 20 40
Contrast:{0) k 0 Processing
Highlight:(0) I
shadow:(0) 0 Large Numbers
[ Linear of Images
Color tone:(0) {1 —_—
Color saturation:{0) k {1
[Unsharp mask v] Editing
Strength:(0) [t J PEGITIFF
Fineness:(0) [ |mageS
Threshald: (1) D —_—
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B —

(1155,1688) : 42,44,28  RAW /Adobe RGB CMYK High quality

w

Information display*2 Display mode**
Image color space*3 and work CMYK simulation display (p.94)
color space (p.78, p.94)

*1 To switch between show/hide, select the [View] menu » [Tool palette]. *3 RAW images are displayed with [RAW].
*2 Displays the coordinates of the cursor position and the RGB values (8- *4 The item selected in [Viewing and saving RAW images] (p.91) of the
bit conversion). [Preferences] window is displayed.



List of Tool Palette Functions

RAW Tool Palette (p.25)
meooncr: NN (o

RAW |RGB NRJALO | LENS

Brightness adjustment (p.26)

i— White balance adjustment

(p.28, p.56)

Picture Style settings (p.26, p.59)

Dynamic range adjustment (p.57)

Contrast adjustment (p.29)

Shadow/highlight adjustment (p.57)

Linear setting (p.29)

| Brightness adjustment
] 0.00
White balance adjustment
1 2 Register...
’ﬁ (Auta) - | Tune...
Picture Style
[@ (5tandard) | Browse...
-10.0 8.0 -6.0 -40 -20 0.0 20 40
Contrast:(0) ' i
Highlight:(0) —f
Shadow: (D) : E:
[ Linear
Color tone:(0) ' i}
Color saturation: (0) : [;
[Unsharp mask v] A
Strength:(0) [
Fineness: (0) [
Threshold:(2) I}

Color tone and color saturation
adjustment (p.30)

— Sharpness adjustment (p.31)

[ [Sharpﬂess '] ]
Sharpness: (1) all

Enlargement display position*

* If animage is displayed enlarged, the enlargement display position can
be moved by dragging. The enlargement display position appears
when [Docking display] (p.93) has been set and the edit image window

(p.135) has been enlarged.

RGB Tool Palette (p.60)
Xy T

RAW | RGB  |nR/ALO [LENS |

| Tone curve assist

fhs o J(r](c](e]

||Tone curve adjustment

1] J
0 255
Brightness: { 0
Contrast: ; D’
Hue: ' 0
Il Saturation: E D’ @ 100
Sharpness: [} 0

255 ‘

Automatic adjustment
(tone curve assist) (p.33, p.106)

Click white balance (p.108)

Tone curve adjustment
(p.58, p.110)

Dynamic range adjustment (p.111)

Brightness and contrast
adjustment (p.107)

Hue and Saturation adjustment
(p.109)

Sharpness adjustment (p.109)

Enlargement display position*
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NR/ALO Tool Palette
(When a RAW image is selected)

v ocorce: DN (6]
Raw |RGE | NRIALO [LENS | :
| Auto Lighting Optimizer
& 0 {— Auto Lighting Optimizer (p.61)
Low Standard Strong J
[ Noise reduction 2o —Hi— Apply noise reduction button (p.62)
. NR Preview... Displays the [NR Preview] window
Luminance noise reduction:{1) (p62’ p133) i .
T . Luminance noise reduction for

RAW images (p.62)

Chrominance noise reduction
for RAW images (p.62)

Chrominance noise reduction:(3)

a {1 20

TIFF/IPEG

Enlargement display position*

* If animage is displayed enlarged, the enlargement display position can
be moved by dragging. The enlargement display position appears
when [Docking display] (p.93) has been set and the edit image window
(p.135) has been enlarged.

NR/ALO Tool Palette
(When a JPEG or TIFF image is selected)

IMG_0001JPG

Rowt | RGE | NRIALO [LENS |

| Noise reduction Apply i: Apply noise reduction button (p.112)
[ MRPreview.. Displays the [NR Preview] window
T (p.112, p.133)
ce noise reduckion; (3]
TIFF/IPEG
L o cion-g Luminance noise reduction for

o [ 20

JPEG and TIFF images (p.112)

Chrominance noise reduction for
JPEG and TIFF images (p.112)

Chrominance noise reduction:{(0)

o [ 20

Enlargement display position*
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LENS Tool Palette

IMG_0001.CR2 =
Raw |RreE | nR/ALO | LENS

| Digital Lens Optimizer Tune...

Setting QOFF H

Lens data : Yes

Lens aberration correction Tune... H

Peripheral illumination OFF

Chromatic aberration OFF
Color blur OFF

Distortion QFF

Digital Lens Optimizer adjustment button (p.72)
Amount of Digital Lens Optimizer (p.70)

Lens data status (p.70)
Lens data Update button (p.71)

Lens aberration correction adjustment button (p.65)

Lens aberration correction (p.65)
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List of NR Preview Window Functions (.62 p.112)

PRR Previcn

Luminance noise reduction:{7)
0 ———it = 20

[Chrnminan::e noise reduction:(8)

g ] 20 |

NR check window

* When you select a JPEG or TIFF image and display the [NR Preview]
window, [TIFF/JPEG] appears and you can reduce luminance noise
and chrominance noise for the JPEG and TIFF images.

Apply noise reduction
button

Enlargement display
position

Navigator window

Image type*

Luminance noise
reduction

Chrominance noise
reduction

J
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List of Quick Check Window Functions .16, p.18)

50% view/100% view (moiré reduction off)/full view*'

Path and file name of image

i ; MllElidee l —— ]

Rating mark display —| ‘

Full screen

Check mark display

Check mark

Clear ‘ ‘

GI2030als

Rating
EEx s )

»”

(] aF point

Image Information ]

|
- | | 5
[ Previous ] l MNext ] ‘ ‘

] |

l Rotate left ” Rotate right l

*1 You can select 50% view/100% view (moiré reduction off) by selecting
[Preferences] in the [Tools] menu and using [Quick check tool display]
in the [View settings] tab sheet. You can also move the display
position in the enlarged display by dragging the image.

*2 To return to the normal screen, press the <Esc> key.

Displays the image in full screen*?

Removes check
marks (p.18)

Check marks (p.18)

Rating (Reject)
(p.18)

Rating (p.18)
Switches between
displayed images
Displays the AF
poins (p.16)
Displays the image
information window
(p.24)

Image rotation
(90 degree
increments)
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List of Edit Image Window Functions (.34, p.36)

Shows/hides grid*4
Image information (p.23)

Shows/hides tool palette
Shows/hides thumbnail display area
Switches to main window (p.126)

Displays the copy stamp window angle adjustment window

Enlargement ratio of displayed image Displays the trimming/
(p.73 to p.77, p.116 to p.120, p.142) ( (.38, p.113, p.137)

Image path and file name @ 0 ital phot

Fi Edit View Label |Adjustmept Tools [ Help

Batch conversion/
saving
(p.101, p.102, p.143)

Toolbar

RAW |RGB | NR/ALO | LENS

‘ Brightness adjustment

] 0.00

Image rotation
(90 degree
increments)

‘White balance adjustment [E]
2]
[ﬂ (Auto)

Register...

v‘[ Tune... ]J

Switches between
displayed images

‘Picmre Style =)
& tandarg) <[ Browse...

—¢— Tool palette
’ (p.130)

Thumbnail display area*3

-10.00 8.0 5.0 10 -Zo 0.0 Z0. 40
Contrast:(0) i}
Highlightz{0)
Shadow:(0)

[ Linear
Color tone:{(0)
Color saturation: {0)

==} =] = =

[Sharpﬂass v]

Sharpness: (1) {1

-l

JE—
InformatioT display*? ’h

(998,984): 99,118,162  RAW [Adobe RGE CMYK

High quality

\— Display mode*>

CMYK simulation display (p.94)

Image color space*! and work 4
color space (p.78, p.94)

*1 RAW images are displayed with [RAW].

*2 Displays the coordinates of the cursor position and the RGB values
(8-bit conversion).

*3 Displays images selected in the main window. The image selected
here is enlarged and displayed on the right.

*4 You can set the grid spacing with [Grid pitch] in the [Preferences]
(p.92).

*5 The item selected in [Viewing and saving RAW images] (p.91) of the
[Preferences] window is displayed.

J
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List of Convert/Save One Image Window Functions () S
|
| Contents at
. { Savein:| || Photo Q2 - el
Types of image —
L -
Type of image Extension || v, 5 . Basic
Exif-JPEG JPG Recent Places Operation
Exif-TIFF 8bit TIF |
TIFF 16bit TIF Desktop J00K_IK_30K . . Advanced
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG = Save destination Operation
TIFF 16bit+Exif-JPEG | .TIF/.JPG | eaiics
. Wl Advanced
"l‘! Image Editing
Computer and Printing
File name Ngﬁk C |r ) Processing
File name: IMG_0001 - Save '-a;gfelrﬂ:g‘g:rs
Saveastpe:  |BdPEG(JPG."JPEG) -] [ Cancel |
Quality setting Editing
. , . * JPEGI/TIFF
Resolution™! Image quality 1w JPEG compression rate*3 Images
Output setting I
Output resolution 350 dpi [¥] Embed 1CC profile in image
Resize setting R
DRESiZE
Size changing*4 . - pix-el “
Lodk aspect ratio

*1 The setting range is 1 to 60,000 dpi. *3 The setting range is 1 to 10. The higher the numerical value, the higher
*2 Color space (p.78, p.94) information that is set in an image is attached
to an ICC profile.
Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.78,

p.94), the ICC profiles are embedded automatically. 136

the image quality becomes. @
*4 The larger of the two values set in [Width] and [Height] is applied to the —
longer edge of an image and change its size.



List of Trimming/Angle Adjustment Window Functions (.3 p.113)

Cancels all the trimming (aspect ratio) information

Full screen

| e
l Clear Reset

Aspect ratio
Free
1,50 i

@ 1/ 1 E\Users\CANON Pictures\Photoooe MG_0001.CR2 ‘

X
04 362

T Heigl

1577 x 1051

Angle 10.10 ‘ ‘

il

| Rotate left Rotate right

| Copy Paste

Apply A

Previous Next

Show borders
Dpadty

i

[~ shaw Grid ‘ ‘
Grid pitch ‘ ‘

)

l Center on Screen

(704, 362) -» (2281, 1413) = (1577 x1051) [ 1.50]

Trimming range
it to another image*2

Full screen display/returns to normal screen
Reverts to the condition when the image was shot

Ratio of trimming range (you can also enter
numerical values if you have selected [Custom])*"

Upper left coordinates of trimmed range (you
can also enter numerical values)

Size of trimmed range (you can also enter
numerical values)

Angle of image adjusted

(Drag bar, use the mouse to click A/V or enter
numerical values to set angle)

Applies the copied trimming range to all other
images*?2
Switches between displayed images*?

Displays borders around a trimmed range
Level of opacity outside a trimmed range
Shows/hides grid lines

(Drag bar to set distance between grid lines)

Displays the trimming range in the center of the
window

Copies the trimmed range and applies (pastes)

Image rotation (90-degree increments)

“1"If [Free] has been selected in the [Aspect ratio] list box, you can also
drag the borders of the trimmed range to change its range.

*2 Operates when you have selected multiple images and the trimming/
angle adjustment window is displayed.
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List of Lens Aberration Correction Window Functions .65 S
When the list box for selecting an extender is displayed in the To correct distortion aberration of images shot with a fisheye lens,
[Lens aberration correction] window, select the extender four effects can be selected from the [Effect] list box in addition to
attached at the time of shooting from the list box. [Shot settings] normally used for distortion correction. T
r.ﬁ Lens aberration correction - G_OEI)LC ] M| a Glance
Basic
Operation
: Enlargement display section*’
S Advanced
I i Operation
Reverts to the condition when the Advanced
‘ image was shot Image Editing
and Printing
Shooting distance information Processing
: H slider*2 (p.68) Large Numbers
Peripheral ilumination . . . . . of Images
H Peripheral illumination correction
] Chromatic aberration — H Chromatic aberration correction Editing
)( H Corrects blue chromatic aberration J'TEISQ: 3
H Color blur correction
ek Distortion correction
Reference
Shows/hides position of
enlargement display section
— |
el ), Grid display
| 0K || Cancel |
] - Corrects red chromatic aberration
Enlargement display position
(Navigator display) *2 For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF
50mm /2.5 Compact Macro with Life Size Converter EF, the slider
*1 The area you clicked on the image (Enlargement display position) is indicator changes to the zoom magnification.
displayed at 200%. The slider is not displayed for images shot with an EF-M lens.
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List of Digital Lens Optimizer Adjustment Window Functions .69

When the list box for selecting an extender is displayed in the
Digital Lens Optimizer window, select the extender attached at the
time of shooting from the list box.
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Operation
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'% Enlargement display position (Navigator display) Sg‘é?:ggﬂ

|

Advanced
Image Editing
and Printing

|

"~ Shooting distance information Proc'ﬁssilr)lg
R A o Large Numbers
F of Images

Shooting distance information slider*? (p.73)

|

(=]

[¥] Setting : (100) Digital Lens Optimizer adjustment (p.72) Editing

— 9 JPEGI/TIFF
Images

|

[Do not sharpen previews] check box (p.72)
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Enlargement display section*’

*1 The area you clicked on the image being enlarged (Enlargement display position) is displayed at 100%.
*2 The slider is not displayed in the Digital Lens Optimizer window for images shot with an EF-M lens.



B EA\Users\CANON\Pictures)

List of Compositing Tool Window Functions .73

[ 100% view ]
] ‘l

100% display (p.80)

Foreground Image

Select foreground image (p.79)

(Mc_ooo2.cr2 2 ‘|

Thumbnail display for foreground
image (p.79)

Composite Method ‘
| weighted |

Select composite method (p.80)
Use RAW compositing (p.81)

Compose in RAW Format

Weight 0.0 5 ‘l
E [

Weighting slider (p.80)

Position

Alignment controls (p.81)

Continue compositing (p.82)
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List of HDR Window (Adjust Image) Functions 52

Presets

[

~
TonefColor

Brightness:(55)
0
Saturation: {50)
I
Contrast: (50)

=1

]
|
~

.

Detail Enhancement

Strength: (0)
-

Smoothness:(0)

I

| ‘

Fineness: (0)
I}
. 7
[ Save As... ]
IMG_0001.CR2 [ IMG_0002.CR2 / IMG_0003.CR2 [ = ]
ose

Select an effect (p.84)

Adjust tone/color (p.84)

Adjust detail emphasis (p.84)
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List of Copy Stamp Window Functions (.73 top.77,p.116 to p.120)

| 100% view H Full screen

[ Apply Dust Delete Data

Repair
{Dark)

[|Fix Copy Source position

Repair
{Light)
OO @O

Pen type
(@ Brush

ndo
<

=
Ci

Radius

! » B |
[u

opy

3 [ Previous ][

Full screen display/returns to normal screen
Applies Dust Delete Data (p.73, p.116)

Types of dust to be erased (p.75, p.118)

Specifies the copy source (p.77, p.120)
Fixes the copy source position (p.77, p.120)

Types of stamps (p.77, p.120)

Sets the size of the dust erasure range (p.75,
p.118) or copy range (p.77, p.120) in a range of
5to 100 (in one pixel increments) (you can also
enter a numerical value)

Restores/redoes the image

Copies the dust erasure range or copy range
and applies (pastes) it to another image

Set to 100% view to perform stamp operation

L = —

* Operates when you have selected multiple images and the copy
stamp window is displayed.

Switches between displayed images*
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List of Convert/Save Multiple Images Window (Batch Processing) Functions (.101) o
! Batch settings 28
. . IMG_0001.CR2 Save folder “ Contents at
Flle names Of Images tO be I mg‘ggg%g&i E:\Users\User\Pictures Save deStination a Glance
batch saved e . S
IMG_0006.CR2 Fie format .
e (rderae Hi Types of image Basic
mg—ggnlggﬁi Image quality f . . Operatlon
e e Type of image Extension
Embeds ICC profiles*2 (p.145) —fjieozca2 Quiput setting | Exif-JPEG JPG
IMG:DD 14.CR2 Cutput resolution 350 dpi Embed ICC profile . _
Resolution*1 16015, CR2 — | Exif-TIFF 8bit .TIF Advanced
e ) TIFF 16bit TIF Operation
. - Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG
Size changing*4 = : :
TIFF 16bit+Exif-JPEG | .TIF/.JPG Advanced
_ Image Editing
- Lock aspect ratio ) and Printing
(e e rame ) — JPEG compression rate*3
) Processing
Large Numbers
— of Images
- String Sequence number File name
DPP_ 0001 Editlng
|:|Save sequence number JPEGITIFF
Ex.: DPP_0001.JPG, DPP_0002. JPG. .. Images
f Image transfer settings
Open image using software Batch transfer to other image editing Reference
software (p.102)
Images tO be Converted are { Convert RAW images only ] [ Execute ] [ Cancel ]
limited to RAW images*>
Save
*1 The setting range is 1 to 60,000 dpi. *3 The setting range is 1 to 10. The higher the numerical value, the higher
*2 Color space (p.78, p.94) information that is set in an image is attached the image quality becomes. @ @
to an ICC profile. *4 The larger of the two values set in [Width] and [Height] is applied to the
Even if you remove the check mark from images that have been set to longer edge of an image and change its size. @}
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.78, *5 Appears when you click the [Batch process] button (p.126, p.135) S—
p.94), the ICC profiles are embedded automatically. without an image selected in the main window or the edit image

window. To convert RAW images only, instead of clicking the [Execute]
button, click this button. 143



List of Rename Window Functions .03 .
Introduction
S ——
@ £\Users\CANON\Pictures\Photoveon xc o =)
File name Extension . Contents at
[DPP + Shooting Date,Time » Sequence number - ‘ Sets the new flle name a Glance
Basic Settings (* Format settings ) —
Sort Sequence number
Order |n WhICh |mages are Sorted (@) Fit to main window 0001 [ save sequence number Basic
) - : F:e name ~ Shooting Date/Time operatlon
() Shooting Date /Time
i _ [teor Month oy 7 Sets the format of information =~ "
Checkmark to app|y the same Same file name for RAW +IPEG images ) [YY-MM-DD v] in the flle name
name to RAW images and JPEG (" Tlcopy and Rename wonse.. | ) | et Advanced
images recorded simultaneously E:\Users\CANON Pictures \ J Operation
. S ——
Checkmark to copy the images
. Original File Name Modified File Mame
Click the [Broyvse.] button and set IMG_000LCR2 , O°P_06.09.15, QagPTRa ; Advanced
the save destination IMG_DODL PG DPP_DE-03-12 0001 PG Image Editing
IMG_0002.CR2 DPP_06-09-13_0002.CR2 and Printin g
IMG_0002. PG DPP_06-09-13_0002. PG
IMG_0003.CR2 DPP_06-03-13_0003.CR2 —
IMG_0003.JPG mp | DPP_06-09-13_0003.JPG
IMG_0004.CR2 DPP_06-09-12_0004.CR2 Processing
IMG_0004.JPG DPP_06-09-12_0004.JFG Large Numbers
- - of Images
4 3 ] b
[ Execute ] [ Cancel .
Editing
JPEG/TIFF
Images
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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Color space

A color space is the reproducible color range (color gamut
characteristics). DPP supports the following five kinds of color space.

sRGB : Standard color space for Windows. Widely used for
the standard color space of monitors, digital
cameras, and scanners.

Adobe RGB : A wider color space than sRGB. Mainly used for
printing for business purposes.

Apple RGB : Standard color space for Macintosh. A slightly

wider color space than sRGB.

ColorMatch RGB : A slightly wider color space than sRGB. Mainly
used for printing for business purposes.

Wide Gamut RGB : A wider color space than Adobe RGB.

Refer to the color chart below for the color area of each color space.

Color chart of color spaces compatible with DPP

y

Color range that can be
seen by the human eye

Gamma White point

value (color temp.)

—— | sRGB 2.2 6500K(D65)
————-- Adobe RGB 2.2 6500K(D65)
............ Apple RGB 1.8 6500K(D65)
————— ColorMatch RGB 1.8 5000K(D50)
—————— Wide Gamut RGB 2.2 5000K(D50)

CMYK simulation profiles

A profile that simulates colors when printing in a CMYK environment
(printing machine, etc.). With DPP, you can simulate color with four

types of profile.

Euro Standard :

JMPA :

U.S.Web Coated :

Profile normally used for book printing in
Europe, suitable for simulation of standard
European printing.

Profile normally used for book printing, etc. in
Japan, suitable for simulation of magazine
advertising standard color printing.

Profile normally used for book printing in
North America, suitable for simulation of
North American standard printing.

JapanColor2001 type3 : Profile becoming a standard in the Japanese

printing industry, suitable for simulation of
JapanColor standard printing.

Rendering intent

Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below.

Perceptual :

Relative Colorimetric :

Before and after conversion, all colors are
converted to maintain the relationship between
colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However,
depending on the image, the saturation may
change overall.

There will not be much conversion to colors
which are similar before and after conversion,
but colors which are not similar are converted
appropriately. Because there are little changes
to similar colors which comprise most of an
image, you can print a natural-looking image in
which the saturation has not changed greatly.
However, depending on the image, there are
cases where the overall tone of an image
changes somewhat as colors which are not
similar and highlights change.
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Index

A

AdJUuSt JPEG IMAQgES.....coviiiiiiiiiiiiiiiieee e 105

Adjust RAW IMages ... .. 25

AdJuSt TIFF IMages......ccoviiiiiiiiiieeeee e 105

Adjusting (JPEG or TIFF Image)
Automatic Adjustment (Tone Curve Assist)............cccceeeeee. 106
BrightneSsS ..o 107
Click White BalanCe ..........coooiiiuiiiiiiieeiieeeee e 108
(O] ] 1= RSOOSR 107
DynamiCc Range.........uuuiiiiiiiiieiee e 111
HUG e 109
RGB ToOl Palette .......cccoeviiiiiiiiiiee e 130
Saturation ... 109
SNAIPNESS ... e 109
Tone Curve Adjustment...... ..o 110

Adjusting (RAW image)
Apply Adjustments.............eoiiiii s 99
Automatic Adjustment (Tone Curve ASSISt).......cccccceeeeiiiiciiieennnn. 33
BrIghtNess .....eeeieiiiieee e 26
Brightness of Highlights.............cooii e 57
Brightness of Shadows.............coiiiii 57
Click White BalanCe ...........ccuuuuiiiiiiiiiiiiiiiiieeeeneaee 28
Color Saturation ..........cccocoiciiiieii 30
Color TEMPErature ........oooiiiiiiieiiee e 56
(0701 (o] gl o] o [T 30
COlOr WNEE ... 56
(O] 1= 1S SRR 29
Copy AJUSTMENTS ......uuiiiiiiiiiiiiiiiie e eraeeaaeeeeees 99
DynamiC RANGE .......ooooiiiiiiiiii e 57
Filter EffeCt ... 31
MONOCAIOME ... 30
Personal White BalancCe .............ouuevviviiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeeee 100
Picture Style ... 26
Picture Style File ........ooooiiii 59
RAW Tool Palette..........uuuueiiiiiiiiiiiiiiieieieeeeeeeeeeeeeeeeeeeee e 130
Save AdJUSTMENTS ......uueiii 99
Tone Curve Adjustment...........cccoii s 58
Toning EffeCt ... 31
B Yo I = 1<) £ (=TT 130, 131
White BalancCe ... 28

Adjustment Contents (ReCIPE)......cccevviiiuiiiiiiiiiiiiiiiiieeeeee e 98, 145
AdODE RGB ... 146
F Y o] o LT R {1 = TP 146
AIrange IMaAgES .....uvvuiei i e e e e eeeaees 20, 21
Auto Lighting Optimizer ... 61
Automatic Adjustment (Tone Curve AsSist)...........eevveveevvveveeeenee. 33, 106
Automatic Dust Erasure Processing.......ccccccvvveveeeveeeeen. 73,75, 116, 117
B
Batch Apply White Balance to Images (Personal White Balance)..... 100
Batch Change the File Name of Images.........ccccccoviiiiiiiiiiiiiiiiine, 103
Batch Convert/Save Images (Batch Process) ...........vvveeevvivvveevveneneee. 101
Batch Process (Batch Save JPEG and TIFF Images)............... 101, 143
Batch Process of Multiple Images
Change File Name ... 103
Convert/Save (Batch Process).........ccooeeuvieeeeeiiiiiiiiiiiieeen 101, 143
Personal White Balance..........ccccccccovviviii 100
Recipe Data .....ccooooviiiiiiiiiii 98
L= 10 = SR 102
Batch Settings Window..........cccooiiiiiiiiiiiiii, 101, 102, 143
Batch Transfer Images ... 102
Batch Transfer Images to Image Editing Software..............cccccvvvvene. 102
Before/After Comparison Display ...............eueeieiiiiiiiiiiiiiiiiiiiieeeeeeeeeeee 53
DIt NUMIDET ... 145
BOOKMAIK ... 51
BrightnNeSS. ..o 26, 107
C
Change File Name............cccoe o, 103
Changing the File Name of Images in the Order in the Main Window... 103
01 aT<To Q1 1Y, F= T ST 18, 19, 128, 134
Chromatic Aberration Correction ...........cccoooeciiiiiiieeiiiceeee e 65
Chrominance Noise Reduction (JPEG, TIFF Images).............c....... 112
Chrominance Noise Reduction (RAW Images) .......cccccceeeeeiiccnnnnnnnns 62
Click White BalancCe..........ooouiiieiiiee e 28, 108
CMYK SIimUulation .........cceuveiieeeeiieeeee e 94, 96, 146
Collection WINAOW .......couueiiiieeeee e 6, 36, 127
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Color Blur Correction ..........ooevieeiieiieee e, 65
(©70] o] g 01 o F- T o SRRSO 146
Color Management (Color Matching)..........cccuveveeiieiiniiiiiieeee e 145
Color Setting of the Monitor (Profiles) .........ceeeveveeviieeiieeeennnen. 94, 95
Color Setting of the Printer (Profiles)...........cevvviiieeveievieeiennneee. 94, 96
[070] (o] gS] o717 TN PPN 146
[CC Profiles ... 145
Color Management (Preferences)........ccccccoovveiiiiiii 94
Color Saturation ... 30
Color Setting of the Monitor (Profiles).................c.cccoc. 94, 95
Color Setting of the Printer (Profiles) .........ccoocoiieeiiiiiiiiiiee, 94, 95
ColOr SPACE ....coeiieiiiiie 146
AdODBE RGB ... 146
APPIE RGB ... 146
Color Space Setting for Each Image ............ccccvvvvevivviiviieeiiieieeeeee, 78
ColorMatch RGB ........ooiiieiii e 146
Default Setting of Color Space ..........euvvveeeeeeeevvieiieeieeeeeeeeeeeee, 94, 95
SRGB ... . e 146
Wide GamUt RGBi..........ouueiiiiieieeeeeeee e 146
Color Space Setting for Each Image..........ooocviiiieiiiiiiniiiieeeeeee e 78
Color Temperature.........cccccoeveeiiiiiie 56
COolOr TONE ..o, 30
(O70] (o] T4 o PSRRI 56
ColorMatch RGB........oooiiiee 146
Compatible Cameras with the Lens Aberration Correction Function ..... 63
Compatible Lenses with the Lens Aberration Correction Function..... 63
Compositing IMages ..., 78
Contact Sheet Printing (Printing a Thumbnail List)...........ccccccceerinies 87
CONraSst ..o 29,107
Convert to JPEG or TIFF Image and Save.................. 42,101, 136, 143
Convert/save One Image Window ...............ccceeeeeeeee, 42,136
Copy Stamp (Image Correction) ...........oeeeveeiiiiiiiiiiieeeeeeeeeee, 77,120
Copy Stamp Window ..........cceevvemiiiiiiiieieeeeeee 73, 75,116, 118, 142
Copying and Pasting (Applying) Recipes..........ccccviiiiiiiiiiiieeeeeees 99
Correct Images (Copy Stamp Function) .................cc.ooeee. 77,120
Creating @ FOIAN ......cooie e 50

D

Default Noise Reduction Settings............ooooiiiiiiiiiiiiiii 94
Default Setting of Color SPace ........ccccccuvuuiveiiiiiiiiiiiiiieereee e 95
Delete IMages .....coooiiiiiiieee e 49
Deleting

Delete IMAagesS ......eeiiiiiiiiie s 49

Delete the Software .............oeeviiiiiiiii e 125
Deleting DPP (Uninstalling) .........cccooiiiiiiiiiicciis 125
Detailed Setting Printing (Printing with Shooting Information)............. 86
Digital Lens OPtimizZEer ............uiiuiiiiiiiiiiiiiiiiiiiiieiseveeveeesseessreeeeeeeeeaee 69
Display

Before/After Comparison Display...........cccccovevviii 53

Enlarged Display (Edit Window) ........cccccccvviiiiiiiiiini 11, 129

Enlarged Display (Quick Check Window) ..........cccccceeeeeennnns 16, 134

Shooting Information Display ...........cceveeviieiiiiiiiiiiiiiieiiieeeeeee, 10, 23

Single IMmage DiSplay ............eueeeiiiiiieiiieeiieieeeeeeeeeeeeeee e 22

Synchronize Edit WiNdOW ............coooiiiiiieee e 54

Thumbnail Display (Main Window).............ccccviiieeiiiinnninnee. 10, 126

Thumbnail Display and Enlarged Display

(Edit Image WindOoW)........ccoiiiiiiiieeiiieeeee e 34, 135
Distortion CorreCtion.........cccoooiiioiicc s 65
Downloading an Image to Your COMPULET .............uuvveivverinniiiriiiiiinnninnns 7

Downloading Images from a Camera ...........cccouvieeeeeiiiiiiiiiieeeeen 7

Downloading Images from a Card Reader...........................ooooe. 9
Downloading IMages .......ccouvuiiciiii e 7
Downloading Images from a Camera...........ccccceeeeeiiiiiiiiieeeceeeeee 7
Downloading Images from a Card Reader .............ccccuvvvvvvvnvvvvininiinnnnnnn,
Dust Delete Data ............coooiiiiiiiiiiie
Dust Erasure Processing

Automatic Dust Erasure Processing ...........cccveeeeeeeiniiiiinnnnn.

Image Correction (Copy Stamp Function)

Manual Dust Erasure (Repair Function) ............ccccveeeeeeinnns 75,118
Dynamic Range ........coooiiiii 57, 111
E
Edit Image WindOW........ccooviiiiiiiiee it e e ee e 34, 135
Edit WINAOW... ...t 11,129
Editing...cco oo - Adjusting
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Enlarged Display (Edit WiNdOW) ..........cccuiiiiiiiiiiiiiiieeeee s 11,129
Enlarged Display (Quick Check WiNndOw) ..........ccoooiiiiiiieieeeeiniiieeee. 134
EOS ULIItY ..o 7
EXItING DPP ..o 14
F
False Color REAUCHON ..........uuueiiiiiiiiiiiiiiiiiiiiiiiiieeeeeeee e 91
FIter EffECt... .o i 31
FOIder WINAOW .....c.ueeieeeeee e 6, 126
G
General Settings (Preferences) ..........cccccc, 91
H
HDR (High Dynamic Range) Images.........ccuvvvvvevevveeieeeeieeeeeeeeeeeeeeeee 82
=] SRR Cover
Highlight Area Warning Indicator............couvceeeiiiiiiiiicce e, 55
o 11 109
|
[CC PrOfilES ..t 145
Image Frame Information (Image Marks) ........cccccoovviiiiiiiieiiiiniiinnn. 128
Image Marks (Image Frame Information) ...........cccceveevviviiiiiieeiinnnnen.. 128
Image Quality
Default Noise Reduction Settings.........cccccccove. 94
False Color Reduction.............ueeiiiiiiiiiiiieeeee e 91
Improve the Quality of an Image (Main Window) ............cccueee.... 23

Noise Reduction of a JPEG Image (Luminance, Chrominance) ... 112
Noise Reduction of a RAW Image (Luminance, Chrominance) ... 62

View and Save a RAW Image ... 90, 91
Image Shooting Information Display ............ccccceeiiiiiiiiiiieieees 10, 23
Improve the Quality of an Image (Main Window).........ccccceevvviiinenn.nn. 23
J
JPEG IMaQge.. .t 145
L
Lens Aberration CorreCtion .........ooeuuiiieeiii e 63
Lens Aberration Correction Window ...........ccceeviviiieeiiiiiiieeeeeee, 65, 138
LENS TOOI Palette ...c.ueeieeeiieeeee et 132

] == T 29
Loading and Pasting (Applying) RECIPES..........cuvvvvrivivereeieeiiieeeeeeeeeee, 99
Luminance Noise Reduction (JPEG, TIFF Images) .......c..ccccoeeuuvnnee. 112
Luminance Noise Reduction (RAW IMages)........cccvvvvvevvvvevereeeeeeeennnen. 62
M
MaIN WINAOW ... e e e 10, 126
Manual Dust Erasure (Repair Function)...........ccccccvvvvvvvvviveveneeee. 75,118
MAP UBIHIEY e 85
MONOCHIOME . ...ttt eeeeee 30
Filter EffeCt.. ..o 31
ToniNG EffeCt ... 31
Move Or COPY FOIErS ......cccoiiiiiiiiiiieiee e 51
Move or COPY IMAGES .......uuuuuiiuiiiiiiiiiiiiiiitiiiiriieereresbeereeeeeeeesreeeeeeeeeeees 50
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Noise Reduction (JPEG or TIFF Image)........cccccceuereerernrinnniininnninnnns 112
Noise Reduction (RAW IMage) ........cccoiiiiiiiiiiiiiiiiiieeeee e 62
Noise Reduction of a JPEG Image (Luminance, Chrominance) ....... 112
Noise Reduction of a RAW Image (Luminance, Chrominance) .......... 62
NR Preview WIiNAOW.........coooiiiiiiiiiiieee e 62, 112, 133
NR/ALO ToOl Palette ......ccoveeiiiiiiiieeee e 131
(0]
Organize IMages ... 49
Organizing IMagES ........uuiiiiiiiiiiieie e 49
Create @ FOIder.........uuiiiiieeeeeeee e 50
Delete IMagesS......ccovvieeeece e 49
Move or Copy Folders.........ccccooiviiii 51
Move or COPY IMagES ........uuiiiiiiiiiiiiiieieeee e 50
Register Folders as Bookmarks............cccccoiiiiiiiiiieeiiieeen 51
P
Peripheral lllumination Correction .............cccccvvveviiiiiiiieieiiieiiieeeeeeeeeeeee, 65
Personal White Balance ..........cccooooiiiie 100
PiICture SEYIE ..o 26
Picture Style File......ccoooiii s 59
Prefer@nCes ... e 90
(0] (ol 1Y/ F=TaT=To [T 1 41T o | AR 94

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

00
©

149



General SettingsS.........uuiiiiiiiii 91
TOOI Palette ... 93
VIEW SEHHNGS...ueiiiiiii i 92
Printing
Printing a Thumbnail List (Contact Sheet Printing) ..................... 87
Printing One Sheet of Paper ...........oovvviviieieiiiiiiiiiiiieeeeeeeeeee, 14, 49
Printing Using Easy-PhotoPrint ..o 46
Printing Using Easy-PhotoPrint EX ..........ccccooiie 43
Printing with a High-End Canon Printer...........ccccciiniinee. 88
Printing with a Large-Format Canon Printer............cccccccceeiinnee. 90
Printing with a Printer other than Canon Printers ......................... 49
Printing with Canon Inkjet Printers ..........cccccco s 43, 46
Printing with Easy-PhotoPrint Pro...........oeeeiiiicee e 88
Printing with Print Studio Pro.........cccco 89
Printing with Shooting Information (Detailed Setting Printing)...... 86
Rendering Intents when Using Easy-PhotoPrint ................... 94, 96
Printing a Thumbnail List (Contact Sheet Printing) ...........cccccoviinnnen. 87
Printing One Sheet of Paper.............coiiiiiii s 14, 49
Printing Using Easy-PhotoPrint................co e, 46
Printing Using Easy-PhotoPrint EX...........oooii e 43
Printing with a High-End Canon Printer ... 88
Printing with a Large-Format Canon Printer ............ccccviiiiiiiiiniinnnee. 90
Printing with a Printer other than Canon Printers............cccccccoeeinniie 49
Printing with Canon Inkjet Printers..........occciieei s 43, 46
Printing with Easy-PhotoPrint Pro...........coooooooioiii e 88
Printing with Print Studio Pro ... 89
Printing with Shooting Information (Detailed Setting Printing) ............ 86
Q
Quick Check WINAOW........ccooiuiiiiiiiiiiceeieec e 16, 134
R
RAtING. ..o 18, 19, 134
RAW IMAQE....cuieiiii it e e e e e 145
RAW ToOl Palette ...........oeeeiieiiiiieeee e 130
Re-Adjusting an Image ........ccooov v 43,122
RECIPE ... e 98, 145
RECIPE FilE ..o 98
Re-Editing an Image ..o 43,122

Registering Folders as BooKmarks............cccuviiviiiiiiiiiiiiieee e 51
Rename WiNdOW ... 103, 144
Rendering Intent (Matching Method) ............ooeeiiiiiiii, 146
Rendering Intents when Using Easy-PhotoPrint..................... 94, 96
Rendering Intents when Using Easy-PhotoPrint .................ooooc. 94, 96
Repair (Manual Dust Erasure)..........ccccoviiiiiiiiiiiiiiiiieeeeeeee 75,118
RGB Tool Palette...........ooeiiiiiiiiieeeee e 130
Rotate Images ..., 10, 25, 126, 127, 134, 135
S
SAtUrAtION ... 109
Save
Batch Convert/Save Images (Batch Process)..................... 101, 143
Convert to JPEG or TIFF Images and Save...........ccccuuue..... 42,136
S AV .. 41, 121
SAVE AS .. 41, 121
Save JPEG or TIFF Image as a Separate Image ...................... 121
View and Save RAW IMages..........ccoviviiiiiiiiiiiieeiieeeeee e 91
S AV AS .o 41, 121
Saving RECIPES......coooiii . 99
SeleCt IMages.......cooovveiiiie . 10, 16, 34
Shadow Area Warning Indicator............ccooooiiiiiiiiiiiiiicc, 55
SNAIPNESS ... 31,109
Shooting Information Display............ccccccc 10, 23
SNOMCUL KEYS ... Cover
Single Image Display...........cccooo . 22
Single Image Display of RAW and JPEG Image..........cccccceeeeiiiinnnee. 22
Sorting Images
(0 0 T=To @ 0 1 7= 1 1S TR 18, 19
RatiNgS ..coeeiiiieeiieeeee e, 18, 19
SRGB ... a s 146
Starting UP DPP ... 6
Supported IMages ..., 3
Synchronization (Edit WindOW)............ccooiiiiiieeeee e 54
Synchronize EAit WIiNdOWS ..., 54
SYNCroNize IMagES ........uviiiiiiiiiiiiee et 54
System Requirements ..., 3
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Thumbnail Display (Main Window) .............eeeieiiiiiiiiiieeeeeee 10, 126
Change the Display ............uuvuuiiiiiiiiiiiiiiiieiiieiiieiieeeeeeerereeeeeeeeeeeeee. 10
Thumbnail Display and Enlarged Display (Edit Image Window)......... 34
Thumbnail Display of Images (Main Window)...............cccccooo. 10
Change the Display .........ccoouiiiiiiiii e 10
TIFF IMAQJE ..o 145
TONE CUIVE ...ttt e 145
Tone Curve Adjustment ..........oooviiiiiiiiiii e 58, 110
Tone Curve Assist (Automatic Adjustment) ............................... 33, 106
ToniNG EffeCt......oeeeeeee e 31
Tool Palette
LENS Tool Palette........cooeeiiiiiieccec e 132
NR/ALO Tool Palette........oocviiiieiiee e 131
RAW TOOl Palette........coooeiiiiiicceeceeeeeeee e 130
RGB Tool Palette ........ovvviiiiiiiiiieiiieeeeeeeeeeeeeeeeeeeeeeee e 130
Tool Palette (PreferenCes)........uueveeeieiiiiiiiiiiiiiieiieeeeeeeeeeeeeeeeeee e 93
Transfer
Batch Transfer Images to Image Editing Software...................... 102
Transfer an Image to Photoshop..........cooccviiiiiiiiiiiiiiee e 78
Transfer an Image to Photoshop ... 78
Trimming and Adjusting the Angle of an Image........................... 38,113
Trimming/Angle Adjustment Window ...........ccccccoovvveennnl. 38, 113, 137
U
UNSharp MaskK........uueoiiiiiie e 32
\'}
View Settings (Preferences) .......cccoveeviiiciieiiiee e 92
w
White BalancCe...........oooiiiiiiiiiiii 28
Click White BalancCe ..........oooouiiiiiiiieeeeeee e 28, 108
Color TEmMPErature .............eeeeeeeieeiiieiiiiiiieeeeeeeeee e e e 56
Color WHEE ... 56
Personal White BalanCe .............coovviiviiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeeeee 100
Wide GamUt RGB ........cooo i, 146
WOIK COlOr SPACE.....ceuiiiiiiiiieiieeeeeeeeeee ettt e e 78

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Microsoft and Windows are registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.

Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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